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1.1 INTRODUCTION 
The availability and importance of Information and Communication Technology (ICT) in 

education are the paradigm shift in Higher Education Institutions (HEIs); that refers the 

transformation of teaching learning tactics. The development and implementation of ICT based 

tools in higher education changes the pedagogical structure of teaching learning in higher 

education in India as well as in the world education. The ICT is a powerful tool to enrich and 

transform the education till the unreachable. The use of ICT in education helps educators and 

learners in many ways, e. g. to provide universal access to education, weaken the learning 

divides, enhance the quality of learning, strengthen inclusion, increasement of GER (Gross 

Enrollment Ratio), support for the development of educators and finally improve the overall 

education in terms of quality education.  

Now e-learning/ technology enabled learning /online learning is the crucial concept for 

brighten the quality and widespread reachability of education. The objectives behind to embed 

ICT concepts and tools in educational Institutions is to facilitate the learners for updating the 
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information regarding their various learning activities. Besides that, ICT enabled learning also 

opens the door of Open Educational Resources (OERs) for getting new knowledge without 

paying a single coin.  

In today’s digital era our adults/minors are digitally engaged with less important activities, in 

that case we can divert/train them towards useful digital engagement as: e-learning. We also 

require to introduce ICT tools and concepts for those learners; so that they can achieve 

something extra outside the course curriculum and they can develop their curiosity and desire 

to learn, and can intensely participating in such activities. The recent developments and 

advancements in mobile devices have opened up more opportunities for every individual across 

the world to be able to communicate and obtain information quickly. Various studies proved 

that ICTs with Internet connection facilitate in-depth study which enhances learning and 

promotes knowledge generation. 

1.2 OBJECTIVES 
After the successful completion of this unit, you will be able to- 

 Explore the ICT oriented educational initiatives. 

 Define the role of ICT in 21st century education. 

 Explore the applications and tools of ICT in teaching-learning. 

1.3 ICT ORIENTED EDUCATIONAL INITIATIVES 
The educational Institutions across the world are embracing ICT based teaching and learning 

process to disseminate quality education to their learners spread across the globe. In India 

availability and access of ICT facilities and learner characteristics are uneven and vary from 

state to state. In line with the advocacy of technology enabled education various Educational 

Institutions across the globe, initiated several initiatives. Some of the popular initiatives taken 

by Govt. of India (GoI) under the National Mission on Education through Information and 

Communication Technology (NME-ICT) are as discussed. Such initiatives are useful to 

promote digital learning and to leverage the potential of ICT to make the best quality content 

accessible to all learners across the globe, free of cost. As- 

 The Virtual Labs initiative has been taken by Ministry of Human Resource 

Development (MHRD). Virtual Labs do not require infrastructural setup for conducting 

experiments at user premises, its intended beneficiaries of are- students and faculty 

members of science and engineering whose inquisitiveness will be triggered, 

researchers and engineering colleges who can share the given resources.  

 The Talk to Teacher is an indigenously built multi-modal, multimedia e-learning 

platform that provides an immersive e-learning experience that is almost as good as a 

real classroom experience.  
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 Spoken Tutorial is an educational content portal where one can learn various Free and 

Open-Source Software by oneself. The courses offered by Spoken Tutorial are of self-

paced, multi-lingual that anybody with an Internet connecting device, such as computer, 

mobile, and etc. and a desire for learning, anyone can learn from anywhere, anytime 

and in a language of their choice.   

 Consortium for Educational Communication is an Inter- University Center set up by 

the University Grants Commission (UGC) of India.  The CEC has been established with 

the goal of addressing the needs of higher education through the use of powerful 

medium of television along with the appropriate use of emerging ICT tools.  

 E-Yantra is an initiative to spread education in embedded systems and robotics by 

Indian Institute of Technology, Bombay; sponsored by MHRD. The objective behind 

this project is to provide hands-on learning to engineering students to create the next 

generation of (Embedded Systems) engineers in India. 

 The e-ShodhSindhu is formed by MHRD with the merger of three consortia initiatives, 

namely UGC-INFONET Digital Library Consortium, National Library and Information 

services Infrastructure for Scholarly Content (NLIST) and Indian National Digital 

Library in Engineering Sciences and Technology (INDEST). The e-ShodhSindhu 

provides current as well as archival access to more than 15,000 core and peer-reviewed 

journals and a number of bibliographic, citation and factual databases in different 

disciplines.  

 The Quantum-Nano computing Centre is a multidisciplinary centre with the mission to 

explore and advance the application of quantum-nano systems to a vast array of relevant 

information processing techniques.  

 The Free Open-Source Software for Education project promotes the use of Free and 

Open-Source Software tools to improve the quality of education with the aim to reduce 

dependency on proprietary software in educational institutions.  

 Creating Digital-learning Environment for Design also called E-Kalpa; presents three 

initiatives- providing digital online content for design, a social networking environment 

for design & higher learning and creating a digital resource database on design. The 

project would focus on knowledge accumulation, storing and dissemination and 

education in four sectors - University, Industry, Government and the Informal sector.  

 E-PG Pathshala is an initiative of the MHRD under NMEICT program being executed 

by the UGC. e-Adhyayan, e-Pathya and UGC-MOOCs are more initiatives of 

NMEICT, where under e-Adhyayan 700+ e-Books and video contents for the Post-

Graduate Courses are provided.  
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In today’s transforming environment, the learning habits of learners are trending, as such 

learning habits are based on hands-on-learning, learners centric, technology-based learning and 

etc. The new age approach of learning develops several skills among learners, as- critical 

thinking, inquiry, autonomy to learn, learn by doing, etc. To keep pace with global challenges 

and competencies we always required something else than traditional learning approaches, an 

effective new age teaching learning pedagogy is based on personalization, awareness about 

technology-based learning, participation and outcome/productivity-based learning. As such 

pedagogical innovations in educational technology should emphasis on individuals’ active 

participations for learning, solving problems, learning with peers, etc. are the key elements of 

effective twenty first century skills of learning. The ISTE (International Society for Technology 

in Education) also referred to student-cantered learning environments, which should provide 

genuine, authentic and student-cantered learning opportunities rather than transforming 

traditional system into digitized form. We try to approach new pedagogies which should 

improve learning outcomes and focus on adaptive learning, peer learning, gamification 

(learning by play/game), flipped classrooms approach and project-based learning. 

1.4 EDUCATIONAL TECHNOLOGIES IN 21ST CENTURY 
The COVID-19 pandemic has drastically changed the way of teaching-learning. In this 

pandemic the role of educational technologies are of key importance for every student because 

there are no alternate. Basically, educational technology facilitates learning and also improves 

performance by creating, using, and managing appropriate technological processes and 

resources of learning. Educational technology is the process of integrating technology into 

education to build better teaching/learning experiences that result in higher learning outcomes. 

In 21st century learning there are several new age technologies adopted, as- Big Data, Machine 

Learning, and the Internet of Things (IoT), etc. 

21st century learning allows teachers to provide multimedia to address diverse learning styles, 

such as animation, live video, etc. besides that it also enables teachers to create online courses 

(MOOCs- Massive Open Online Courses) where students can learn in their own pace. 

Technology has made it possible for everyone to stay connected, so that the students and 

teachers can connect, discuss, share their opinions, and act upon situations collaboratively. 

Educational technology makes learning more fun and exciting for students. When we feel 

engaged in learning, we learn better, remember better, and also apply knowledge better to real 

life. Technology makes education smarter, more effective, accessible and gamified with the 

use of multimedia. Following are the trending 21st century educational technologies- 

 E-Learning: e-Learning is education or training delivered electronically. it is a rising 

demand for online educational platforms. With eLearning, educational content is 

delivered to learners through computers, laptops, tablets, or smartphones. It opens the 

doors for interactive learning where one can interact directly with on-screen 

information. E-Learning courses includes- animation, podcasts, videos, text, 
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infographics that create a multimodal and practical learning experience. A variety of 

outstanding feature of online learning platforms are available where one can get the 

advantage of real time teaching-learning (synchronous) via live stream or group 

meetings using Zoom or Microsoft Teams, etc. or you can use recorded (asynchronous) 

methodologies with a wide range of media and digital functions available to enrich 

lessons. 

 Video-Assisted Learning: Video-assisted learning has become more and more popular 

as classroom displays. 

 Blockchain Technology: The Distributed Ledger Technology (DLT) from blockchain 

brings so many benefits to education, especially data storage. Every time new data is 

added, it adds another “block” to the system, so the storage is technically limitless. 

Simultaneously, the data will be encrypted and distributed across multiple computers 

in the system. It makes transacting data decentralized and transparent. Blockchain 

technology is used in Massive Open Online Courses (MOOCs) and ePortfolios to verify 

skills and knowledge.  

 Artificial Intelligence (AI): AI can automate several activities in education, like 

grading. It’s now possible for teachers to automate grading of the multiple-choice and 

fill-in-the-blank questions. AI-driven programs can give both learners and educators 

helpful feedback. 

 Learning Analytics- The current landscape of learning analytics has dramatically 

expanded, especially for higher education. It allows measurement, collection, analysis 

and reporting of data about learners and their contexts, for purposes of understanding 

and optimising learning and the environments in which it occurs. 

 Gamification- Today's educational technologies trends towards learning as fun and 

engaging process. Gaming elements help create a funny and positive learning 

environment for learners. 

1.5 ROLE OF ICT IN EDUCATION 
ICT is a part of our lives for the last few decades affecting our society as well as individual 

life. ICT which is now broadly used in educational world. Teacher, Student, administrator and 

every people related to education are popularly used ICT. Teacher uses ICT for making 

teaching-learning process easy and interesting. A competent teacher has several skills and 

techniques for providing successful teaching. The presence of ICT in education allows for new 

ways of learning for students and teachers. E-learning or online learning is becoming 

increasingly popular and where various unprecedented events taking place in our lives, like 

COVID 19. 

In modern science and technological societies education demands more knowledge of teacher 

regarding ICT and skills to use ICT in teaching–learning process. The knowledge of ICT also 
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required for pre-service teacher during their training programme, because this integrated 

technological knowledge helps a prospective teacher to know the world of technology in a 

better way by which it can be applied in future for the betterment of the students. Now-a-day's 

ICT is transforming educational institutions and classrooms into a new look by involving new 

educational tools which can enhance learning, providing teachers and students more facilities 

and opportunities for futuristic learning. Teachers must know the use of ICT in their subject 

areas to help the learners for learning more effectively. 

Educational Technology is a behavioural and scientific approach to the teaching-learning in 

which technological methods/tools and applications are used. Broadly the means of educational 

technology is the “development, application and evaluation of system techniques and aids in 

the field of learning.” 

Educational technology/ tools help to create condition for better explaining the inputs during 

the teaching process as well as it also focuses on to achieve the learning objectives. It is a way 

to systematize the learning methods and techniques in today's digital era. Its purpose is to bring 

more effectiveness in the teaching-learning process to meet the requirements according to the 

need of the changing era. 

In modern era, the educational technology has great importance in learners' achievement. For 

example- Radio, television, Internet supported tools (smart phones, social media, etc.) as a 

media of education technology broadcasts/offers a variety of educational programmes 

throughout the country/globe. The products of educational technology, i. e. audio-visual aids 

are considered effective media for teaching and learning. The skilful utilization of such digital 

techniques/tools are the needs of time. 

1.6 APPLICATIONS OF ICT IN EDUCATION 
Application of ICT (Information and Communication Technology) in education has changed 

the whole scenario of teaching and learning process. ICT benefits the teaching-learning process 

in several ways, as- it used various components of ICT for content delivery, defines the online 

teaching–learning process more interactive, etc. During the last few decades, there has been a 

tremendous growth in the use of ICT in all fields, such as- Industries, businesses, societies, 

lives of people and education. During this global pandemic (COVID 19) situation, only the 

applications of ICT become the way to carry teaching-learning activities among the global 

community. ICTs provide greater opportunity for both teachers and students to adjust learning 

and teaching to individual needs, so it is necessary to integrate ICT application in every level 

of education (Roy, 2015). Some of the ICT tools those are used in teaching-learning are as-  

 ICT in Record Keeping. 

 Connecting with Parents (E-mail, Website or Blog, Online Survey, Virtual Learning 

Environments, Media Sharing, Social Networks, Online Groups and Forums, SMS and 

Instant Messaging, etc.) 
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 School/College Management Tools- Such tools are used to maintain, Student's profile, 

result, fee record, result, etc. 

 ICT in information delivery/teaching-learning- OER, MOOCs, Blogs, Video 

(YouTube) Channel, Blogs, Digital recorders, Digital books, electronic math 

worksheets, Mobile technology (e. g. tablets, iPods, iPads, smartphones, MP3 players, 

etc.), Reading systems that utilize a computer, scanner, and software to "read" scanned 

book pages out loud, Speech recognition software that allows a computer to operate by 

speaking to it. 

1.7 
TYPES OF TOOLS USED IN TECHNOLOGY ENABLED 
LEARNING 

E-learning or technology enhanced learning may either be synchronous or asynchronous. 

Synchronous learning occurs in real-time (live), with all participants interacting at the same 

time, while asynchronous learning is self-paced learning which allows participants to engage 

in the exchange of ideas or information without the dependency of other participants′ 

involvement at the real time. Several tools are used to success the technology enabled 

education, some of them are mentioned below- 

 Google Classroom (https://classroom.google.com)- It is a powerful community based 

social tool for learning where students can post questions and receive answers from 

their teachers. It can also be integrated with other Google products such as Google 

Forms, which can be a great way to get feedback from students. 

 Khan Academy (www.khanacademy.org)- It is a platform through which one can learn 

anything freely. Learning material is presented in the form of videos, interactive 

activities, and challenges. 

 Presentation Software- Visual aids are complement for teaching, stimulate discussion, 

or allow out-of-class teaching. Tools designed for this purpose are- PowerPoint, Google 

Slides, Slidedog, etc. 

 Online Projects and Collaboration Tools- Technology can support student collaboration 

on creating new knowledge, reflecting on what they are learning, or working together 

to achieve a deeper understanding of course material.  

 Podcasts- podcasts conveys information to the students for initial learning or review. It 

is easier to record and deliver. 

 Smart Boards- It is an interactive whiteboard which allows teachers and students to 

control the computer through touching the screen. More services and software can be 

purchased to increase its functionality and interactivity. 

 Virtual Classrooms- A virtual classroom is an online teaching and learning environment 

in which teachers and students can interact with one another in a real time manner. 
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 Learning Management System (LMS)- LMS is a software application in which one can 

manage courses and learning activities (i. e. content delivery, monitoring and assessing 

students’ performance, etc). 

 Computer-aided assessment- Computer-assisted assessment includes various forms of 

students' assessments which is conducted using online medium. 

 AI (Artificial Intelligence) supported tools for learning- AI can help in several ways for 

learning and developing skills among the learners. Some of the popular ways in which 

AI can contribute, as- the learners can receive more personalized learning, AI can help 

to educators to identify learning disabilities, etc. 

1.8 POINTS TO REMEMBER 

 The development and implementation of ICT based tools in higher education changes 

the pedagogical structure of teaching learning in higher education in India as well as in 

the world education. 

 The use of ICT in education helps educators and learners in many ways, e. g. to provide 

universal access to education, weaken the learning divides, enhance the quality of 

learning, strengthen inclusion, increasement of GER (Gross Enrollment Ratio), support 

for the development of educators and finally improve the overall education in terms of 

quality education. 

 Teacher uses ICT for making teaching-learning process easy and interesting. A 

competent teacher has several skills and techniques for providing successful teaching. 

 Recent developments and advancements in mobile devices have opened up more 

opportunities for every individual across the world to be able to communicate and 

obtain information quickly. 

 To keep pace with global challenges and competencies we always required something 

more than traditional learning approaches, an effective new age teaching learning 

pedagogy is based on personalization, awareness about technology-based learning, 

participation and outcome/productivity-based learning. 

 21st century learning allows teachers to provide multimedia to address diverse learning 

styles, such as animation, live video, etc. besides that it also enables teachers to create 

online courses (MOOCs- Massive Open Online Courses) where students can learn in 

their own pace. 

1.9 GLOSSARY 

 LMS- Learning Management System. 

 AI- Artificial Intelligence. 
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 NLIST- National Library and Information Services Infrastructure for Scholarly 

Content. 

 INDEST- Indian National Digital Library in Engineering Sciences and Technology. 

 GER- Gross Enrollment Ratio. 

 UGC- University Grants Commission. 

1.10 CHECK YOUR PROGRESS 
1) Define the role of ICT in 21st century learning. 

2) What do you understand by technology assisted learning? Explain. 

3) List the key initiatives of ICT oriented education. 

4) Define the tools used in technology enabled learning. 
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2.1 INTRODUCTION 
As you are already aware that the application of some form of digital technology to teaching-

learning in an educational context is referred as Technology-Enabled Learning. There are a 

range of terms to denote Technology-Enabled Learning in several context, as- computer-

assisted learning, networked learning, computer-based learning, e-Learning, and technology-

enhanced learning. Currently, it has been noted a significant increase in accessing technologies, 

especially in mobile and Internet technologies for accessing digital learning resources by the 

students and teachers. Several educational institutions are involved in taking the advantage of 

technology-enabled learning for innovation and capacity building. In today's learning 

environments students having a bunch of learning resources so that they are becoming 

independent of learning time and space. This leads to new ways of teaching-learning tools and 

techniques. 
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ICTs provide both students and teachers with more opportunities in adapting learning and 

teaching resources. The potentials of ICTs in increasing access and improving relevance and 

quality of education in the society. ICTs greatly facilitate the acquisition and absorption of 

knowledge, to enhance educational systems, improve policy formulation and execution, and 

widen the range of opportunities for educational technologies and entrepreneurship. In today’s 

information age ICTs opens the door of accessing knowledge in ways unimaginable not long 

ago. ICTs have revolutionized the way we work today and are now transforming education 

systems into a new age education. Now, ICT is gaining recognition and attention at every level 

of education system. 

A learning environment in today’s interconnected and technology-driven world can be virtual, 

online or remote. Such learning environments can be considered as support systems that 

provide the condition in which one can learn. These environments are able to accommodate 

the unique learning needs of every learner to provide effective learning. These learning 

environments provide the structures, tools, and communities that students and educators can 

use to attain the knowledge and skills required to succeed in 21st century. 21st century learning 

must take place in environments that promote interaction which enable formal and informal 

learning. 

Rapidly evolving demands of the new knowledge society are posing serious challenges for 

designs of learning environments. Some important challenges include how to design learning 

environment to best meet the demands of 21st century learners and educators, how can new 

and existing environments best accommodate increasingly diverse technologies, are 

governments/schools investing in building new technology-enabled learning environments, 

and how can existing learning environments can be transformed to achieve future educational 

goals. Today’s interactive learning environments place students and teachers at the centre of 

educational process. Design of learning environment plays an important role in facilitating 

innovative learning pedagogies. Learning environments must be sufficiently flexible to 

accommodate range of teaching and learning scenarios and technologies. 

2.2 OBJECTIVES 
After the successful completion of this unit, you will be able to- 

 Explore various learning environments. 

 Define role of social media in learning. 

 Define challenges and opportunities of social media in e-learning. 

2.3 BRIEF OVERVIEW OF LEARNING ENVIRNIMENTS 
Learning environment refers to the diverse physical locations, contexts, and cultures in which 

students learn. Since students may learn in a wide variety of settings, such as outside-of-school 

locations and outdoor environments. The term also encompasses how individuals interact with 
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and treat one another, as well as the ways in which teachers may organize an educational setting 

to facilitate learning. In other words, we can say that the students learn in many different ways 

and in different contexts. The aim is to create a total environment for learning that optimises 

the ability of students to learn. There are infinite number of possible learning environments, 

which makes teaching-learning effective and interesting. Developing a total learning 

environment for students is of key importance and also is a most creative part of teaching-

learning pedagogy. 

2.4 TYPES OF LEARNING ENVIRNIMENTS 
 Online Learning: Online learning can be termed as a tool that can make the teaching–

learning process more student-centred, more innovative, and even more flexible. Online 

learning is defined as “learning experiences in synchronous or asynchronous environments 

using different devices (e.g., mobile phones, laptops, etc.) with internet access. In Online 

learning environment, students can be anywhere (independent) to learn and interact with 

instructors and other students. The synchronous learning environment is structured in the 

sense that students attend live lectures, there are real-time interactions between educators 

and learners, and there is a possibility of instant feedback, whereas asynchronous learning 

environments are not properly structured. Synchronous learning can provide a lot of 

opportunities for social interaction. 

 E-learning: is a learning program that makes use of an information network- such as the 

internet, an intranet (LAN) or extranet (WAN) whether wholly or in part, for course 

delivery, interaction and/or facilitation. Web-based learning is a subset of e-learning and 

refers to learning using an internet browser such as the Moodle, blackboard or internet 

explorer. 

 Blended Learning: refers to learning models that combines the face-to-face classroom 

practice with e-learning solutions. For example, a teacher may facilitate student learning 

in class contact and uses the MOODLE (Modular Object-Oriented Dynamic Learning 

Environment) to facilitate out of class learning. 

 Constructivism: is a paradigm of learning that assumes learning as a process individual 

“construct’’ meaning or new knowledge based on their prior knowledge and experience. 

Educators also call it the emerging pedagogy in contrast to the long existing behaviourism 

view of learning. 

 Learner-centred learning environment: is a learning environment that pays attention to 

knowledge, skills, attitudes, and beliefs that learners bring with them to the learning 

process where its impetus is derived from a paradigm of learning called constructivism. 

2.5 ROLE OF SOCIAL MEDIA IN LEARNING 
ICT has continually enabled us to keep up with knowledge and information sharing. It has 

made our daily activities faster and more efficient; trade and commerce more fluid; and 
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communication easier despite distance, among other things. As ICT revolutionizing 

information sharing and completely changed the education system. Now, several online courses 

are made available, and enabling interested to learn from anywhere any time. The emergence 

of social media and applications has immensely changed our lifestyles immensely, influencing 

the way we define our interpersonal relationships, and connect with the outer world. Social 

media anchors itself on the concepts of sharing and communities. Social media platforms are 

perceived as good avenues for idea sharing and information transfer. 

In today’s digital world social media plays a meaningful role in education and information 

sharing. Social media is a platform which is beneficial for future learning, through these 

platforms, teachers can connect with students and incorporate social media into their lessons, 

making them more interesting, relatable and engaging. Social sites are a great tool when it 

comes to interacting with students. There are several handy tools/platforms are available to 

pursue learning where you can find useful learning resources, as- YouTube, Blogs, discussion 

forums, etc. There are several social media platforms available, some of them are listed here- 

 YouTube- YouTube’s greatest strength as an online learning resource is that it’s a free and 

easily accessible repository for videos. Videos for educational purposes are said to have 

various pedagogical benefits, including improved thinking through visual clues, enhanced 

mastery learning, and increased student engagement. 

 Facebook- The major advantage of Facebook has over other social media platforms is that 

it is the most widely-used social media platform which nutures various virtual 

communities and connections. Facebook also offers an option to develop an application 

that will cater to your needs, while simultaneously integrating interactive features. 

 Pinterest- It is a search engine which can yield thousands of educational materials from 

infographics to simple images. Infographics cut down information into bite-sized data for 

easier mental digestion and better memory recall. 

 Hashtags- Hashtags bring together publicly-posted and available materials (e.g., photos, 

videos, status, etc.) on a specific category across all social media platforms. The advantage 

of using hashtags is that it makes easier for the user to search for various content. 

 Google Docs- It is not a social media platform, but it provides easy access for collaboration 

and also allows multiple users to freely access documents online. 

2.6 
SOCIAL MEDIA- CHALLENGES AND ISSUES FACED 
DURING LEARNING 

Teachers and students are using social media in education; this is also shown by several 

research studies. Studies have explored the learners’ perceptions towards use of social media 

in higher education where both challenges and opportunities are exists. Studies denotes to the 

facts that teachers are using social networking technologies as a teaching and learning tool in 
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the informal/ virtual learning environment. Studies found a direct link between Social 

Networking Sites use and education where one can search according his/her needs 

(Ngonidzashe, 2013). 

The term social media is used to describe the use of networked tools by individuals or groups 

of people to consume, produce and share content. To do the same several platforms such as- 

Facebook, Skype, Wiebo, WeChat, and WhatsApp as well as individual web and blog sites are 

used. Significant educational benefits of using social media are (Anderson, nd.)-  

 learning awareness of potential interaction with others. 

 Enhanced media/digital literacy. 

 Increased informal participation in institutional, social and political activities. 

 Integration of formal with informal learning. 

 Support for continuing relationship between institutions and alumni. 

 Improve knowledge retention and understanding. 

 Increase class participation and motivate students. 

 Build community and connects with students to the global community. 

 Become an effective member of an online community. 

 Improve students writing (through writing for peers, feedback) 

 Improve student attitudes towards the course content. 

 Digital citizenship. 

 Global competency. 

 Internationalizing of learning in which global classrooms, instructors and students are 

available to teach and learn with peers using Internet-based global network. 

Challenges 
Several challenges are associated with the use of social networking sites in learning- 

 Teachers cannot make assumptions about students’ proficiency with social media. 

 Student proficiency must be taken into account when designing activities. 

 Lack of technology skills or support. 

 Online misbehaving. 

 Time required to monitor. 

 Activities and assessments should be designed carefully. 

 Comments and posts on social media platforms are public. 

 Internet exposes students to inappropriate material, unwanted adult interactions, and 

bullying from peers. 

 Issues related to privacy, authorship and ownership rights. 

 Information overload as another challenge. 

 Quality of content. 

 Online safety of students. 
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 Loss of control wherein one can receive unsolicited negative comments. 

2.7 FUTURISTIC LEARNING 
In 21st century, everything is transforming whether it is education, global trade and economy, 

technology or society. To cope-up with such transformations and succeed in facing the 

challenges in real-life, leading to his holistic progress, one needs to gain new skill-set in every 

aspect of facing challenges in life. The term 21st century skills refer to a broad set of 

knowledge, skills, work habits, and character traits that are believed by educators, school 

reformers, college educators, employers, and others to be critically important to success in 

today’s world. Thus, the 21st Century Skills or future skills or new age skills are the skills that 

are required by an individual for his/her holistic development. Such skills develop us as- 

globally active, digitally transforming, collaboratively moving forward, creatively progressing, 

seeking competent human resource and quick in adopting changes. Empowering our young 

one's with such skills is a challenging task. 

2.8 POINTS TO REMEMBER 
 The term 21st century skills refer to a broad set of knowledge, skills, work habits, and 

character traits. 

 The skills required by an individual for his/her holistic development is known as 21st 

Century Skills or future skills or new age skills.  

 Teachers are using social networking technologies as a teaching and learning tool in 

the virtual learning environment. 

 In digital world social media plays a meaningful role in education, information sharing, 

and future learning.  

 Using such platforms, teachers can connect with students and incorporate social media 

into their lessons, making them more interesting, relatable and engaging. 

2.9 GLOSSARY 

 Learning Environment- An interconnected and technology-driven world which can be 

virtual, online or remote, called virtual learning environment. 

 Learning Environments are able to accommodate the unique learning needs of every 

learner to provide effective learning. 

 Virtual Learning Environments provide the structures, tools, and communities that 

students and educators can use to attain the knowledge and skills required to succeed 

in 21st century. 

 Online Learning- Online learning can be termed as a tool that can make the teaching–

learning process more student-centered, more innovative, and even more flexible. 
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 Online learning is defined as “learning experiences in synchronous or asynchronous 

environments using different devices (e.g., mobile phones, laptops, etc.) with internet 

access. 

2.10 CHECK YOUR PROGRESS 
1) Explore the challenges and opportunities involved in social media. 

2) How do you understand the role of social media in learning? Explain in your own 

words. 

3) What do you mean by learning environments? Explain different learning environments. 

4) Write a short comment on futuristic learning. 
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3.1 INTRODUCTION 
Digital technology has changed the way in which students use visual materials in academic 

work and has increased the importance of visual literacy skills. (Matusiak, et. al., 2019) Visual 

literacy refers to the ability to interpret, negotiate, and make meaning from information 

presented in the form of an images (Wikipedia). 

The web, social media, and mobile technology have contributed to the ease of viewing and 

sharing images on a global scale. This digital transformation is not only associated with the 

proliferation of information resources, but also with the increasing importance of the image as 

a mode of knowledge representation. Image users are no longer only viewers, but are also 

creators of and active contributors to visual communication. Visual literacy emerges as a set of 

essential competencies for today's learners. As we are surrounded by visual media, it does not 

necessarily mean that we know how to find appropriate images, understand their meaning in 

their respective context, or integrate them accordingly (Matusiak, et. al., 2019). The 



DVTEE- 201: ICT Resources and Applications- II UOU 

Unit 3: Fundamentals of Image Editing Page 24 of 151 
 

development of multimedia technologies for learning and reachability of smart devices offers 

new ways in which learning can take place in different age group learners. The term multimedia 

denotes, Text, Images and graphics, Audio, Video, and Animation. 

 

3.2 OBJECTIVES 
After the successful completion of this unit, you will be able to- 

 Explore types of images. 

 Define raster and vector images. 

 Explore key features of Adobe Photoshop and GIMP. 

 Define copyright issues involved with images. 

3.3 TYPES OF IMAGES 
File formats are intended to store particular kinds of digital information. For Example- the 

".JPEG" file format is designed only to store still images, while the ".GIF" format supports 

storage of both still images and simple animations. The most well-known formats have file 

specifications that describe exactly how the data is to be encoded. 

Digital image files are seen by programs as streams of data (binary digits, as- 0s and 1s), a 

method is required to determine the format of a particular file within the file system. One 

popular method is to determine the format based on the final portion of the filename, known as 

the filename extension. 

A digital image is a picture that is stored on a digital device, i.e. a computer. A digital image 

means, which consists of a sequence of numbers (binary digits, as- 0, and 1) that computers 

can understand. To create a digital image, generally you have two ways, as- using software 

(i.e., Paint brush, Photoshop, etc), and using digital cameras (i.e. mobile phones, web cams, 

etc). 

Note: Some terminologies about images. 

What is a pixel? 

A 'pixel' (also called picture element) is a tiny square of colour. Lots of pixels together can 

form a digital image. More number of pixels in a image shows better quality of the image 

whereas lesser number of pixels in an image shows lower quality of the image. 

What is Resolution? 

Resolution is usually described as “Pixels per Inch” (PPI) when referring to a computer display, 

or “Dots per Inch” (DPI) used by a printer when printing an image. Generally speaking, 300 

DPI is considered the industry standard for printing (although many printers can print over 

2000 DPI), whereas an image on a computer screen is displayed at about 100 PPI (a newer ‘4k’ 

computer monitor that is 28″ across the diagonal (or about 71 centimetres) has approximately 

160 PPI and some mobile phones have screens with over 400 PPI). This means that, even if the 
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image quality looks good on your screen, the resolution may not be good enough or of an 

acceptable quality when printing. 

 

This means, you need larger images (higher resolution) for printing. The disadvantage is that 

high resolution images correspond with large file sizes, so you need to think about the size of 

the image (in centimetres) on the printed page. For example, to print an A4 sized image so that 

the image covers the full page at 300 DPI, you need a minimum resolution of 3508 X 2480 

pixels, which means an image file size of between approximately 5MB (Lossless PNG) to 

13MB (Lossless JPEG), which may be too big for environments with low or expensive 

bandwidth. 

When developing teaching resources, we recommend that you do not enlarge the image on the 

page more than a standard photo print size. This will reduce the file size of images you need to 

embed in the resource to ensure good quality printing (if printing in colour). 

Image file formats- 

 GIF (Graphic Interchange Format)- GIF uses lossless compression for relatively small 

file sizes, as compared to uncompressed data. The GIF format can only show 256 

colors. 

 TIFF (Tagged Image File Format)- TIFF files have many formats, as- Black and white, 

greyscale, 4-bit color, 8-bit color, and 24-bit color images.  

 BMP (Bitmap)- Bitmap is monochrome and the color table contains two entries. Each 

bit in the bitmap image represents a pixel.  

 JPEG (Joint Photographic Expert Group Format)- A JPEG image provides very good 

compression, but does not uncompressed exactly as it was; JPEG is a lossy compression 

technique. 

 PNG (Portable Network Graphics)- It utilizes lossless compression. It is a universal 

format that is recognized by the World Wide Web consortium (W3C), and supported 

by modern web browsers. 

3.4 RASTER AND VECTOR IMAGES 
Images are the greatest contributors to the visual appeal of your website. Images are files, just 

like any other document in your computer, but they can be coded and formatted differently to 

reproduce the image you want to see. We find these referred to as raster and vector graphics. 

These formats represent two very different methods of creating an image. [2] 

Raster Image/Graphics- 
The image files most of us are already familiar with using are typically raster format. Examples 

of these are JPEG, GIF and BMP. When we interact with pictures, we took on digital cameras 

for example, we are dealing with JPEG or JPG files. Raster files recreate an image by recording 

the color value of pixels, which represent the smallest single point on a screen that can be 
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assigned a color by the display. The higher the number of pixels (or density, measured as pixels 

per inch) translates to how sharp the image is, and how large it can be rendered without losing 

quality. [2] 

The number of colors available in the image file is based on the length of the value available 

to each point. If we only allowed a single binary character for each pixel point, we would be 

able to keep our file size as small as possible. This however would mean we could only 

represent our image in black and white (binary only allows us two options, 0 or 1, so we can 

only represent two colors.). When we allow longer values to represent a single point, we can 

assign values a larger range of colors. Once we scale these up, however, we trade away our 

smaller image sizes in order to have more colorful pictures. [2] 

Traditionally, we have faced this trade off by using different image formats in different areas 

of our website. While reserving JPG for our larger images or photos, we can use GIF for smaller 

icons and indicators. GIFs limit us to 256 colors, but since most icons use few colors, we are 

able to capitalize on the benefits of this format here. It is important to note that raster images 

will quickly lose quality when rendered at sizes larger than the original image’s width or height. 

[2] 

Vector Images/Graphics- 
Vector images store information about colors and locations as definitions of angles, lines, and 

curves in mathematical format. The benefit of a vector formatted image is that it can be scaled 

both up and down in size without distortion or degradation in image quality. This is due to the 

fact that the image is “drawn” by the browser each time it is loaded, and the processor performs 

the steps necessary to recreate the image. Since the image can be scaled, the same image file 

can be drawn very large, or very small, without changing the file size. [2] 

To resize the image, you can perform compression / decompression techniques. When we 

discuss compression in terms of graphics, we need to consider whether it will result in a lossy 

or lossless result. A lossless result means the compression techniques used do not remove data 

from the original copy, so we can restore the image to its exact original size and appearance. 

A lossy compressions structure can result in greater compression, but achieves the extra 

advantage by removing information from the file. [2] 

Slicing- For some time, there has been a practice of breaking larger images up into many 

smaller ones (a process called slicing), in an effort to allow webpages to load more quickly. 

3.5 POPULAR OPEN- SOURCE IMAGE EDITING TOOLS 
[1] GIMP (www.gimp.org)- 

"GIMP is a free and open-source raster graphics editor used for image manipulation and image 

editing, and free-form drawing"- Wikipedia. It is the well-known alternative to Adobe 

Photoshop (which is paid licensed) for image editing and manipulation. It is a feature-rich and 
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free program, allowing you to show your creativity in photo editing. You can freely download 

it from the following link, as- www.gimp.org. 

[2] Krita (www.Krita.org)- 

It is a free and open-source raster graphics editor designed primarily for digital painting and 

2D animation. Krita is a great tool for sketching or digital painting, and has multiple brush 

options. If you are creating cartoons, textures, concept art, and digital paintings, Krita supports 

almost all kinds of activities. You can freely download it from the following link, as- 

www.Krita.org. 

[3] Pinta (www.pinta-project.com)- 

It is somehow similar to MS Paint. Pinta is an open-source, cross-platform (can run in other 

Operating Systems) bitmap image drawing and editing program. It is a basic image editing 

application which is easy to learn, you can download it from the following link, as- www.pinta-

project.com. 

[4] Darktable (www.darktable.org)- 

It is a free and open-source photography application software. It has several image editing 

features like Adobe Photoshop, as- dynamic adjustment filters and presets, and etc. You can 

download it from the following link, as- www.darktable.org. 

[5] DigiKam (www.digikam.org)- 

DigiKam is an advanced open-source digital photo management application that runs on Linux, 

Windows, and Mac Operating System. The application provides a comprehensive set of tools 

for importing, managing, editing, and sharing photos/images. You can download it from the 

following link, as- www.digikam.org. 

[6] Inkscape (www.inkscape.org)- 

It is a free and open-source vector graphics editor used to create vector images, primarily in 

scalable Vector Graphics format. Other formats also can be imported and exported. It offers a 

rich set of features and is widely used for both artistic and technical illustrations such as 

cartoons, clip art, logos, typography, diagramming and flowcharting. You can download it from 

the following link, as- www.inkscape.org. 

3.6 BRIEF INTRODUCTION TO ADOBE PHOTOSHOP 
Adobe photoshop is a photo editing and raster graphic design software which allows users to 

create, edit, and manipulate various graphics. It is developed by Adobe Systems for both 

Windows and Mac Operating Systems. It allows to create and edit raster images with multiple 

layers, and also supports multiple file formats. Adobe Photoshop having a sidebar with a 

variety of tools in its toolbox with multiple image-editing functions. These tools typically fall 
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under the categories of drawing; painting; measuring and navigation; selection; typing; and 

retouching. Brief introduction of such tools are- [5] 

 Pen tool- The pen tool creates precise paths that can be manipulated using anchor 

points. The free form pen tool allows the user to draw paths freehand, and with the 

magnetic pen tool, the drawn path attaches closely to outlines of objects in an image. 

 Clone stamp tool- The Clone Stamp tool duplicates one part of an image to another part 

of the same image by way of a brush. 

 Shape tools- Photoshop provides an array of shape tools including rectangles, rounded 

rectangles, ellipses, polygons and lines. 

 Measuring and navigation- The eyedropper tool selects a color from an area of the 

image that is clicked, and samples it for future use. 

 Selection tools- Selection tools are used to select all or any part of a picture to perform 

cut, copy, edit, or retouching operations. 

 Cropping- The crop tool can be used to select a particular area of an image and discard 

the portions outside the chosen section. 

 Slicing- The slice tool can be used to divide an image into different sections, and these 

separate parts can be used as pieces of a web page design once HTML and CSS are 

applied. 

 Moving- The move tool can be used to drag the entirety of a single layer or more if they 

are selected.  

 Marquee- The marquee is a tool that can make selections that are a single row, single 

column, rectangular. An area that has been selected can be edited without affecting the 

rest of the image. 

 Lasso- The lasso tool is similar to the marquee tool; however, the user can make a 

custom selection by drawing it freehand. There are three options for the lasso tool– 

regular, polygonal, and magnetic. 

 Quick selection- The quick selection tool selects areas based on edges, similarly to the 

magnetic lasso tool. The difference between this tool and the lasso tool is that there is 

no starting and ending point. 

 Magic wand- The magic wand tool selects areas based on pixels of similar values. 

 Eraser- The Eraser tool erases content based on the active layer.  

 Color replacement tool- The color replacement tool allows the user to change the color, 

while maintaining the highlights and shadows of the original image, of pieces of the 

image. 

3.7 OVERVIEW OF IMAGE EDITING AND GIMP 

Image editing- 
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A photo editing software makes visually appealing changes to the photos and helps you 

organize your photographs into collections. From the business viewpoint, images contain 

thousands of words and also can be a symbol of your brand. Image editing software can take 

the scanned image of the old pictures/images, covert and restore them into the digital images. 

So, that one can edit and reshape old memories. [7] 

Why edit a/an image/photograph? [7] 

 For gaining attention, so that business benefit can be attain. 

 For Portrait Services. 

 For Clipping. 

 For quality enhancement, And many more. 

Things to be noted while selecting Photo Editing Software- [7] 

 Almost all computers, digital cameras, smartphones, and other movable devices come 

with in-built image editing software.  

 File Format– The images that you need to create should locate on the web in the right 

format. That format can be any, i.e., JPEG, PNG or GIF. The file format you choose 

should also allow you to compress the file size of your photo for the web. 

 Organizing Tools– Try finding the software that helps you keep track of your photos 

by using naming schemes, search, and thumbnail previews, especially when you are 

taking lots of pictures. 

 Standard Editing Tools– Your photo editing software should possess at least minimum 

level editing requirements like resizing, cropping, rotating and adjusting brightness and 

contrast in your photos. These tools should be quick and easy to use. 

 Photo Sharing– You should select a program that integrates to photo-sharing services 

like Integra, Flickr, etc. 

Some are the basic steps for editing image(s)-  

 Crop your image(s) and clean them up. 

 Adjust white balance. 

 Adjust exposure and contrast of your image. 

 Adjust colour vibrancy and saturation. 

 Sharpen images. 

 Finalize and share image. 

 

Introduction to GIMP-  

GIMP is a multi-platform photo manipulation tool. GIMP stands for 'GNU Image Manipulation 

Program'. The GIMP is suitable for a variety of image manipulation tasks, including photo 

retouching, image composition, and image construction. It has many capabilities, as it can be 
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used as a simple paint program, an expert quality photo retouching program, an image format 

converter, etc. GIMP is free available from many sources for many operating systems. [6] 

Some of the key features and capabilities of GIMP are- [6]  

 A full suite of painting tools including brushes, a pencil, an airbrush, cloning, etc. 

 Sub-pixel sampling for all paint tools for high-quality anti-aliasing. 

 Layers and channels. 

 Advanced scripting capabilities. 

 Multiple times undo/redo. 

 Transformation tools including rotate, scale, shear and flip. 

 Supports wide range of file formats, as- GIF, JPEG, PNG, XPM, TIFF, TGA, MPEG, 

PS, PDF, PCX, BMP, etc. 

 Selection tools, as- rectangle, ellipse, free, fuzzy, Bezier and intelligent scissors. 

 

You can perform several photo editing tasks, some of them are listed here. as- 

 Basic image and layer manipulation techniques. 

 Different shaped images. 

 Introduction to layer masks to modify the opacity of a layer. 

 Basics of colour curves. 

 Image formats overview. 

 Photo editing techniques. 

 Luminosity masks. 

 Layer masking and creative filter applications. 

 Several paintings brush. 

 Automate editing. 

Note- for accessing/knowing more detailed tutorials about GIMP, you may follow/visit to- 

www.gimp.org/tutorials. 

3.8 COPY RIGHT ISSUES OF IMAGES 
Photographs are more often the subject of copyright infringement due to the ease of 

republishing photos on the Internet. Because photos are so often published without attribution, 

it can be difficult to locate the actual owner of an image. You should use images responsibly. 

Most databases and websites provide information about copyrights and how their images can 

be used. Read this information carefully and comply with usage guidelines. Usage guidelines 

can vary. [3] 

There are a number of different citation styles including but not limited to APA, MLA, AP, 

Chicago, etc. It is important to stay consistent with style usage throughout any particular 
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document. If you are using images pursuant to a Creative Commons (CC) license, so you 

should have good understanding of CC licenses to properly cite to such materials. [3] 

Any items obtained from the web or scanned from a print source should be attributed to the 

owner of the copyrighted work. This includes photographs, paintings, or other works of art, 

tables, graphs, and other illustrations from primary or secondary source materials. Images from 

royalty free clip art, such as the clip art available in Microsoft Word or Power Point, do not 

need to be cited. Generally, the following elements are needed in an image citation- [3] 

Artist's name (if known). 

Title of image (if known). 

Title of article or book if applicable. 

Author of article or book if applicable. 

Title and date of journal if applicable. 

Database name if applicable. 

Date of access if online. 

Date of publication if originally from print material. 

URL if applicable. 

NOTE-  

Many image libraries allow you to filter search results by licence status: for instance, CC0 (in 

the public domain, no attribution required), CC BY (free to re-use with attribution and 

indication if changes were made) or CC BY-NC (free to re-use in a non-commercial context, 

with attribution and indication if changes were made). The CC Search tool 

(http://search.creativecommons.org) enables you to search multiple libraries simultaneously. 

[4] 

Google Images- Advanced Search option enables you to filter results by Usage Rights, similar 

to Creative Commons categories. Be aware that Google doesn't accept responsibility for the 

reliability of these results- check the terms of use at source where possible. [4] 

3.9 POINTS TO REMEMBER 
 Image users are no longer only viewers, but are also creators of and active contributors 

to visual communication. Visual literacy emerges as a set of essential competencies for 

today's learners. 

 The term multimedia denotes, Text, Images and graphics, Audio, Video, and 

Animation. 

 A 'pixel' (also called picture element) is a tiny square of colour. Lots of pixels together 

can form a digital image. More number of pixels in a image shows better quality of the 

image whereas lesser number of pixels in an image shows lower quality of the image. 

 A digital image is a picture that is stored on a digital device, i.e. a computer. A digital 

image means, which consists of a sequence of numbers (binary digits, as- 0, and 1) that 
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computers can understand. To create a digital image, generally you have two ways, as- 

using software (i.e., Paint brush, Photoshop, etc), and using digital cameras (i.e. mobile 

phones, web cams, etc). 

 Resolution is usually described as “Pixels per Inch” (PPI) when referring to a computer 

display, or “Dots per Inch” (DPI) used by a printer when printing an image. 

 Adobe photoshop is a photo editing and raster graphic design software which allows 

users to create, edit, and manipulate various graphics. 

 A photo editing software makes visually appealing changes to the photos and helps you 

organize your photographs into collections. 

 Photographs are more often the subject of copyright infringement due to the ease of 

republishing photos on the Internet. Because photos are so often published without 

attribution, it can be difficult to locate the actual owner of an image. You should use 

images responsibly. 

 There are a number of different citation styles including but not limited to APA, MLA, 

AP, Chicago, etc. 

3.10 GLOSSARY 

 Vector images- Vector images store information about colors and locations as 

definitions of angles, lines, and curves in mathematical format. The benefit of a vector 

formatted image is that it can be scaled both up and down in size without distortion or 

degradation in image quality. 

 Raster image- The image files most of us are already familiar with using are typically 

raster images. Raster files recreate an image by recording the color value of pixels, 

which represent the smallest single point on a screen that can be assigned a color by the 

display. The higher the number of pixels in a image shows the better quality if the 

image.  

 GIF (Graphic Interchange Format)- GIF uses lossless compression for relatively small 

file sizes, as compared to uncompressed data. The GIF format can only show 256 

colors. 

 TIFF (Tagged Image File Format)- TIFF files have many formats, as- Black and white, 

greyscale, 4-bit color, 8-bit color, and 24-bit color images.  

 BMP (Bitmap)- Bitmap is monochrome and the color table contains two entries. Each 

bit in the bitmap image represents a pixel.  

 JPEG (Joint Photographic Expert Group Format)- A JPEG image provides very good 

compression, but does not uncompressed exactly as it was; JPEG is a lossy compression 

technique. 
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 PNG (Portable Network Graphics)- It utilizes lossless compression. It is a universal 

format that is recognized by the World Wide Web consortium (W3C), and supported 

by modern web browsers. 

3.11 CHECK YOUR PROGRESS 
a) What do you understand by Raster and Vector images? Explain. 

b) List frequently used open-source image editing applications. 

c) Define the basics of editing an image. 

d) How can we safe ourselves of from violating copyright(s) of an image(s)? Explain. 

3.12 BIBLIOGRAPHY/ REFERENCES 

 Matusiak, K. K., Heinbach, C., Harper, A. & Bovee, M. (2019). Visual Literacy in 

Practice: Use of Images in Students’ Academic Work. Colleage & Research Libraries, 

80(1). https://crl.acrl.org/index.php/crl/article/view/16950/19370. 

 [2] https://courses.lumenlearning.com/suny-the-missing-link-an-introduction-to-web-

development-and-programming/chapter/chapter-12-graphics. 

 [3] https://guides.library.txstate.edu/c.php?g=184026&p=1218956. 

 [4] https://subjectguides.york.ac.uk/copyright/images. 

 [5] http://edshare.soton.ac.uk/3222/1/_edshare_main.html. 

 [6] https://docs.gimp.org/2.10/en/introduction.html. 

 [7] https://www.goodfirms.co/blog/best-free-open-source-photo-editing-software. 

 https://www.gimp.org/tutorials. 

3.13 SUGGESTED READINGS 
 https://www.gimp.org/tutorials. 

 Matusiak, K. K., Heinbach, C., Harper, A. & Bovee, M. (2019). Visual Literacy in 

Practice: Use of Images in Students’ Academic Work. Colleage & Research Libraries, 

80(1). https://crl.acrl.org/index.php/crl/article/view/16950/19370. 

 https://courses.lumenlearning.com/suny-the-missing-link-an-introduction-to-web-
development-and-programming/chapter/chapter-12-graphics.   



DVTEE- 201: ICT Resources and Applications- II UOU 

Unit 4: Fundamentals of Infographics Page 34 of 151 
 

 

UNIT- 4 

FUNDAMENTALS OF INFO GRAPHICS 

 

4.1 INTRODUCTION 

4.2 OBJECTIVES 

4.3 CHARACTERISTICS OF THE INFOGRAPHICS 

4.4 TYPES OF INFOGRAPHICS 

4.5 DESIGNING AN INFOGRAPHIC 

4.6 INFOGRAPHICS DESIGNING TOOLS 

4.7 APPLICATIONS OF INFO GRAPHICS 

4.8 POINTS TO REMEMBER 

4.9 GLOSSARY 

4.10 CHECK YOUR PROGRESS 

4.11 BIBLIOGRAPHY/ REFERENCES 

4.12 SUGGESTED READINGS   

 

 

4.1 INTRODUCTION 
The infographics are modern technologies, which are used for visual presentations in which 

graphic drawings (illustrations, symbols, maps, graphics, etc.) are combined with text messages 

to transform complex data and concepts into the form of images and drawings that can be 

clearly conveyed and easily understood by the people/target audience. The term "infographics" 

is made up of "Information" and "Graphics" that integrates visualization of data, illustrations, 

texts and images all together in a form which is easily understood. The infographics are 

characterized by numerous advantages, including simplifying the scientific facts and 

presenting them in a visualized data form, shortening explanatory texts, illustrations, and 

videos to expressive symbols, images and simple denotations, as well as being easier to be 

produced (Afify, 2018). 
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Infographics are widely spread in educational and entertainment social networks, newspapers, 

magazines, and multi-interest websites more than the other electronic media as well as being 

less expensive than the other means. With the use of infographics one can design more than 

one type of visuals; and perhaps the most prominent ones are static and animated types. The 

static infographics denote the graphics which are designed for the objective of printed use or 

digital use in websites, or to be viewed on a screen as digital presentations without integrating 

any motion; And animated elements having motion properties. As for the animated 

infographics, they refer to the graphics designed for being displayed on graphic animated video 

screens on video websites such as YouTube, TV ads or animated presentations on smartphones, 

etc (Afify, 2018). 

In other words, you can say that the word infographic is an abbreviation of "information 

graphic". It is a visual representation of data or editorial content. "Simply put, an infographic 

uses visual cues to communicate information. They do not need to contain a certain amount of 

data, possess a certain complexity, or present a certain level of analysis. There is no threshold 

at which something becomes an infographic. It can be as simple as a road sign of a man with a 

shovel that lets you know there is construction ahead, or as complex as a visual analysis of the 

global economy" (Lankow, Ritchie, & Crooks, 2012). 

The effectiveness and role of using infographics in teaching-learning proven the students' 

success when they are utilized as an alternative to texts, and also the infographics facilitates 

learning in comparison to ordinary texts, as well as enabling learners to participate effectively 

in the learning process, which results in long lasting learning. Infographics are specially used 

in e-learning environments which are based on the digital platform through e-learning 

management systems or using other platforms of Internet based learning. The key advantage 

of using infographics is that there is no fixed place or need for a specific time to learn the things 

which are expressed using such mediums. 

4.2 OBJECTIVES 
After the successful completion of this unit, you will be able to- 

 Explore features of infographics. 

 Define types of infographics. 

 Explore infographics designing steps and tools. 

4.3 CHARACTERISTICS OF THE INFOGRAPHICS 
Infographics are considered as a new type of digital learning resources with innovative style of 
information presentation. The most important feature of infographics is their flexible structure 
which permits the visual portrayal of information, the possibility of preparing them with 
alternative forms, besides the possibility for using other components in their production, such 
as video and audio files. The infographics are characterized by the following (Afify, 2018)- 



DVTEE- 201: ICT Resources and Applications- II UOU 

Unit 4: Fundamentals of Infographics Page 36 of 151 
 

 Visual Attractive: The visual attractiveness is considered the essence of infographics 
use. It combines graphic elements to represent digital data, with an objective textual 
explanation through icons, images, colors, and all elements and principles of visual 
designs able to orient the audience and have their attention focused. 

 Symbolizing and Summarizing: One of the most important features of infographics 
is the ability to symbolize information, concepts, facts and knowledge into brief 
presentation in visual symbols, ranging from images, shapes, arrows as well as static 
and animated graphics. 

 Ability for Sharing: Infographic designs are produced in the form of digital content, 
which makes them easy to share across different electronic content platforms, and that 
enables the readers to learn collaboratively, and supports communication among them. 
Additionally, their design holds copyrights in high regard so the content is more secure 
when shared. 

 Enhancement Ability: The designer can add the links and additional internet addresses 
as reference for the learners to enrich their culture and knowledge about the subject of 
infographics. Besides, there is also the possibility for adding the titles of some books, 
abstracts, studies and related research, which enriches the electronic as well as the 
printed content. 

 Enhancing learning process: Infographics act in having the learning process done in 
a fast and effective manner. Learners prefer visual images to abstract texts for learning. 
This can be explained by the fact that infographics constitute an appropriate tool which 
ensures that students learn important points in the subject matter quickly; and that they 
attain textual information according to their own speed. 

4.4 TYPES OF INFOGRAPHICS 
There are many reasons why infographics are becoming a common form of communication in 

several places. There are many different types of infographics, few of them are-  

[1] Comparison- 

Generally, used for- 

This vs. That 

Clearly divided into 2 columns. 

Showing differences between 2 similar concepts. 

Visuals should illustrate differences immediately. 

[2] Chart- 

It is very commonly used infographics in which you can explore more information in a short 

time whereas in a textual format you would have to re-read everything; opening and closing 

paragraphs would reiterate. 

[3] Timeline- 

Such type of infographics used to present history of something, like- concept, product, service, 

person (e. g. timeline of their life). 

[4] Process- 
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Using infographics, you can explain complex and multi-layered information in an easy manner; 

you also can add branching and decision making. 

[5] Essay- 

Components of an essay or article broken into parts. Think of it in rectangular blocks. You can 

use different elements of an essay, i.e., definitions, comparisons, checklists- keeps it from being 

boring, keeps viewer alert. 

Infographics doesn’t need to be read chronologically like it would be in a textual report- a 

reader can pick out whatever their eye is drawn to. It reduces redundant text compared to a 

report. 

[6] Animated- 

Instead of a poster- like infographic, this is a video which includes images, charts and graphs 

but can also include music and narration. Such type of infographics can be created with 

PowerPoint or Keynote, or using other video editing software. 

4.5 DESIGNING AN INFOGRAPHIC 
STEP 1: Decide what you want to say. [1] 

First decide, what do you want to get across to your readers? Then, you should think about the 

different ways in which the data can be visualized.  

NOTE- Each of the infographics on the previous page could probably be displayed in different 

ways and using different designs. However, each design may subtly change the meaning, or at 

least change the way the audience interacts or reacts to it. 

STEP 2: Pinpoint Patterns 

You must decide- 

What does the data say? 

What insight is starting to emerge from patterns in the statistics or data? 

What type of infographic might fit for presenting your data or core message? 

What types of charts, images, or graphics might be useful to convey your message correctly? 

STEP 3: Sketch out a design 

Try to sketch a draft of your design on paper before creating your graphic using software. Your 

design may change many times before you get it right and it is much easier to scrap a piece of 

paper than it is to start over in the software. It can save your time. 

STEP 4: Choose your tool 

There are many online/offline tools which are used to design different types of infographics. 

Different tools requiring different technology skills. Some of the popular tools which are 

frequently used to design infographics, are-  

 PowerPoint 

 Piktochart (www.piktochart.com) 

 Venngage (www.venngage.com) 

 Canva (www.canva.com) 
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 Easelly (www.easel.ly) 

 Visme (www.visme.co) 

 Infogram (www.infogram.com) 

 Snappa (www.snappa.com) 

4.6 INFOGRAPHICS DESIGNING TOOLS  

Microsoft PowerPoint 

Basically, PowerPoint is not a photo editing tool, but you can create effective infographic using 

PowerPoint. As humans are visual creatures, and as such we prefer a visual illustration as 

opposed to reading a plain text. Infographics allow you to present information in an eye-

catching and efficient manner. Plain and simple designs can become more effective by putting 

your creativity and imagination on them. PowerPoint is a tool through which you can use Smart 

arts, Clip arts, Place holders with different colours, Various shapes, and more. 

Piktochart (www.piktochart.com) 

Piktochart is a cloud-based infographic application that allows users to use various templates 

to create infographics, presentations, reports for many purposes. Piktochart is unique from 

other applications because it creates content that is web-publisher ready and can stand alone as 

a part of multimedia content. It is intuitive, produces fast templates, and can personalize content 

and designs as needed. All templates are stored in an online library which also affords real-

time collaboration to streamline the workflow and reach desired objectives. [2] 

One of the most crucial aspects of Piktochart is its ability to embed the multimedia principle. 

It allows users to showcase their learning by using pictures to support the text which is in 

accordance with the multimedia principle. People learn better from words and pictures than 

from plain words alone and benefit all types of learners. The foundation of Piktochart is to use 

images, graphics, and designs to communicate meaningful information with intended 

audiences. Moreover, most of the templates provided by Piktochart contain the option to 

include both words and graphics and helps viewers engage in active learning. It supports the 

collaborative learning approach as it encourages learners to share information and collaborate 

with others to share resources and information. It is a learning environment that provides 

information and allows opinion sharing between team members to make a rich connection 

among them. [2] 

Canva (www.canva.com) 

Canva is a graphic design tool for the web, Android, iOS, and Chrome. Users create an account 

(with an email address or by linking their Google or Facebook account) and then follow the 

instruction to proceed. Users can upload their own images and create their own layouts or 

choose from a selection of thousands of built-in images and design templates (some of which 
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are available freely). You can adjust brightness and contrast, resize images, overlay images 

with text and colors, and many more. Once you have finished creating designs, they will 

automatically save to the cloud storage and can be accessed from the user's login in the website. 

Users can then export their creations via e-mail, as Facebook posts, or via Twitter, and they 

can download their images in JPEG, PNG, or PDF format. I hope you will definitely take an 

experience. 

Easelly (www.easel.ly) 

Easelly is an infographic creation tool that guides users to build visual and text representations 

of a concept or idea. Easelly provides some themes and many objects, but it is up to the user to 

search through these materials and organize them into a cohesive infographic. This website 

offers an option to share finalized products, so there are many public infographics to choose 

from for a template. This website is easy to navigate, and progress on an infographic can be 

saved for later. I hope you will try it out by visiting the www.easel.ly. 

Infogram (www.infogram.com) 

With the help of this tool, you can create and share infographics, charts, and other types of data 

illustration. can create a variety of illustrations, ranging from tree maps to bar and line graphs. 

Designs can be customized with quotes, brief text, and a title; other elements like a facts and 

figures section, world map, and a live countdown timer can also be added with just a couple of 

clicks. By clicking on ..., you should try it out. You can also share your creations on Twitter, 

Facebook, or Pinterest; or copy and paste a link to embed it on a blog or other websites. 

Venngage (www.venngage.com) 

Venngage is an online tool for creating infographics, reports, and data visualizations. You can 

choose a template or color scheme, then you can add text, change fonts, and add widgets, charts, 

and icons. You can save the infographic as an image or download it as a PDF. Users can also 

publish their image to the site and share it with other users via a URL or embedding code. 

4.7 APPLICATIONS OF INFO GRAPHICS  

 Infographics are graphic visual representations of information, data, or knowledge, 

intended to present complex information quickly and easily. 

 Using infographics, you can easily convey the figures and data from which people can 

absorb information in a much efficient way. 

 They can improve cognition by utilizing graphics to enhance the human visual system’s 

ability to see patterns and trends (source: Wikipedia). 

 Infographics display large amounts of data and information in the form of a graph or 

picture. 
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 Infographics are entertaining, eye-catching, concise, and all the information they 

contain is easily digested by the audience. 

 Infographics are composed of- Visual Elements (i.e. Color, Graphics, Reference icons), 

Content Elements (i.e. Time Frames, Statistics, References), and Knowledge Elements 

(i.e. Facts, etc).  

 Infographics are helpful to communicate more effectively for agencies reporting 

achievements to their clients. 

 Trade shows are chaotic places where infographics can play key role to interactive data 

visualization. 

4.8 POINTS TO REMEMBER 

 The term "infographics" is made up of "Information" and "Graphics" that integrates 

visualization of data, illustrations, texts and images all together in a form which is easily 

understood.  

 Infographics are widely spread in educational and entertainment social networks. 

 The effectiveness and role of using infographics in teaching-learning proven the 

students' success. 

 Infographics are considered as a new type of digital learning resources with innovative 

style of information presentation.  

 Many different types of infographics are in trend, as- Comparison, Chart, Timeline, 

Process, Animated, etc. 

 Some popular tools to design infographics, are- PowerPoint, Piktochart, Venngage, 

Canva, Easelly, Visme, Infogram, Snappa, etc. 

4.9 GLOSSARY 
 Visually attractive: The visual attractiveness is considered the essence of infographics 

use. 

 Infographic: information with graphics. 

 Infographics: It is characterized by numerous advantages, including simplifying the 

scientific facts and presenting them in a visualized data form, shortening explanatory 

texts, illustrations, and videos to expressive symbols, images and simple denotations, 

as well as being easier to be produced (Afify, 2018). 

4.10 CHECK YOUR PROGRESS 
a) Define the role of infographics in teaching-learning. 

b) How can you design an effective infographic? Explain. 

c) List the different types of infographics. 

d) Define some of the popular infographic designing tools with their key features. 

e) State the applications of infographics. 
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5.1 INTRODUCTION 
Word processing means creating or manipulating text documents using some word processing 

computer applications in presentable and effective manner. Manual documentation has so 

many constraints like once a document is created it cannot be modified. We cannot apply 

different text formats to make an attractive document. Such documents cannot be saved for 

later use and multiple original copies cannot be created. But all these problems and lot more 

can be easily handled in computer using a word processor. Using these, we not just only create 

the attractive and presentable documents, but also modify them with the required change and 

can print the hardcopy when needed. They provide various other tools like spell checker, mail 

merge, tables, etc., to handle many other typical documentation problems. Commonly used 

word processors are Microsoft Word, Google Docs, WordPad, Apache OpenOffice writer, etc. 
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5.2 OBJECTIVES 
After going through this unit, you will be able to: 

 Explore the new features of Word 2010 

 Use Bullet and Numbering in MS Word 2010 

 Describe how to create Table 

 Describe ways of adding and editing text in MS Word 2010 

5.3 INTRODUCTION TO MICROSOFT WORD 2010 
Microsoft Word 2010 is one of the word processing components of Microsoft Office 2010 

Suite used for creating, editing, formatting or printing the text document. Using this you can 

create high quality text documents like letters, reports, books, etc. The powerful features of 

Microsoft Word 2010 make it one of the most widely used word processing software.  

Starting Microsoft Word 2010  

To start Microsoft Word 2010  

Step 1: Click on Start button  

Step 2: Choose All Programs  

Step 3: Click on Microsoft Office option 

Step 4: Click Microsoft Word 2010 option in the expanded list. 

5.4 BULLET AND NUMBERING 
Information in a Word document is stored in the form of pages. So before you start typing 

anything in your document, it is necessary to set the page format like its size, margins, 

orientation, etc. so that we can get the document output in the desired manner. Although these 

settings can be modified anytime even after typing your document, but that will lead to the 

change in adjustment of document contents. 

Creating Lists- 

Bullets on numbers make a list look attractive and legible. A Bulleted list has a dot, circle or 

any other symbol to identify the items in the list. A numbered list has a number or a letter to 

identify the items in the list. Word 2010 offers another powerful feature which is used to 

automatically create the ordered or unordered list of items in the document. An ordered or 

number list is the one in which the items get automatically numbered when they are entered 

and in unordered list, items get marked with a specific symbol every time when a new item is 

added. 

Creating A Bulleted List  

Step 1: Type the items of the list and select them.  
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Step 2: On the Home tab, click on the drop-down arrow of bullets option in the paragraph 

group. 

Step 3: Click a bullet style from the list that appears. 

Creating A Numbered List  

Step 1: Type the items of the list and select them.  

Step 2: On the Home tab, click on the drop-down arrow of numbering option in the paragraph 

group.  

Step 3: Click a number style from the list that appears. 

 

5.5 UNDO AND REDO 
Correcting a typo in Microsoft Word is one of the easiest and most useful functions to access. 

There are two ways to do so- Via Keyboard shortcut, and Via menu control  

Via Keyboard shortcut 

Undo Keyboard Shortcut- The Undo command undoes anything you do in Word, which 

includes formatting text, moving blocks, typing and deleting text. Undo a mistake you have 

made, simply press Ctrl + Z on your keyboard. The last thing you edited will be undone. 

Redo Keyboard Shortcut- Use the Redo command to set things back to the way they were. If 

you have undone three edits and you press Ctrl + Y, word will redo the earliest undone action. 
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Via Menu Control 

The other option to use the undo and redo functions in word is via the top menu bar. You will 

see two arrows- a back one and a forward one. 

5.6 WORKING WITH FONTS 
Formatting means making the document attractive and presentable. It helps to enhance the 

appearance of your document to make it more effective and easily readable. The tools available 

in Font group are: 

 Font is used to change the style and shape of the characters. 

 Font Size is used to change the size of the characters. 

 Font Color is used to change the text color. 

 Bold is used make text darker. 

 Italic is used to make text slanted towards right. 

 Underline is used to put a line under text. 

 Text Highlight Color is used to highlight text in our document. 

 Change Case is used to change the case of the selected text without typing again. 

 Various text properties that can be set using Font group.  

 

Changing Font- Font is the style and shape of the letters of the text. Some of the fonts in Word 

2010 are: Calibri, Arial, Times New Roman, Comic Sans MS, Monotype Corsiva, Bradley 

Hand ITC, etc. 

To change font- 

Step 1: Select the text to change the font. 

Step 2: On the Home tab, click on the drop-down arrow of the Font option in the Font group.  

Step 3: Click a font style from the list to apply it. 

Changing Font Size- Font size is the size of the characters of text. 

Step 1: Select the text to change the font size. 

Step 2: On the Home tab, click on the drop-down arrow of the Font Size option in the Font 

group.  

Step 3: Click a font size from the list to apply it. 

Changing Font Color-  

Step 1: Select the text to change the color. 

Step 2: On the Home tab, click on the drop-down arrow of the Font Color option in the Font 

group.  

Step 3: Click a color from the list to apply it. 

Typing Superscript and Subscript-  
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The text that appears above the normal text level is called superscript text. The text that appears 

below the normal text level is called subscript text. 

For example, in O2 and O2, 2 is the superscript and subscript, respectively. 

Step 1: Select the text to change it to superscript or subscript. 

Step 2: From the Home tab, click on superscript or subscript in the Clipboard group.  

Making text Bold, Italic, Underline- 

Bold means darker text. Italic means text slanted towards the right. Underline means a line 

under the text. 

Making text Bold 

Step 1: Select the text you want to make bold. 

Step 2: On the Home tab, click on Bold option in the Font group.  

Making text Italic 

Step 1: Select the text you want to make italic. 

Step 2: On the Home tab, click on Italic option in the Font group.  

Underlining text 

Step 1: Select the text you want to make underline. 

Step 2: On the Home tab, click on Underline option in the Font group.  

Highlighting Text: We can highlight the text in our document just like we highlight with a 

marker pen. 

Step 1: Select the text to highlight. 

Step 2: On the Home tab, click on the drop-down arrow of the Text Highlight Color option in 

the Font group. A color palette appears. 

Step 3: Click the color you want to apply. 

Changing Case- 

The Change Case command is used to change the case of the selected text without typing again. 

There are five change case options in Word. 

 Sentence Case: This changes all the selected letters of the sentence to lowercase except 

the first letter. The first letter remains capital. 

 Lowercase:  This changes all the selected letters to small case. 

 Capitalize Each Word: This changes the first letter of each word to capital. 

 Uppercase: This changes all the selected letters to capital. 

 tOGGLE cASE: This reverse the case of every letter. The letters in small are converted 

to capital and the letters in capital are converted to small. 

To change the case of text: 

Step 1: Select the text. 
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Step 2: On the Home tab, click on the Change Case option in the Font group.  

Step 3: Click an option from the list of options. 

5.7 PAGE BREAK 
Word automatically inserts a page break when you reach the end of a page. If you want the 

page to break in a different place, you can insert a manual page break. Or you can setup rules 

for Word to follow so that the automatic page breaks are placed where you want them. This is 

especially helpful if you are working in a long document. As adding breaks to your document 

can make it appear more organized and can improve the flow of text. 

Breaks in Word 

To insert a blank line between two existing lines, we place the cursor at the end of the line after 

which we want to insert a blank line and press the Enter key. 

Page Break 

Page break allows us to move text to the next page before reaching the end of a page. Word 

2010 automatically inserts a page break when you reach the end of the document. However, 

we can choose to add manual page break as per our requirements. Words offers three page 

break options- Page Break, Text Wrapping and Column Break.  

Page 

To insert a page break: 

Step 1: Click where you want to start a new page. 

Step 2: Click on Breaks and choose Page Option in the Page setup group in Page Layout tab. 

The page break will be applied to the document, and the text will move to the next page.  

Column 

Column break is used when you wish to divide your document into multiple columns. It splits 

the text into columns. By using column breaks, you can move to the next column. This 

command works only when we have formatted the text in columns using the Column option in 

the Page Layout tab.  A column break can be applied to balance the appearance of the columns. 

Step 1: Click the location where you want to start a column break. 

Step 2: Click on Page layout tab. 

Step 3: Click on Breaks and choose Column option. The content gets shifted to the next 

column. 

Text Wrapping 

When text has been wrapped around an image or object, you can use a text wrapping break to 

end the wrapping and begin typing on the line below the image. 

Step 1: Click the location where you want to start a column break. 

Step 2: Click on Page layout tab. 

Step 3: Click on Breaks and choose Text wrapping option. The content gets shifted to the 

next column. 
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5.8 HEADER AND FOOTER 
A Header or footer is text or graphics that is usually printed at the top or bottom of every page 

in a document. A header is printed in the top margin and footer is printed in the bottom margin. 

The area where the header and footer content are placed is called the Header and Footer 

workspace. 

The workspace uses a layer of the document that is separate from the main body and behaves 

differently than the documents main content. After the header or footer is inserted the areas 

become active and can be edited. They are tagged with Header or Footer and are marked with 

a dashed line. Any content in the header or footer area will appear and print on every page. 

Inserting Header or Footer 

Header and footer display information, such as page number, author’s names and date. 

To insert header/footer: 

Step 1: Click on Insert tab 

Step 2: From the header and footer group, click on header or footer. A Gallery appears. 

Step 3: Choose a header style or footer style. Now, type the text you want at the top or bottom 

of each page respectively 

Step 4: Click on the close header and footer from the closed group in the design tab 

Or 

Double click in the document area 

Editing Header or Footer 

To edit header/ footer  

Step 1: Click on insert tab  

Step 2: Click header from the header and footer group. A Drop menu appears. 

Step 3:  Select edit header option. The header area will get activated. 

Step 4:  Now, modify and edit the header using the design tab. Following are some useful 

special items you can insert into a header. 

 Page Number: Click page number from the header and footer group and select the 

location for the page number. 

 Date & Time: Click date and time from the Insert group. The date and time dialogue 

box appears. Select date format of your choice and click ok button. 

 Graphic: Click Picture /Clip Art from the insert group to insert graphics in the 

header. 

5.9 PAGE SETUP 
The page setup is the parameters defined by the user that help determine how a printed page 

appears. Those parameters can include everything from the size, margins, page orientation, and 



DVTEE- 201: ICT Resources and Applications- II UOU 

Unit 5: Introduction to Text Editor (MS Word) Page 49 of 151 

quality of print. More plainly, it's a menu that allows users to customize the size and layout of 

a page.  

1. Click the Page Layout tab. 

2. Click the small arrow in the bottom-right corner of the Page Setup group. 

The Page Setup dialog box will appear. 

 

 

 

 

 

 

 

 

 

5.10 HANDLING TABLES IN MS WORD 

Creating Table- 
Tables are used to organise the information in the form of rows and columns. Rows and 

columns intersect each other to form rectangular blocks called cells. 

Creating Tables 

Word 2010 offers different methods to create tables in your document. Let us learn three of 

them. 

Method 1  

Step 1: Click on Insert tab 

Step 2:  Click on table from the tables group. A grid of cells will appear. 

Step 3: Move the pointer across the grid to select rows and columns. Click in the last cell of 

the selected grid of cells to get the table. 

Method 2  

Step 1: Click on insert tab  

Step 2: Click on table from the tables group 

Step 3: Select insert table option. The Insert table dialogue box will appear on the screen. 

Step 4:  Enter the number of rows and columns required in the table. 

Step 5: Click on Ok button to get your table at the insertion point. 

Method 3  

Another way to create table is by drawing it manually as need it used in draw table tool: 
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Step 1: Use Draw Table option in the Table expanded list as the mouse pointer will turn to a 

pen shape. 

Step 2: Drag the pointer diagonally on the document to draw the outer border of the table. 

Step3: Now using the same tool draw horizontal and vertical lines in the box to divide it in the 

required number of rows and columns. 

Deleting Table- 

There is a very quick way to delete a table in Word 2010, that doesn’t even involve selecting 

the table first. Place the cursor in a cell in the table and notice that the Table Tools contextual 

tab appears in ribbon.  

Click Layout > Rows & Columns > Delete > Delete Table. 

Doing this removes the table from your document. 

Moving Across The Table Cells- 

You can use Mouse or keyboard keys to move across the table cells for data entry. 

 Press Tab key or use Right Arrow key to move forward in the next cell. 

 To move in the backward direction along the row press Shift + Tab or Left Arrow key. 

 Use Up or Down arrow key to move upward or downward in a Column. 

 You can also click directly in a cell to enter or edit cell value 

Selecting Table Cell, Row and Column- 

Selecting cells 

You can select multiple cells, rows and columns in a table to edit or format them together. 

Selecting a single cell 

Triple click inside the cell to select the cell. 

Selecting all the cells in a row  

Keep the mouse pointer in front of the row towards the left edge and click the left mouse button. 

The entire row will be selected. 

Selecting all the cells in a column 

Keep the mouse pointer at the top of the column. The pointer turns to a downward arrow. Click 

the left mouse button to select the entire column. 

Entering And Deleting Data- 

Entering data: 

After creating your table, to enter data values in the table cells: 

 Click in the cell where you want to enter the data. A blinking cursor will appear in it. 

 Type the cell information. 

 Use arrow keys to move into the next cell. 

Or 

 Click in the cell where information is to be inserted. 
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 Continue like this till all the data values are entered in the table. 

Deleting Data: 

 Select the data you want to delete 

 Press the delete key from the keyboard.  

 Cell data will be removed from the table. 

Or 

 Move the cursor at end of data that you want to delete the data  

 Press the Backspace key from the keyboard.  

 Cell data will be removed from the table. 

Inserting And Deleting Columns and Rows- 

Inserting Rows or Columns 

Sometimes, you need to add more columns and rows in a table. 

Inserting a new column 

Step 1: Select cell where you want to insert a new column and click on Layout tab. 

Step 2: Click on Insert Left or Insert Right in the Rows and Column group. 

Inserting a new Row 

Step 1: Select cell where you want to insert a new row and click on Layout Tab. 

Step 2: Click on insert above or insert below as needed in the rows and columns group to get a 

new blank row in the table. 

Deleting Rows or Columns 

You can also remove the rows or columns that are no more needed in a table.  

Step 1: Select the cell whose row or column is to be deleted. 

Step 2: Click on the Layout Tab. 

Step 3: Click on delete option in the rows and columns group. 

Step 4: Select an option- Delete Rows or Delete columns. The entire row or column get deleted.  

Merging And Splitting Cells- 

Merging table cells 

If you want to show some data value in a table which is spread across two or more cells, you 

can merge them to form a single cell. The cells can be merged horizontally across the row or 

vertical across the column. 

Step 1: Select the adjacent cells which are to be merged. 

Step 2: Choose the Layout Tab and click on Merge Cells option on the Merge group. 

The selected cells will merge to form a single large cell 

Splitting table cells 

Just as you can merge two or more cells to form a single large cell, you can also split a cell into 

two or more cells to store multiple values in them. 

Step 1: Select the cell that has to be split 
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Step 2: Choose the Layout Tab and click on Split Cells option in it. The Split cells dialog box 

will appear 

Step 3: Enter the number of rows and columns in which the cells is to be splitted. 

Step 4: Click on Ok button 

5.11 POINTS TO REMEMBER 

 Microsoft Word 2010 is a word processing program, designed to help you create 

professional quality documents.  

 With the finest document formatting tools, word helps you organise and write your 

document more efficiently. Word also includes powerful editing and revising tools so 

that you can collaborate with others easily.  

 We have learnt how to create our own documents, open existing documents and finally 

save them before closing. The standard toolbar and the formatting toolbar offer a variety 

of buttons which offer a quick service to the user. 

 Text can also be justified between the margins. Proper line spacing can be given in 

between the printed lines. Text entries separated by commas can be put in the bulleted or 

numbered form. This makes the major heads clearly readable and long remembered. 

 Word document generally contain paragraphs with different formatting. Even a very 

simple document with a centered heading and a justified body contains paragraph with 

two different types of formatting. 

5.12 GLOSSARY 

 Word processing means creating or manipulating text documents using some word 

processing computer applications in presentable and effective manner. 

 A Bulleted list has a dot, circle or any other symbol to identify the items in the list.  

 A numbered list has a number or a letter to identify the items in the list. 

 The Undo command undoes anything you do in Word, which includes formatting text, 

moving blocks, typing and deleting text. 

 Use the Redo command to set things back to the way they were. 

 Formatting means making the document attractive and presentable. It helps to enhance 

the appearance of your document to make it more effective and easily readable.  

 Page break allows us to move text to the next page before reaching the end of a page. 

 A Header or footer is text or graphics that is usually printed at the top or bottom of every 

page in a document. 
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 The page setup are the parameters defined by the user that help determine how a printed 

page appears. 

 Tables are used to organise the information in the form of rows and columns. Rows and 

columns intersect each other to form rectangular blocks called cells. 

5.13 CHECK YOUR PROGRESS 

Descriptive type questions- 

a) What is Word Processor? 

b) Write a short note on Header and Footer in Word. 

c) Write a short note on Page Break? 

d) What is font? How can you change the font size? 

e) Write the steps involved in creating a Bulleted list. 

f) How will you create a Numbered List? 

g) Define a Table? What are the steps to create and delete a table? 

h) Write to steps to insert a table in MS Word. 

i) Write to steps to merging and splitting cells.  

j) Difference between superscript and subscript. 

Objective type questions- 

a) Font is used to change the style and shape of the characters. (True/False) 

b) Italic is used to make text slanted towards right. (True/False) 

c) Change Case is used to change the case of the selected text typing again and again. 

(True/False) 

d) Rows and columns intersect each other to form rectangular blocks called table. 

(True/False) 

e) A header is printed in the top margin and footer is printed in the bottom margin. 

(True/False) 

f) Column break is used when you wish to divide your document into single columns. 

(True/False) 

g) ………… on numbers make a list look attractive and legible. 

h) ………………… display information, such as page number, author’s names and date. 

i) You can use a ……………..break to end the wrapping and begin typing on the line below 

the image. 

j) ………….. allows us to move text to the next page before reaching the end of a page. 

Answer (Objective Type Question)- 

[a] True   [b] True   [c] False  [d] False    

[e] True  [f] False   [g] Bullets  [h] Header and footer  
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[i] text wrapping [j] Page break 
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6.1 INTRODUCTION 
Data analysis, calculations, decision making are some of the important jobs in today's 

competitive world of business. Organised representations of data, Complex calculations, 

statistical analysis, comparisons, graphical representation of data are the jobs which are 

frequently performed in the large organisations and Institutions to manage their operations. But 

carrying out all such jobs manually is not only tedious and time consuming but also error-

prone. 

Electronics spreadsheet are the computerized solutions of all such problems. In these 

spreadsheets, data can be stored easily in the tabular form and all type of calculations, analysis, 

etc. can easily be performed very quickly and accurately. Various electronic spreadsheet 

programs are available to choose from like Apache Google Sheets, OpenOffice calc, Quattro 

Pro, Lotus 123, Microsoft Excel, etc. 
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6.2 OBJECTIVES 
After the successful completion of this unit, you will be able to- 

 Define the importance of spreadsheet 

 Explore Formula and functions 

 Explore the Analysing data 

6.3 INTRODUCTION TO MICROSOFT EXCEL 2010 
Excel 2010 is an electronic spreadsheet program. It is the spreadsheet component of Microsoft 

Office 2010 suite, which is one of the most widely used application software for data analysis. 

Microsoft Excel allows to store data in the form of rows and columns. Both number or text 

type of data values can be used in the worksheet on which you can perform different type of 

operations using built in functions or with the help of user defined formulas. 

Starting Excel 2010 

To start Excel 2010, follow the steps given below 

Step 1: Click on the Start button. 

Step 2: Click on All Programs. 

Step 3: Click on Microsoft Office 

Step 4: Click on Microsoft Excel 2010 

6.4 COMPONENTS OF SPREADSHEET PROGRAM 
Workbook: An Excel document is known as workbook which is basic excel file saved with 
.xlsx extension. It is a collection of multiple worksheets. There are 3 worksheets by default in 
a workbook, but you can always add or Delete worksheets as per your need. 

Worksheet: Worksheet is like an individual page of the workbook having grid of cells formed 
by the intersection of rows and columns. The 3 worksheets are named as sheet 1, sheet 2, sheet 
3 by default which can be changed if needed. 

Rows: Rows forms the horizontal sections of the worksheet which are arranged vertically from 
top to bottom. There are 1,048,576 rows in a single excel worksheet. Excel worksheet and are 
identified by the numbers 1 to 1,048,576. 

Columns: Columns forms the vertical section of the worksheet which runs horizontally from 
left to right. There are 16,384 columns in a worksheet represented with the labels A, B, C……... 
upto XFD. 

Cell: A small rectangular box formed by the intersection of a row and a column is called cell. 

Formula Bar: It displays the contents of the current cell. It also used to create and view 
formulas. 

6.5 WORKING WITH FUNCTIONS AND FORMULAS 
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Basic Calculations in Excel 

Excel has a powerful feature to perform calculations on the data. We can perform addition, 

subtraction, multiplication and decision of numbers either using formulas or using functions. 

Formulas 

A formula in Excel is an expression made up of data value or the cell references of the cells 

containing data values along with the mathematical operations. These operators are used along 

with the operands that can be the constant or cell references of the values to be used for 

calculations. Every formula in Excel begins with “=” sign. Various arithmetical operators that 

are used in the formula are: 

=A1 + B1 - C1 

Where A1, B1, C1 are Operands (Cell Addresses) 

Creating Formulas using Fixed Values 

We can use the numbers directly in the formula as fixed values.  For example, if you want to 

add two numbers say 100 and 200. 

Step 1: Select the cell where result is to be displayed and click in it. 

Step 2: Enter the formula =100+200 and press enter key or click button on the Formula Bar. 

The result 300 will appear in the selected cell. 

Creating Formulas using Cell Address 
Look at the cells. 

 

 

 

 

To find amount of a product: 

Step 1: Click in the cell D5 and type = (equal to) sign 

Step 2: Click in the cell B2. 

Step 3: Now type and then click on the cell D2 

Step 4: Click on Enter button on the formula bar. The result will appear in cell E2. 
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Types of Formulas 

Let us learn some simple ways of using a formula. 

In Excel each cell can contain a calculation. In Excel terminology, it is called formula. Each 

cell can contain one formula. When you enter a formula in a cell, Excel calculates the result of 

that formula and displays the result of that calculation to you. Excel uses standard operators of 

formula, such as plus sign for addition (+), a minus sign for subtraction (-), an asterisk for 

multiplication (*), forward slash for division (/) and a caret (^) for exponents. 

All formulas in Excel must begin with an equal sign (=). This is because the cell contains or is 

equal to the formula and the value it calculates. There are two types of formulas- Simple and 

Compound formulas. 

Simple Formulas 

Basic formulas involve only one operator in a formula. Here is an example to understand this 

well. To calculate the sum of two numbers, follow these steps: 

Suppose you want to calculate the total marks of student. To enter formula, use the given steps: 

Step 1: Click in the cell where you want to display the total. For example, G2. 

Step 2: Type the formula=B2 + C2 + D2 + E2 + F2 

Step 3: Press Enter Key. The total gets displayed in the cell. 
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Compound Formulas 

Compound formulas are used when you need more than one operator. 

To calculate the Simple Interest (Principal x Rate x Time) / 100), follow these steps: 

Step 1: Type the content in the worksheet. 

Step 2: Click on C6 (Where the result of the formula is to be displayed) 

Step 3: Here, type= (C3*C4*C5)/100 

Step 4: Press Enter Key and the result will be displayed. 

Functions in Excel 2010 

Functions are the predefined formulas used to perform complex calculations and analysis. 

These functions can be used in excel worksheet with the help of their name along with the 

arguments in the form of cell references, ranges or values, which appear between parenthesis 

next to the function name. for example, a simple mathematical function to calculate the sum of 

multiple cell values can be used as: 
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The above function will show the sum of values stored in cell range A1 to a10. 

Some of the commonly used function in Excel are: 

1) SUM () 
SUM function is used for summing up the values in a given cell range. The syntax of using this 

function is: 

=SUM (Argument1, Argument2 ……….)  

Where SUM is the name of function and arguments can be the cell reference, cell range or 

fixed values. Multiple arguments can be used by separated by comma (,) operator. 

For example, =SUM (A1, A2, A3) [use of multiple cell address] 

Or =SUM (A1:A10, B1:B10) [use of cell range] 

Or =SUM (10,5,4) [use of constant values] 

2) AVERAGE () 
This function is used to calculate the average or mean of the series of numbers in a cell range. 

The syntax of using this function is: 

=AVERAGE (Argument1, Argument2 ……….)  

Where AVERAGE is the name of function and arguments can be the cell reference, cell range 

or constants.  

For example, =AVERAGE (A1: A10) 

Or = AVERAGE (A1, A5, A10) 

Or = AVERAGE (10,15,60,80) 

3) MAX () 
This function is used to find the largest values in a series of numbers. The syntax of using this 

function is: 

=MAX (Argument1, Argument2 ……….)  

Where MAX is the name of function and arguments can be the cell reference, cell range or 

constants.  

For example, = MAX (A1: A10) will return the largest number value among the number stored 

in the range of A1 to A10. 

= MAX (10,15,60,80) will return 80 being the largest among these four numbers. 

4) MIN () 
This function is used to find the smallest values in a series of numbers. The syntax of using this 

function is: 
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=MIN (Argument1, Argument2 ……….)  

Where MIN is the name of function and arguments can be the cell reference, cell range or 

constants.  

For example, = MIN (A1: A10) will return the smallest number value among the number stored 

in the range of A1 to A10. 

= MIN (10,15,60,80) will return 10 being the smallest among these four numbers. 

5) IF () 
This is a logical function which evaluates a logical expression for its truthness and returns a 

value among the two options. The syntax of using this function is: 

=IF (Condition test, True_value, False_value)  

In this, IF is the name of function and conditional test is the logical expression to be tested for 

its truthiness. True_value is the value returned in case expression evaluates to TRUE and 

False_value is the value returned if the condition stands False in the expression. 

For example, = IF (A10>10, 1, 2)  

In this statement, if the value in cell A10 will be less than or equal to 10 it will return 2 as a 

result where as if the value will be more than 10 the value returned will be 1. 

6.6 MODIFYING WORKSHEETS WITH COLOR 
Working with columns, rows, and cells 

By default, every row and column of a new workbook is set to the same height and width. 

Excel allows you to modify column width and row height in different ways. 

To modify column width: 

1. Position your mouse over the column line in the column heading so the white cross 

becomes a double arrow . 

Click and drag the column to the right to increase column width or to the left to decrease 

column width. 

 

2. Release the mouse. The column width will be changed in your spreadsheet. 
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If you see pound signs (#######) in a cell, it means the column is not wide enough to display 

the cell content. Simply increase the column width to show the cell content. 

To set column width with a specific measurement: 

1. Select the columns you want to modify. 

2. Click the Format command on the Home tab. The 

format drop-down menu appears. 

3. Select Column Width. 

4. The Column Width dialog box appears. Enter a 

specific measurement. 

Click OK. The width of each selected column will be 

changed in your worksheet. 

Select AutoFit Column Width from the format drop-down 

menu, and Excel will automatically adjust each selected 

column so all of the text will fit. 

To modify row height: 

Position your mouse over the row line so the white cross 

becomes a double arrow . 

Click and drag the row downward to increase row height or 

upward to decrease height. 

Release the mouse. The height of each selected row will be changed in your worksheet. 

To set row height with a specific measurement: 

1. Select the rows you want to modify. 
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2. Click the Format command on the Home tab. The format drop-down menu appears. 

3. Select Row Height. 

 
 

 

4. The Row Height dialog box appears. Enter a 

specific measurement. 

 

 
5. Click OK. The selected rows heights will be 

changed in your spreadsheet. 

Select AutoFit Row Height from the format drop-

down menu, and Excel will automatically adjust each 

selected row so all of the text will fit. 

MODIFYING WORKSHEETS WITH COLOR 

Step 1: Select the row or column you want to change the color. 

Step 2: Click on the fill color option 

Step 3: Select the Theme color, you want to fill in the row or column. 
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6.7 ANALYZING DATA 

This section illustrates the powerful features Excel has to offer to analyze data. 

1) Sort: You can sort your Excel data on one column or multiple columns. You can sort in 

ascending or descending order. 

2) Filter: Filter your Excel data if you only want to display records that meet certain criteria. 

3) Conditional Formatting: Conditional formatting in Excel enables you to highlight cells 

with a certain color, depending on the cell's value. 

4) Charts: A simple Excel chart can say more than a sheet full of numbers. As you'll see, 

creating charts is very easy. 

5) Pivot Tables: Pivot tables are one of Excel's most powerful features. A pivot table allows 

you to extract the significance from a large, detailed data set. 

6) Tables: Tables allow you to analyze your data in Excel quickly and easily. 

7) What-If Analysis: What-If Analysis in Excel allows you to try out different values 

(scenarios) for formulas. 

8) Solver: Excel includes a tool called solver that uses techniques from the operations 

research to find optimal solutions for all kind of decision problems. 
9) Analysis ToolPak: The Analysis ToolPak is an Excel add-in program that provides data 

analysis tools for financial, statistical and engineering data analysis. 

6.8 SORT AND FILTER DATA 
Excel offers a variety of built-in tools for data management among which sorting and filtering 

features are the best one. The filter tool allows you to filter a column of data within a table to 

isolate the required key components. The sorting tools allow you to arrange data in ascending 

or descending order.  

Sorting Data  
Sorting means to arrange data either in ascending or descending order. 

To sort the data: 

Step 1: Select the cells. For example, A2:F4 

Step 2: Click on Data Tab on the ribbon 

Step 3: From the Sort & Filter group, Click on Sort A to Z option to sort in ascending order or 

Sort Z to A option to sort in descending order. 
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To sort data on basis of multiple columns: 

Step 1: Select the range of cells that contains the data to be selected. 

Step 2: On the Data Tab, in the Sort & Filter group, Click on Sort option. The sort dialog box 

appears. 

Step 3: Under Column, Click the Sort by down arrow and select a column from the list on 

which you want to sort the data. 

Step 4: Under Order, Click the down arrow and select an option to specify the sort order-A to 

Z or Z to A, Smallest to Largest or Largest to Smallest, from the list.  
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Step 5: Click on Add Level button and repeat step 3 and 4 to add another column to sort the 

data on. 

Step 6: Click on the OK button. 

 

 

 

 

Excel sorts the data on the basis of the first column and where the data values in the first column 

are same, on the basis of the second column. 

Filtering Data  

Filtering is a process to extract the records from the worksheet that fulfil certain conditions. It 

temporarily hides the rows that you do want to see. Excel provides AutoFilter and Custom 

Filter to filter the data in a worksheet. 

AutoFilter 

The AutoFilter is used to filter data on basis the specific values present in a column. 

To filter the records: 

Step 1: Select any cell in the range or select range of cells. 

Step 2: Click Filter option in the Sort & Filter group on the Data tab 

 

 

 

 

 

 

 

Filter drop button will appear to the right side of each field name in the column headers row. 

Step 3: Now, to filter the records with same data values in a particular field, click on the Filter 

drop button of that field name 
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A list appears showing the values of that column. The option Select All is checked by default. 

Step 4: Uncheck the Select All option and check only those values whose related records you 

want to see. For Example, choose value 89 in the science field to see the record of students 

who scored 89 marks in science. 

Step 5: Click on OK button to filter and see the selective records. 
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Custom Filter 

You can also use Custom Filter to extract the records that meet a specific condition. For 

example, to display the records where the marks in Maths are less than 91. 

Step 1: Select the range of data. 

Step 2: Click on Filter option in the Sort & Filter group on the Data tab 

 

 

 

 

 

 

Step 3: Click on Filter drop button next to the column on which you want to apply the condition. 

Step 4: From the drop list, select Number/Text Filters and click Custom Filter option from the 

submenu. The Custom AutoFilter dialog box will appear. 

Step 5: Click on the condition drop button to choose required condition like equals, does not 

equal, is greater than, is less than, etc. 

Step 6: Enter the value with which the condition is to be tested in the box next to it. You can 

add another condition, if needed, by joining it with And or Or option. 

Step 7: Click on OK button to get the filtered records 
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Removing Filter 

You can remove the filter and see all the records again. 

Step 1: Select any cell in the worksheet. 

Step 2: Click on Filter option in the Sort & Filter group on the Data tab 

The filter drop buttons will disappear from the worksheet and the hidden records will be 

displayed again in the worksheet. 

6.9 POINTS TO REMEMBER 

 Excel 2010 is an electronic spreadsheet program. It is the spreadsheet component of 

Microsoft Office 2010 suite, which is one of the most widely used application software 

for data analysis  

 Spreadsheet were originally developed for book keeping. They are also useful for 

scientific calculations, data manipulation and for producing graphs. 

 Microsoft Excel include some statistical functions, but for serious research work a 

specialized package should be used. 

 Excel can also sort and select data, however for large amounts of data or more complex 

task, a database program should be used instead. 

6.10 GLOSSARY 
 A cell is a box at the intersection of a row and column in a worksheet where data is stored. 

 Columns are combination of all the vertical cells joined together in a single vertical line. 
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 Rows are combination of all the horizontal cells joined together in a single horizontal 

line. 

 Workbook is a group of worksheets, which can be stored as a unit. A workbook is stored 

on the disk in the form of a file with extension .xls. 

 Worksheet is the working area of MS-Excel. Each worksheet of a single workbook has 

its own identity and is separate from other worksheets. 

 Workspace is the working area of MS-Excel where workbooks, worksheets and other 

related objects may be opened and manipulated. 

6.11 CHECK YOUR PROGRESS 

Descriptive type questions- 

a) What are the components of Spreadsheet program? 

b) Define a Formula in Excel and also define types of formulas. 

c) Define all functions used in Excel?  

d) How can number be subtracted, multiplied, and divided in excel cells? 

e) Explain the SUM () function. 

f) What is sorting? How will you apply sorting to a range of cells? 

g) What is filter? 

h) How can we enter numerical value or formula as a label? 

i) What is the role of Auto filter option? 

j) Explain the use of IF () function with the help of an example. 

k) Differentiate between Formula and Function. 

Objective type questions- 

a) Formula should always start with = sign. (True/False) 

b) Formula and Function give the same result. (True/False) 

c) Ranges cannot be used in formulas.  (True/False) 

d) A function must be followed by opening and closing parenthesis. (True/False) 

e) The AutoFilter is used to filter data on basis the specific values present in a row. 

(True/False) 

f) Using sort function data can be stored either in … … …  and … …. … order. 

g) Sort A to Z option is used to sort the data in … … …  order. 

h) A formula always contains … … …  and … … …  

i) The cell address in a formula is known as … … …  

j) … … … function is used to calculate the sum. 

Answer (Objective Type Question)- 

[a] True  [b] True  [c] False  [d] True  [e] False  
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[f] Ascending, Descending [g] Ascending [h]create, edit [i] cell reference [j]sum 
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UNIT- 7 

INTRODUCTION TO MS POWER POINT-II 
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7.1 INTRODUCTION 
Presentation is a way of communication between the speaker and the audience. It helps to 

communicate the ideas for information on any topic to the masses. An effective presentation 

always leaves an everlasting effect in the minds of people, so it is very important to understand 

before creating any presentations that who are the target audience of that presentation? What 

should be the contents? How these are to be organised? And finally, what should be mode of 

presentation? A presentation can be in a written, oral or visual form. But a successful 

presentation is one which can bind the audience till the end by effectively communicating the 

core idea behind the presentation. Graphical components in a presentation like pictures, charts, 

motion clips, figures, diagram, etc, prove to be an excellent tool to convey the idea in an 

effective and interesting manner. 
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Earlier, there were limited tools available to deliver the presentation. The traditional tools like 

notes, drawn figures, images, still slides, etc., were used for this purpose. But now with the 

development of multimedia technology in the field of computers, the trends are totally changed. 

Today’s presentations are supported by multiple modes of communication like text images, 

graphics, videos, audios, etc. Animation and sound effects not only just make the presentation 

effective and interesting, but also help the presenter to quickly design the presentations. Some 

popular presentation software are. Microsoft PowerPoint, Google Slides, Prezi, Corel 

presentations, Open office impress and Harvard graphics. We are going to learn the use of one 

such application for designing a computer-based multimedia presentation. The name of this 

application is Microsoft PowerPoint 2010. 

7.2 OBJECTIVES 
After the successful completion of this unit, you will be able to- 

 Define MS PowerPoint Working 

 Explore Table 

 Define Charts and Graphs 

7.3 WHAT IS POWERPOINT 2010 
Microsoft PowerPoint 2010 is a presentation component of Microsoft Office 2010 suite which 

is used to design computer-based multimedia presentations. Presentation in PowerPoint is a 

collection of electronic slides containing information in the form of text, graphics, movie clips, 

sounds, etc. These slides are displayed in a sequential order one after the other at the time of 

presentations on the monitor or projection screen with all multimedia and animation effect in 

the form of a slide show. 

PowerPoint is not just used for creating electronic presentations, but is also used for making 

handouts, speaker notes, etc. which are effective tools for any kind of presentations. 

Starting PowerPoint 2010  

To start PowerPoint 2010: 

Step 1: Click start button on the Taskbar. 

Step 2: Select all programs 

Step 3: Choose Microsoft Office option in the submenu  

Step 4: Click Microsoft PowerPoint 2010 option 

7.4 COMPONENTS OF THE POWERPOINT WINDOW 
The various components of PowerPoint 2010 Windows are as follows. 
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File tab: It opens the backstage view to manage the files and settings. You can save, open and 

create a new presentation based on a blank or predefine templates. 

Quick access toolbar:  It is a customizable toolbar present on the left side of the titlebar used 

to quickly perform some of the commonly used functions like saving a file, undo, redo etc. 

Title bar: It appears at the top of PowerPoint window which shows the name of presentations 

you are working with and has three control buttons on its right side to minimize, maximize and 

close the window. 

Ribbon: This component is present just below the title bar. It has eight tabs in it wherein each 

tab is divided into the groups. The groups are the logical collection of PowerPoint command 

to perform various presentations related functions. 

Group: Logical collection of commands together are referred as group. It changes with every 

tab. File tab show following groups: clipboard, slides, font, paragraph, drawing and editing. 

Slide Pane: It is the actual work area where individual slides are created or modified. 

Notes Pane: It is a small rectangular area under the slide pane which is used for making the 

speaker notes for the individual slides. 

Slide Tab: It is present on the left side which shows miniature of each slide. Functions related 

to slide can be performed such as addition, deletion and rearranging slides from the slide tab. 

Outline Tab: It is present on the left side which show the existing text present in the slide.  

Status Bar: It is present at the bottom of the PowerPoint window. It displays the information 

about the current slide such a slide number, name of the theme, slide view and zoom 

percentage. 

Slide View: It is present on the status bar at the bottom of the PowerPoint window having four 

views: Normal view, slide sorter view, slideshow view and reading view 

7.5 CREATING PRESENTATIONS IN POWERPOINT 
Microsoft PowerPoint 2010 offers different ways to create new presentation. You may choose 
any of these method as per your needs which are available under Available Templates and 
Themes. These are: 

Blank Presentation: You can use this method to create customise presentations wherein you 
can add contents, format slide, apply effects of your own. This is the default way for creating 
presentations in PowerPoint. 

Recent Templates: The templates which you have used recently are shown in this category. 

Sample Templates: This is an easiest way to create presentations on some general topics. 
PowerPoint offers a set of readymade templates suggesting the contents and designyou’re your 
presentation. 
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Themes: This option is useful when you want to use predesigned format for your presentation 
as the present background font style, etc are provided by PowerPoint  

My Templates: In this, templates customised by you are saved and shown here which can be 
used later on  

New from Existing: It allows you to use create or modify the new template using existing 
templates as a base  

Common Terms Used in PowerPoint  

 slide a single page in a presentation which may contain text image stars video etc 
 presentation a group sequentially arrange  
 slides slide deck a group of related slides 

7.6 EDIT TEXT, FONT STYLE AND COLORS IN SLIDES 
Communication is a vital part of our daily life. We can communicate our ideas in verbal or 

written form. Communication through text is effective in Presentation having graphics adds for 

clarity. 

Inserting Text in a Slide 
Textbox command is used to create additional text placeholder on a slide, if needed 

To insert a text box: 

Step 1: Click on the insert tab 

Step 2: Click on text box from the Text group. 

Step 3: Drag the mouse pointer on the slide where you want to add the text. A text box will 

appear with a blinking cursor. 

Enter the text as needed. The Text box expands automatically to the next line, if the enter text 

is more than the size of the text box. 

Editing Text in a Slide 
The Text entered in a placeholder or text box can be modified easily. 

Step 1: Click on the text placeholder to be modified. The cursor appears. 

Step 2: Make changes as required and then click outside the placeholder. 

Changing the Text Box Background Colour 
Step 1: Select the text box. When you insert a text box, a new Format tab appears. 

Step 2: Click Shape Fill from the Drawing group and select the color of your choice. The select 

color will appear in the background of the text box. 

Changing the Text Box Outline 
Step 1: Select the text box. When you insert a text box, a new Format tab appears. 

Step 2: Click Shape Outline from the Drawing group and select the line color of your choice. 

You can use Weight option in it to change the line thickness. The select color will appear in 

the background of the text box. 
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Copying the Text in a Slide 
Step 1: Select the text to be copied. 

Step 2: Click copy option in the Clipboard group on the Home tab. 

Or 

Press Ctrl + C keyboard Shortcut. 

Step 3: Bring the cursor to the new location where text is to be pasted. 

Step 4: Click paste option in the Clipboard group. 

Or 

Press Ctrl + V keyboard Shortcut. 

The selected text will appear at the destination. 

Moving the Text in a Slide 
Step 1: Select the text to be moved. 

Step 2: Click Cut option in the Clipboard group on the Home tab. 

Or 

Press Ctrl + X keyboard Shortcut. 

Step 3: Click to select the destination where text is to be moved. 

Step 4: Click paste option in the Clipboard group. 

Or 

Press Ctrl + V keyboard Shortcut. 

The selected text will move to at the new position. 

Formatting the Text in a Slide 
Text entered in the slide using various placeholders appears as per the format set for these. 

PowerPoint offers wide variety of formatting features that can help you to change the default 

text formats as per the need of your presentation. 

Using Font Group 
Step 1: Select the placeholder that contains the text to be formatted. 

Step 2: Use the commands in the Font Group to format the text on the slide. 

Using Font Dialog Box 

You can also use Font Dialog box to collectively modify the text formatting.  
Step 1: Select the text to be formatted. 

Step 2: Click launcher button available in the lower right corner of Font Group. A Font Dialog 

box will appear. 

Step 3: Use the various text formatting and special effects option to change the default format.  

Aligning Text 
Alignment refers to the placement of text within the placeholder. Text inside the placeholder 

can be aligned to left, right, center or justified like this: 

Align Left: Aligns the text towards the left edge of the placeholder. 

Align Right: Aligns the text towards the right edge of the placeholder. 
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Center: Aligns the text between left and right edge of the placeholder. 

Justify: Aligns the text evenly between left and right edge of the placeholder. 

Using Paragraph Group 

 Step 1: Select the text or the placeholder whose text has to be aligned. 

Step 2: Click the required alignment option from the four options available on the paragraph 

group under the Home Tab. 

Using Paragraph Dialog Box 

 Step 1: Select the text or the placeholder whose text has to be aligned. 

Step 2: Click launcher button available in the lower right corner of Font Group. 

Step 3: A paragraph dialog box will appear and select the alignment under the General section. 

Text Direction 
This command is used to change the orientation of text in a placeholder. It has four options: 

Horizontal, Rotate all text 900,  Rotate all text 2700, and Stacked. The default text direction is 

Horizontal. 

Align text 
This command is used to align the text between the top and bottom edge of a placeholder. The 

options are: Top, Middle, and Bottom. 

7.7 WORKING WITH TABLES IN A PRESENTATION 
In PowerPoint 2010, tables are useful tool for presenting and organising the data in tabular 
form. A table is information arranged in horizontal rows and 
vertical columns. Tables are generally used to organised text 
on numerical data. When you first insert a table into a 
document, it appears as a simple grid with black gridlines 
defining the rows and columns. In PowerPoint, you can 
modify the appearance of table as per your choice. A well-
designed table conveys information in more meaningful way. 

Inserting Table 

Let us learn how to insert a table in PowerPoint. 

Using Insert Tab 

To insert a table: 

Step 1: Click on the insert tab 

Step 2: Click the table option from the table group. A drop-down menu will appear. 

Step 3: Drag the mouse over the required number of boxes. A table with the selected number 
of rows and columns will be inserted. 

Using Layout 
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To insert a table 

Step 1: Click on the new slide dropdown Arrow under the home tab. Select the title and content 
Layout from the drop-down list  

Step 2: Click on the insert table icon present on the slide. The insert table dialog box will 
appear. 

 

 

 

 

 

 

 

 

Step 3: You can define the number of rows and columns as per your requirements. 

Step 4: Click on Ok button 

A table will be displayed with defined number of rows and columns. 

 

 

 

 

 

 

 

 

Entering data in a table 

To enter data in a table: 

Step 1: Position the mouse pointer in the first cell of the table and typing whatever you want. 
If the data takes up more than one line in the cell, the text will automatically wrap to the next 
line. This increases the height of that cell and all the other cells available in that row. 
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Step 2: To move to the next insertion point, you can press the tab key on the keyboard or simply 
click on the desired cell. 

Step 3: Type whatever you want in the next cell. Thus, we can enter data in the table using the 
tab key or Arrow key or Mouse  

 

 

 

 

 

 

 

 

 

Step 4: Click anywhere outside the table when you have finished 

Inserting Rows and Columns in a Table 
To insert new rows in a table: 
Step 1: Locate the insertion point in a cell and right-click. A shortcut menu will appear. 

 

 

 

 

 

 

 

 

Step 2: Select the insert option and click either on the insert row above or insert row below sub 
option. After selection, you will see a new blank row is inserted. 

Deleting Rows and Columns in a Table 

Before you delete a row or a column, you should know that whatever you want to delete the 
content of the row or the contents and the structure of the row. 
To delete a row or column from a Table: 
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Step 1: select the row column you wish to delete 
step 2: under the layout tab, click on the delete option in the Rows and Column group. 
Step 3: Select the required option from the submenu. 

Formatting a Table  

PowerPoint offers numerous predefined table styles that you can use to quickly format a table. 
If the predefined tables styles do not meet your requirements, you can create and apply a custom 
table style. 

When you insert a table in a slide, a new tab appears known as Table Tools. This tab is divided 
into two sections such as Design and Layout tabs. You will find various tools and commands 
for formatting present on these tabs such as Borders, Shading, Table style, Border Color, Merge 
cells, Split cells, etc. 

Applying Table Styles 

When you insert a table in a slide, a table style will be applied automatically. PowerPoint 2010 
offers various predefined styles in the Table Style group on the Design tab under the Table 
Tools tab. To apply a table style: 

Step 1: Select the table. 
Step 2: Click on the design tab to access all the table styles and other options of this tab. 

 

 

 

 

 

 

 

Step 3: Hover the mouse over any table style to see its live preview on the slide. 
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Step 4: Click on the more dropdown Arrow of the table styles group to view all the options. 

Step 5: Click on the desired style to select it. 

Applying Borders 

To apply a border: 

Step 1: Select the cells on which you want to add a border. 

 

 

 

 

 

 

 

 

 

Step 2: Click on the Borders dropdown arrow in the table styles group on the design tab. Select 
the desired border type from the drop-down menu. 

Step 3: Selected border will be applied to the selected cells. 

 

Applying Border Color 

To change border color of a table: 
Step 1: Select the table. Click on the Pen Color option from the Draw Borders group in the 
design tab. 
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Step 2: Choose the required color from the color palette. You will see that mouse pointer 
changes to a pencil shape. 

Step 3: Click on the left mouse button on the border whose color you want to change or simply 
drag the mouse into the cell border and release the button. The line color will be changed. 

Applying Border Style 

A tool named as Pen style is used to change the line style of a table. 
To changing the line style of a table: 
Step 1: Select the table. 
Step 2: Under the table tool tab, click on the pen style list box which is present on the design 
tab. 
Step 3: A drop down mouse appears. Select the required style from the drop-down menu. 
Step 4: Position the mouse pointer on any border of the table and click on it. 

 

 

 

 

 

 

 

Applying Shading 

You can change the appearance of a table by adding shades. for example, if a table contains 
many rows and columns, you might shade alternate rows to help readers distinguish them from 
one another. To change table shading follow the given steps: 
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Step 1: Select the table and click on the design tab 

Step 2: Select the rows and columns that you want to modify. 

Step 3: In the table style group, click on the shading option and select any color of your choice. 

7.8 INSERTING CHARTS IN A PRESENTATION 
A chart is the graphical representation of data in which data is represented by symbols such as 
bars, lines, etc. It is an effective way of visualize data to the audience. In general, charts are 
widely used for, understanding large quantities of data and the relationships between parts of 
the data. There are many types of chart in PowerPoint 2010. Each chart has its own advantage. 
for example, a pie chart is used to show the percentage value data and line chart is used to show 
the trend of data over a period of time in effective way. 

Inserting Chart  
There are two main ways to insert chart in a presentation. 

Using Insert Tab 
To create a simple chart 
Step 1: Click on the insert tab. 

 

 

 

Step 2: In the illustration group, click on the chart option 

Step 3: The insert chart dialog box appears. Select the desired chart type from the left pane and 
the wide range of selected chart type will be appeared in the right pane. 
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Step 4: After selection, click on Ok button. 

The chart will be displayed in a slide. 

Using Layout 
To insert a chart: 

Step 1: Open a new file in the PowerPoint 

Step 2: Click on Home tab 

Step 3: Click on the Layout option from the slides group and change the layout of the file. 

Step 4: Select the title and content 

Step 5: Click on the insert chart icon in the content placeholder. 

Step 6: The insert chart dialog box appears. Select the chart type from the left pane and the 

wide range of the selected chart type will be appeased in the right pane. 

Step 7: Click on Ok button. 

An Excel window will open with the placeholder for your data. 

Modifying a Chart 

In PowerPoint 2010, there are many ways for customising and organising chart. You can 
change the appearance of chart by changing the text, line, font color, background, chart style 
etc. On inserting a chart, a new tab appears named as Chart Tools. This tab is divided into three 
sections. Design, Layout and format which contains various option that allows you to modify 
and format the chart as desired. 

Changing the Chart Type 

You can change the chart type as needed 

To change the chart type: 

Step 1: Select the chart. Click on the design tab under the chart tools. 

Step 2: Click on the change data type option in the type group. The change chart type dialog 
box will appear. 

Step 3: Select any chart type and click on Ok button. The chart will change accordingly. 

Or 

Step 1: Select the chart where you want to change layout. 

Step 2: In the chart layout group under the design tab, click on the more dropdown arrow to 
see all the available chart layout options. 

Step 3: Select desired chart layout. 

Changing Chart Style 

You can quickly modify the appearance of the chart by changing its style. Quick style for lines 
includes line styles, gradients, various effects and Shadow. 
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To change the chart style: 

Step 1: Select the chart whose layout you want to change. 

Step 2: Click the more dropdown arrow in the chart styles group under the design tab 

Step 3: Select any style from the list that appears. 

The chart will be displayed as per your selection. 

Changing Background 

You can modify a chart by changing its background. 

To change the background: 

Step 1: Select the chart whose background you want to change. 

Step 2: Click on the plot area and select the format plot area option from the shortcut menu 

Step 3: The format plot area dialog box will appear. You can select border-style, border color, 
shadow effect as per your requirement. 

Step 4: Click on the close button and observe the change. 

Editing Data 

Apart from that, the chart you are obtain on the slide has some fixed data in it. If you want a 
chart with your own set of data, follow the given steps: 

Step 1: A datasheet will open up. 

Step 2: Right click on the chart and click on the edit data option from the shortcut menu. A 
datasheet will open up containing the default data for charts. 

Step 3: Modify the data of this seat to any data you want. 

Every time you press Enter key on the datasheet the chart get refreshed and the newly entered 
data takes effect. 

7.9 
TIPS TO CREATE PROFESSIONAL SLIDE FOR 
PRESENTATION 

 Remember to avoid too much text. You should keep your text brief and include talking 

points only. Detailed notes can be inserted into the notes section of PowerPoint, but only 

you should see those notes, unless a professor asks to see your notes to evaluate your 

PowerPoint as an assignment. 

 Be consistent and clear with your font choices. Helvetica is a nice font for 

presentations. Make sure your font is large enough that an audience in a room would be 

able to see your text, even if audience members are sitting in the back of the room. 
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 Be careful with your color choices for text and background. You want to make sure 

your audience can read your text easily. Black on white text is easiest to read but is also 

boring for a presentation. Still, when you add color, just be sure you are adding color that 

works and doesn’t distract. 

 Add images. Text on slides for every slide is boring. Add appropriate images to your 

slides. Relevant charts and graphs are excellent, as are pictures that will connect to your 

content. 

 Make sure your main points are clear. Remember to connect your ideas well and 

provide background information and transitions when necessary. 

 Keep your audience in mind. Your audience will affect the overall tone and appearance 

of your presentation. Sometimes, humor can be appropriate. Other times, a more serious 

tone may be necessary. Just as you evaluate your situation any time you write a paper, 

you should evaluate your situation for creating a PowerPoint presentation. 

7.10 POINTS TO REMEMBER 

 Microsoft PowerPoint is widely used for making professional quality presentations in a 

variety of formats, including tables, charts. You can also use it for notes and class 

presentations.  

 PowerPoint can be used as a drawing package for preparing pictures, forms, posters, and 

leaflets. Presentation is a powerful managerial tool of communication through which you 

can compile and deliver your ideas, concepts, plans or products to the audience in a 

structured, effective and impressive manner. 

 Slides and transparencies are used to be projected in front of the audience using overhead 

projector or otherwise. The operation of this equipment was mainly manual, semi-

automated at the best. This approach had obvious limitations. Computer have now 

replaced the traditional method of presentation entirely. 

7.11 GLOSSARY 
 Title bar is the top section of the window. It shows the name of the file followed by the 

name of the program which in this case is Microsoft PowerPoint. 

 Slide area is the area where the actual side is created and edited. You can add, edit and 

delete text, images, shapes and multimedia in this section. 

 The Quick Access Toolbar is located just under the ribbon. This toolbar offers a 

convenient place to group the most commonly used commands in PowerPoint. 
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 Blank Presentation is used to create customise presentations wherein you can add 

contents, format slide, apply effects of your own. This is the default way for creating 

presentations in PowerPoint. 

 Themes is useful when you want to use predesigned format for your presentation as the 

present background font style, etc are provided by PowerPoint  

 Ribbon component is present just below the title bar. It has eight tabs in it wherein each 

tab is divided into the groups. The groups are the logical collection of PowerPoint 

command to perform various presentations related functions. 

 A table is information arranged in horizontal rows and vertical columns. Tables are 

generally used to organised text on numerical data. 

 A chart is the graphical representation of data in which data is represented by symbols 

such as bars, lines, etc. It is an effective way of visualize data to the audience. 

7.12 CHECK YOUR PROGRESS 

Descriptive type questions- 

a) What is a slide? How many tabs are there in the Microsoft PowerPoint? 

b) List the key points to be kept in mind while making a Microsoft PowerPoint. 

c) How do we change font, size and its color? 

d) What is alignment? What are the types of alignment? 

e) What features are used to modify text? 

f) What is Table? What are the advantages of table in a document? 

g) How will you insert a table in a slide? 

h) Write a short note on ‘Formatting a Table’. 

i) How will you change the chart type? 

j) What are the steeps you should follow to change the background of a chart? 

Objective Type Questions- 

a) Chart represent data in linear form. (True/False) 

b) Chart tools tab is divided into one section. (True/False) 

c) Textbox command is used to create additional text placeholder on a slide. (True/False) 

d) Tables are generally used to organised text on numerical data. (True/False) 

e) A pie chart is used to show the trend of data over a period of time in effective way. 

(True/False) 

f) Clipart is a collection of presentation files. (True/False) 

g) A table is information arranged in …………… rows and ……………. columns. 

h) Shading option is available in the …………………. group. 

i) ………………. option is used to change the border color of rows or columns.  
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j) To change the background, click on ………………………. tab. 

k) A ………………... chart is used to show the percentage value data. 

l) Picture option is in …………………. option. 

Answer (Objective Type Question)- 

[a] False [b] False [c] True [d] True  [e] False  

[f]False [g] horizontal, vertical  [h] Table Style [i] Pen Color  

[j] plot area [k] pie  [l] insert 
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8.1 INTRODUCTION 
The role of Internet in education is of prime importance. The internet-based services in 

teaching-learning are the essential tools of all of us. Such services are the need of modern era/ 

automation which makes our task efficiently in terms of time, effort, cost and quality of service. 

Internet oriented services in education helps to reduce the movement of hard copy papers 

within an organization and integrate various, seemingly unrelated, activities within an 

organization. The aspirants/user can access learning applications, and the office 

applications/services using Internet. Several benefits of such tools are envisioned due to the 

easy access of Internet, such as- Searching files, quick information flow, availability of online 

learning material, enhance transparency, increase accountability, etc. 
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8.2 OBJECTIVES 
After the successful completion of this unit, you will be able to- 

 Understand the role of Google applications in teaching-learning. 

 Know about advanced tools on Google like Docs, Sheets, and Slides etc. 

 Best practices of using Google Drive tools and applications. 

8.3 GOOGLE SHEETS- AN OVERVIEW 
Google Sheets is a web-based spreadsheet application that allows you to store and organize 

different types of information, much like Microsoft (MS) Excel. Howerever Google Sheets 

does not offer all the advanced features of MS Excel. It is easy to create and edit spreadsheets 

online with a variety of tasks ranging from the simple to the complex. Basically, spreadsheets 

are used by to process complicated numbers and data, they can actually be used for a variety 

of everyday tasks, such as- data storage in tabular form, budget planning, creating an invoice 

or just about anything else you can think of. Spreadsheets are a great way to organize and 

process information. 

Google Sheets is a web-based spreadsheet that you can use anywhere with Internet connection. 

It works from any device, with mobile apps for iOS and Android along with its web-based core 

app. Google Sheets is free, and it's bundled with Google Drive, Docs, and Slides to share files, 

documents, and presentations online anywhere. It includes almost all of the same spreadsheet 

functions. If you know how to use MS Excel, you will feel at home in Google Sheets. For 

advanced features you can download add-ons, create your own, and write custom code. 

 

Figure 8.1 Google Sheet home 

8.4 STEPS TO USE GOOGLE SHEETS 

Create or import files to Google Sheets- 
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Choose any option from the below to create a new file, as- (i) type 

"http://spreadsheet.google.com" into browser's address bar; (ii) either click on the spread sheet 

icon (refer to the figure 8.2) 

 

Figure 8.2 Open Google Spread Sheet Using Icon 

Create new file- 

After opening Google sheet, you can create a new file; and also can select several templates, 

as- to-do-list, annual budget, and monthly budget (refer to figure 8.3). 
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Figure 8.3 Create new file 

Import and convert existing files in to google sheet 

If you have existing files, you can import and convert them to google sheets. Following are the 

steps to import a file. as- 

Step 1- Go to Google Drive. 

Step 2- Click on new and then File Upload. 

Step 3- Choose the file you want to import from your computer to add it to Google Drive. 

Step 4- In the Upload complete window, click the show file location. 

Step 5- Right-click the file and select Open with Google Docs (Sheets). 

 

Figure 8.4 Google Sheet Interface (home) 

You can do the following tasks on the google sheets (only few are listed here)- 

 Access stored Google Drive files offline. 

 Get instant insights into your data 

 Insert and edit and summarize your data with charts. 
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 Filter your data in a spreadsheet. 

 Protect content in a spreadsheet 

 Share links of your file to others. 

 Transfer ownership of a file. 

8.5 GOOGLE DOCS- AN OVERVIEW 
Google Docs is a free Web-based application which offers word processing, spreadsheets, 

presentations, forms, and drawings. Google Docs facilitates to create, edit and store docements 

(files) online. Docements can be accessed from any computer with an Internet connection and 

a full-featured Web browser. 

Users of Google Docs can import, create, edit and update documents and spreadsheets in 

various fonts and file formats, combining text with formulas, lists, tables and images. Google 

Docs is compatible with most presentation software and word processor applications. Work 

can be published as a Web page or as a print-ready manuscript. Users can control who sees 

their work. 

Google Docs provides an easy-to-use, integrated way for teachers and students to work together 

on projects, reports, and more, and to collect and share information in a secure online 

environment. Some of the advantages of using Google Docs include: (i) Anytime, anywhere 

access (ii) Collaboration support (iii) Autosave and revision history; and many more. 

8.6 STEPS TO USE GOOGLE DOCS 
Step 1: Setting Google Account 

For using Google Docs you have to setup a Google account (if you does not have one). It is 

free to signup a Google Account, and with it you can access GMAIL, Maps, Youtube, as well 

as GDrive. 

To create a Google Account you can use (http://docs.google.com) this link. You will get the 

screen as shown in Figure 8.5 

Enter your information and follow the suggestion. After creating the Google Account login and 

get access to google Drive screen. 
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Figure 8.5 Google Account Interface (home) 

 

Step 2: Starting Google Docs 

There are a different ways to get to Google Docs, contingent upon your gadget. You can 

download the application from the App Store or Google Play, or click on the Google Apps 

symbol in the upper-right corner of the Google landing page. You should then tap the Docs 

button — you might need to look down inside the menu that pops-up or click More From 

Google in that equivalent pop- up menu to see it. 

 

Figure 8.6 Google Docs Launching Dashboard 
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Step 3: Creating a New Document 

To make a new document,  

 Click the blank page with the multicolored Addition sign inside it, which is located on 

the upper-left side of the main Google Docs page. 

 After that a blank page icon with the multicolored addition sign will pop up again at the 

top of your screen. Click on that to open a new document. 

 

Figure 8.7 Creating a new document 

Step 4: Working on a new document 

Once you’ve created a document, you can work on it.  

 Click Untitled Document in the upper-left corner to add a title to your document.  

 You can also adjust the font type, text size, and much more via the Toolbar at the top 

of the page. If those options are hidden, click the downward-facing Arrow in the upper-

right corner to display them. 

 Any changes made to your file will be saved automatically to the Google cloud 

platform. And you can access that file from any of your devices that has an internet 

connection.  

 If you look to the right of your document’s title at the top of the screen, you should 

either see Saving… or Saved to Drive. Wait for the second message to appear before 

exiting out to ensure all your work has been saved. 

 You can also use shortcut keys to format your document 

o Bold — Ctrl+B 

o Italic — Ctrl+I 
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o Underline — Ctrl+U 

o Strikethrough — Alt+Shift+5 

o Subscript — Ctrl+, 

o Superscript — Ctrl+. 

 

 

Figure 8.8 New document in Google Docs 

8.7 GOOGLE SLIDES- AN OVERVIEW 
Google Slides is a free program that is important for Google's set-up of electronic applications, 

including Google Docs (word preparing), Sheets (bookkeeping pages), Slides (introductions) 

and Forms (gathering and putting together data). What's especially amazing about Google 

Slides is that you can make, alter, work together and present consistently across working 

frameworks and without potential document similarity or debasement issues, overseeing streak 

drives or sorting out connector links. Utilizing an online program likewise takes out the danger 

of moving an infection. 

It is likewise genuinely simple to move a show from PowerPoint to Google Slides and back 

once more, however you might lose some designing simultaneously. In the event that you do 

move a show, page through to ensure the slides actually look the manner in which you need 

them to. In case you are utilized to PowerPoint and end up expecting to utilize Google Slides 

(or the other way around), dread not! The orders and techniques are quite comparative among 

them, and in the event that you stall out, there are heaps of acceptable online assets to address 

your inquiries. 

To feature a couple of key components and advantages:  

 

 Widespread access, from your telephone, tablet or PC  

 Backing for both Android and iPhone/iPad (Google Slides applications)  

 Offer your show with choices for to limit/empower seeing, remarking and altering  
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 Auto-save 

8.8 STEPS TO USE GOOGLE SLIDES 
Step 1 – Create a new presentation in Google Slides 

 Login into your Google Account, head to Google Drive.  

 There, make a Google show by clicking New > Google Slides > Blank Presentation.  

 You'll be diverted to another page with a blank page(presentation) 

 

Figure 8.9 Creating new presentation in Google Slides 

Step 2 – Creating new Slide 

 If you are on the slides page, select an option from the top of the page to create a new 

slide.  

 You can press the white square with a plus sign for a blank slide, or click one of the 

templates.  

 Click on the Template Gallery option, where more templates will show up. 
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Figure 8.10 Adding new Slides  

 

 Delete slides by selecting the slide and clicking Edit > Delete.  

 Or right-click on the slide thumbnail in the sidebar and clicking Delete slide.   

 Or simply press the Delete key while the slide is selected. 

Step 3 – Formatting a Google Slides Presentation 

The initial phase in making presentation is arranging what it looks like. In this way, we should 

investigate the Themes sidebar that shows up after opening a new slide.  

Google Slides comes preloaded with various themes for slides.  

The Themes sidebar shows up on the right half of your new slide. Utilize that bar to travel 

through the different themes accessible. 

 

Figure 8.11 Formatting in Google Slides 

What are the things that we can do using Google Slides? 
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 Create and Present a Professional Presentation: Google Slides is the most ideal 

decision for writing and putting across a presentation expertly. Alternatives accessible 

with the moderator incorporate speaker notes and the choice by which one can set up 

Q&A adjusts during the show. 

 Share a Presentation Online: Google Slides can likewise be utilized to make a 

slideshow show that can run consequently on the web at whatever point somebody 

attempts to utilize it. Utilizing Google Slides, one can make a shareable connection to 

the show so it very well may be utilized in online media. One can likewise make codes 

that would permit one to insert their show into their own sites. 

 Create a Timeline: One can make a timeline with Google Slides with the use of 

drawing tools. However, if one selects the correct Google Slides Template, making 

one’s timeline presentation would be an easy task. 

 Work as a Team: Google Slides very much like some other office usefulness apparatus 

that G Suite offers has distinctive sharing choices like can alter, can see, can remark 

access. This permits clients to adjust the substance of the presentation continuously 

cooperation differently or prevent them from doing as such if the show maker doesn't 

need others to affect the archive with a particular goal in mind. 

8.9 GOOGLE DRIVE- AN OVERVIEW 
Google Drive is a cloud-based capacity arrangement that permits you to save records on the 

web and access them anyplace from any cell phone, tablet, or PC. You can utilize Drive on 

your PC or cell phone to safely transfer records and alter them on the web. Drive likewise 

makes it simple for others to alter and team up on records. 

Google Drive also gives you access to free web-based applications for creating documents, 

spreadsheets, presentations, and more. 

Why use Google Drive? 

Google Drive is perhaps the most well known cloud storage administrations accessible today. 

On the off chance that you've never utilized a cloud-based capacity administration like Google 

Drive previously, pause for a minute to consider the upsides of keeping your documents on the 

web. Since records can be gotten to from any PC with an Internet association, Drive takes out 

the need to email or save a document to a USB drive. Furthermore, in light of the fact that 

Drive permits you to share records, working with others turns out to be a lot simpler. 

8.10 STEPS TO USE GOOGLE DRIVE 
For using Google Drive you have to login to your Google Account. (Google Account setup has 

been discussed earlier in this UNIT). 

Once you login to your google account you can use Google Drive option. 
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Google Drive doesn't simply store your records; it additionally permits you to make, share, and 

oversee reports with its own efficiency applications. In the event that you've at any point 

utilized a suite like Microsoft Office, a few things about Google Drive's applications may 

appear to be natural. For example, the sorts of documents you can work with are like records 

that can be made with different Microsoft Office programs. 

Below are the types of files you can create and share on Google Drive: 

  Documents: For composing letters, flyers, essays, and other text-based files (similar 

to Microsoft Word documents) 

  Spreadsheets: For storing and organizing information (similar to Microsoft Excel 

workbooks) 

  Presentations: For creating slideshows (similar to Microsoft PowerPoint 

presentations) 

  Forms: For collecting and organizing data 

  Drawings: For creating simple vector graphics or diagrams 
Accessing Google Drive 

1. Whenever you've set up your Google account, you can get to Google Drive by going to 

http://drive.google.com in your internet browser. 

2. You can also navigate to Google Drive from any Google page (such as Gmail or Google 

search) by selecting the grid icon near the top-right corner, then clicking Drive. 

 

Figure 8.12 GDRIVE Link in Google Account 

Interface of Google Drive 

Your Google Drive might be vacant at the present time, yet as you transfer and make records 

you'll have to realize how to see, oversee, and sort out them in the interface.  
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You can use different facilities under GDrive by using (+New) option under Drive logo in left 

side. 

 

Figure 8.13 GDRIVE Interface 

8.11 
BRIEF INTRODUCTION TO DISCUSSION FORUM, 
BLOGS AND NEWSGROUPS 

Discussion Forum 

A discussion forum is a website where people can gather to have discussions about a specific 

topic.  Electronic message boards for asynchronous communication, also commonly referred 

to as Web forums, message boards, discussion boards, discussion groups and bulletin boards. 

A program which permits individuals to have conversations on the web. The conversation is 

begun by one part by posting a subject and different individuals answer. This permits 

individuals from similar gathering to share data and thoughts.  

It’s common for websites to add a discussion forum to their website for people to discuss the 

product, service, or organization and even help each other. It reduces customer support 

requests, is great for search engine optimization, and creates a sense of community. 

Discussion Forums are maybe the most punctual type of web-based media stage. Early adopters 

of Internet innovation might review news gatherings or particular vested parties (SIGs) that 

were facilitated on the early sites and frameworks associated with the Internet. These people 

group were established in specialized points however in the long run extended to cover pretty 

much any classification that could draw in a group of people. These stages developed and are 

currently facilitated on purchaser situated informal communication destinations. 

Some of them are – 

 Reddit 
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 Stack Overflow 

 Quora 

 Yahoo Groups 

 Google Answers 

Blogs 

A blog is a sort of site that is refreshed routinely with new substance. Most sites contain short, 

casual articles called blog entries. These posts ordinarily contain a blend of text, photographs, 

recordings, and different media. At its center, a blog is only a space on the Web that you can 

make to record and state your viewpoints, encounters, and interests. A larger part of websites 

are composed by one individual. Thus, the normal blog is genuinely close to home, mirroring 

the interests and character of the individual who composes it. This is the sort of blog we'll zero 

in on in this instructional exercise. 

Individuals who compose blogs are called bloggers. From what you hear on the news, you may 

think bloggers are each of the a particular kind of individuals—youthful, politically slanted, 

and educated. Or on the other hand possibly you've caught wind of bloggers who've expounded 

on stunning encounters or yearning projects, then, at that point transformed their web journals 

into smash hit books. While a few bloggers do fit these portrayals, a greater part of bloggers 

don't. Indeed, there's no "normal" blogger—web journals are composed by individuals, all 

things considered, and foundations and from varying backgrounds. 

There are many reasons why people blog, like: 

 To share your experiences and expertise 

 To speak up about an issue you care about 

 To become more involved with hobbies and passions 

 To be part of a community 

 To advance your career or start a career in writing 

 To keep family and friends updated about your life 

Another explanation a few group blog is to bring in money. Individuals bring in cash from their 

web journals by facilitating promotions, selling items, or distributing their blog entries as a 

book or printed articles. 

Some of the common features that a typical blog will include: 

 Header with the menu or navigation bar. 

 Main content area with highlighted or latest blog posts. 

 Sidebar with social profiles, favorite content, or call-to-action. 

 Footer with relevant links like a disclaimer, privacy policy, contact page, etc. 

NewsGroups 
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A newsgroup is a storehouse of electronic messages posted by clients and oversaw by the 

Usenet framework. This is an overall Internet conversation framework that is isolated from the 

World Wide Web. Usenet was set up in 1980, somewhat more than 10 years before the making 

of the World Wide Web. Newsgroups on Usenet were one of the main chances for general PC 

clients to share and post data on the arising Internet. 

Members in a newsgroup read and post messages to at least one classes. Usenet was made in 

when the transfer speed of the Internet was exceptionally restricted, and newsgroups were 

intended to be text as it were. All the more as of late, clients had the option to join pictures and 

different records to postings, yet as a rule, newsgroups stay intensely text-based. 

The protocol utilized by newsgroups is called Network News Transfer Protocol, or NNTP. This 

is one of the numerous correspondence conventions utilized on the Internet, which additionally 

incorporates the more notable HTTP convention utilized by the World Wide Web. The name 

of a newsgroup is dictated by the individuals who make it. A name normally comprises of a 

few words that portray the subject, isolated by a dot. 

Some of the examples are- 

 news.admin.net-abuse.email  

 rec.arts.sf.tv.babylon5.moderated 

 talk.origins 

Newsgroups are dissimilar from other communication methods that use the World Wide Web 

in a number of ways: 

 No registration with a particular newsgroup is required 

 Stored information is distributed on a collection of computers instead of a central server 

 Archives are always available 

 Newsreader software is commonly used to read and post messages 

8.12 POINTS TO REMEMBER 

 E-Office Suite is the need of modern office automation which makes our task efficiently 

in terms of time, effort, cost and quality of service. 

 Google Docs facilitates to create, edit and store docements (files) online. Docements 

can be accessed from any computer with an Internet connection and a full-featured Web 

browser. 

 Google Drive is a cloud-based capacity arrangement that permits you to save records 

on the web and access them anyplace from any cell phone, tablet, or PC 

 Google Sheets is a web-based spreadsheet application that allows you to store and 

organize different types of information, much like Microsoft (MS) Excel. 
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 A newsgroup is a storehouse of electronic messages posted by clients and oversaw by 

the Usenet framework. 

 A blog is a sort of site that is refreshed routinely with new substance. Most sites contain 

short, casual articles called blog entries. 

 A discussion forum is a website where people can gather to have discussions about a 

specific topic.  

8.13 GLOSSARY 
 Add Fonts - When you create a new document, Google Docs starts you off with nearly 

two dozen native fonts you can choose from using the dropdown list on your top editing 

toolbar.  

 Templates - A template is a pre-created document that already has some formatting 

 Create or Remove Header - Headers and footers are particularly useful when creating a 

Google Doc that has many pages. You can create a header that includes the document 

title, each page number, or both on every page all at once. 

 Classroom - Classroom is where your child can find their assignments, grades and 

feedback, and communicate directly with their teacher 

 Forms - Forms are often used by teachers for creating quizzes, parent feedback surveys, 

or even field trip forms. 

 Drive - Drive is your child’s virtual backpack, where they can hold all of their 

assignments, projects, and notes online 

8.14 CHECK YOUR PROGRESS 

Descriptive Type Questions- 

1) How to get Google Account? 

2) What are the different software tools available in Google Drive? Explain. 

3) What are Google Docs? 

4) What is a blogger? Explain. 

5) Write the steps to use Google Slides? 

Objective Type Questions- 

a) If you already have a Google account, you can use the same account to access Google 

Docs. (True/False) 

b) You can insert automatic page numbers for your document in the header or footer. 

(True/False) 

c) Google Docs do not allow you to insert or upload images. (True/False) 

d) A Google doc is most similar to..................................... 

e) Inserting a header at the top of a page will make it appear on....................... 
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Answer (Objective Type Question)- 

[a] True  [b] True   

[c] False  [d] Microsoft Word  [e] Every page  
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9.1 INTRODUCTION 
A computer network must provide general, cost-effective, fair, and robust connectivity among 

a large number of computers. As if this weren't enough, networks do not remain fixed at any 

single point in time but must evolve to accommodate changes in both the underlying 

technologies upon which they are based as well as changes in the demands placed on them by 

application programs. Furthermore, networks must be manageable by humans of varying levels 

of skill. Designing a network to meet these requirements is not a small task. To help deal with 

this complexity, network designers have developed general blueprints, usually called network 
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architectures. The network architecture guides to the design and implementation of networks. 

[1] 

In case of network systems layering approach is followed where start with the services offered 

by the underlying hardware and then add a sequence of layers, each providing a higher (more 

abstract) level of service. The services provided at the upper layers are implemented in terms 

of the services provided by the low layers. [1] 

The International Standard Organization (ISO) was one of the first organization to formally 

define a common way to connect computers. Their architecture, called the Open Systems 

Interconnection (OSI) architecture which defines a partitioning of network functionality into 

seven layers, where one or more protocols implement the functionality assigned to a given 

layer. It is often referred to as the 7-layer model or OSI model by ISO. [1] 

Figure 9.1 The OSI Model 

The physical layer handles the transmission of raw bits over a communications link. The data 

link layer then collects a stream of bits into a larger aggregate called a frame. Network adaptors, 

along with device drivers running in the node's (computer) operating system, typically 

implement the data link level. This means that frames, not raw bits, are actually delivered to 

hosts. The network layer handles routing among nodes within a packet-switched network. At 

this layer, the unit of data exchanged among nodes is typically called a packet rather than a 

frame, although they are fundamentally the same thing. The lower three layers (Physical, Data 

link, and Network layer) are implemented on all network nodes, including switches within the 

network and hosts connected to the exterior of the network. The transport layer then 

implements what we have up to this point been calling a process-to-process channel. Here, the 

unit of data exchanged is commonly called a message rather than a packet or a frame. The 
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transport layer and higher layers typically run only on the end hosts and not on the intermediate 

switches or routers. [1] 

There is less agreement about the definition of the top three layers. Application layer protocols 

include things like the Hypertext Transfer Protocol (HTTP), which is the basis of the World 

Wide Web (www) and is what enables web browsers to request pages from web servers. Below 

that, the presentation layer is concerned with the format of data exchanged between peers. 

Finally, the session layer provides a name space that is used to tie together the potentially 

different transport streams that are part of a single application. For example, it might manage 

an audio stream and a video stream that are being combined in a teleconferencing 

application.[1] 

9.2 OBJECTIVES 
After the successful completion of this unit, you will be able to- 

 Define IP addressing scheme and Internet governance. 

 Understand the role of IPv4 in networking. 

 Explore the popular protocols, i. e. FTP, HTTP, SMTP, HTTPS, TCP/IP. 

9.3 IP ADDRESSING SYSTEM 
An IP (Internet Protocol) address is a label which is used to identify one or more devices on a 

computer network, such as the internet. It can be compared to a postal address. An IP address 

can be presented using binary number system or dotted decimal notation. IP addresses are 

usually written as a set of numbers (dotted decimal notation) in a given order. Devices using 

IP addresses use the internet protocol to communicate. The Internet Assigned Numbers 

Authority (IANA) assigns IP addresses to regional internet registries (RIRs). The RIRs assign 

them to Internet Service Providers (ISP). Internet Service Providers then assign IP addresses 

to their customers. All internet connecting devices necessarily have an IP address. Each IP 

address has two parts: One that specifies the computer or group of computers, and another 

which specifies the network. Certain types of addresses are unique, others can be re-used. A 

number of IP addresses are used for special purposes (called reserved addresses). [2]  

IP addresses allow network resources to be reached through a network interface. If one 

computer wants to communicate with another computer, it can address the information to the 

remote computer’s IP address. Assuming that the two computers are on the same network, or 

that the different computers and devices in between can translate requests across networks, the 

computers should be able to reach each other and send information. Each IP address must be 

unique on its own network. Networks can be isolated from one another, and they can be bridged 

and translated to provide access between distinct networks. A system called Network Address 

Translation (NAT), allows the addresses to be rewritten when packets traverse network borders 

to allow them to continue on to their correct destination. This allows the same IP address to be 



DVTEE- 201: ICT Resources and Applications- II UOU 

Unit 9: Layered Architecture of Internet and Protocols- II Page 109 of 151 

used on multiple, isolated networks while still allowing these to communicate with each other 

if configured correctly. [3] 

9.4 OVERVIEW OF IPv4 AND IPv6 
The Internet is a network of networks. The connection points between networks are called 

routers, networking devices that route data traffic between sub-networks on the Internet. Every 

device on the Internet has a unique Internet Protocol (IP) address, like a postal or e-mail 

address. The Internet Protocol specifies how a router handles a request for a different IP 

address.  

IPv4 (Internet Protocol Version 4)- 

Each of the four numbers in a typical IP address today is an eight-bit or 1 byte with a decimal 

value between 0 and 255. A 32-bit (4 byte) IPv4 address is big enough to support 232 

(4,29,49,67,296) unique IP addresses. An IPv4 address can be expressed by the-  

Dotted-decimal notation (Example- 172.16.254.1) 

Binary notation (Example- 10101100 00010000 11111110 00000001) 

The IPv4 address distribution- 

Classful distribution 

Classless distribution 

 

IP addresses are typically made of two separate components. The first part of the address is 

used to identify the network address, the part that comes afterwards is used to specify a specific 

host within the network. As per classful address distribution, IPv4 addresses are divided into 

five different classes, As- 

Class A (ranges 0.0.0.0 to 127.255.255.255) 

Class B (ranges 128.0.0.0 to 191.255.255.255) 

Class C (ranges 192.0.0.0 to 223.255.255.255) 

Class D (ranges 224.0.0.0 to 239.255.255.255) 

Class E (ranges 240.0.0.0 and 255.255.255.255) 

 

IPv6 (Internet Protocol Version 6)- 

An IPv6 addresses are generally expressed in hexadecimal form because of larger length. 

For example- 2001:0DB8:AC10:FE01:0000:0000:0000:0000 

The new IPv6 addresses are 128 bits wide (16 bytes), which is enough to support 2128 unique 

IP addresses. 

9.5 INTERNET SERVICE PROVIDER (ISP) 
Internet Service Providers (ISPs) are companies that provide various Internet services to 

interested customers. ISPs provide Internet connectivity to homes and workplaces on a 
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contractual basis. The beneficiary (either an individual person or an organization) pays a fee 

for the services. Usually, ISPs provide either business or individual Internet access. [4,5] 

ISPs support various forms of Internet access, such as traditional modem dial-up up, DSL 

(Digital subscriber Line), cable modem broadband services, fiber and dedicated lines. In the 

past, some of the best ISP services were DSL and dial-up services. In the case of DSL, if the 

beneficiary was looking for more speed and a better Internet connection, then the DSL accounts 

would have been a great alternative a few years ago. As compared to the dial-up, DSL does not 

use the home phone line so that the telephone can be used anytime without presenting a conflict 

for the user. [4,5] 

There are many different Internet Service Providers, some of the most popular include BSNL, 

MTNL, Reliance Jio, Bharti Airtel, Idea Cellular, etc. When you choose an ISP, there are many 

factors to take into consideration. Some of those factors include price, type of internet 

connection you want, speed, customer support, types of devices you use, and cancelation 

policies. [4,5] 

Types of Internet Connections 

 Dial-up connection- ‘Dial-up’ connection is also known as level two connection. This 

provides connection to Internet through a dial-up terminal connection. The computer, 

which provides Internet access is known as ‘Host’ and the computer that receives the 

access, is called ‘Client’ or ‘Terminal’. The client computer uses modem to access a 

“host” and acts as if it is a terminal directly connected to that host. 56 Kbps (Kilo Byte 

Per Second) modem access is widely available and supported by most ISPs. So, this 

type of connection is also known as low speed or ‘Remote Modem Access’ connection. 

[6]  

 Integrated Services Digital Network (ISDN)- ISDN offers Internet connectivity at 

speeds of up to 128 Kbps through the use of digital phone lines. ISDN is a dial-up 

service that has been provided by telephone companies for many years.  

 Leased connection- It is also known as direct Internet access or Level Three connection. 

It is the secure, dedicated and most expensive, level of Internet connection. With leased 

connection, your computer is dedicatedly and directly connected to the Internet using 

highspeed transmission lines.  

 Digital Subscriber Line (DSL)- It is another technology being used for Internet access. 

DSL connects your home or office to the Internet through the same telephone wire that 

comes from the telephone pole on the street. Like ISDN, with DSL, user can make and 

receive telephone calls while connected simultaneously to the Internet. However, DSL 

service is limited in the distance that you can be from the provider’s point of presence 

(POP). 
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 Cable Modem Connection- The connection speed can be up to 10 times that of a dial-

up and the cost is about twice that of an ISP’s dial-up account, with no phone company 

charges. Many people who have cable TV can now get a high–speed connection to the 

internet from their cable provider. Cable lines offer an extremely high bandwidth 

connection to the Internet. It divides the connection into lots of bands, and translates 

the data in the bands into signals that can be carried through cable lines. Cable modems 

change these signals into IP packets that your computer can understand. 

 And many more connection types are available such as- Wireless connections, etc. 

9.6 INTERNET GOVERNANCE 
Internet governance is the development of norms and principles relating to how the Internet 

functions by a group of stakeholders including governments, organizations, and commissions 

and the regulation and administration of those principals by the parties involved. Aside from 

structural issues, Internet Governance can include conversations around access, policy and 

content. [7] 

According to the Report of the Working Group on Internet Governance (WGIG) (June 2005 

P.4) Internet Governance is the development and application by governments, the private 

sector, and civil society in their respective roles of shared principles, norms, rules, decision-

making procedures, and programs that shape the evolution and use of the Internet. Some of the 

organizations that are involved in Internet governance are [7]-  

 ICANN (Internet Corporation for Assigned Names and Numbers) 

 IANA (Internet Assigned Numbers Authority) 

 ISOC (Internet Society) 

 Internet Governance Forum 

 NTIA (National Telecommunications and Information Administration) 

 ITU (International Telecommunication Union) 

 UNESCO (United Nations Educational, Scientific and Cultural Organization) 

 WIPO (World Intellectual Property Organization) 

 Registries and Registrars 

 IETF (Internet Engineering Task Force) 

9.7 GATEWAY 
In computer networking, a gateway is a component that is part of two networks, which use 

different protocols. The gateway will translate one protocol into the other. A router is a special 

case of a gateway which connects two or more similar networks. Gateways, also called protocol 

converters, can operate at any network layer. The activities of a gateway are more complex 

than that of the router or switch as it communicates using more than one protocol. 
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9.8 FILE TRANSFER PROTOCOL (FTP) 
File Transfer Protocol (FTP)- It is an Internet utility software used to upload and download 

files. It gives access to directories or folders on remote computers and allows software, data 

and text files to be transferred between different kinds of computers. FTP works on the basis 

of same principle as that of Client/Server. FTP “Client” is a program running on your computer 

that enables you to talk to, and get stuff from, remote computers. The FTP client takes FTP 

commands and send them as requests for information from the remote computer or known as 

FTP servers. To access remote FTP server, it is required but not necessary to have an account 

in the FTP server. When the FTP client gets connected, FTP server asks for the identification 

in-terms of user login name and password of the FTP client. [8] 

9.9 
HYPER TEXT TRANSFER PROTOCOL (HTTP AND 
HTTPS) 

Hypertext Transfer Protocol is a communication protocol which is used to send and receive 

webpages and files on the internet. It was developed by Tim Berners-Lee and is now 

coordinated by the W3C (World Wide Web Consortium). 

HTTP works by using a user agent to connect to a server. The user agent could be a web 

browser. The server must be located using a URL (Uniform Resource Locator) or URI 

(Uniform Resource Identifier). This always contains "http://" at the starting. It normally 

connects to port 80 on a computer. 

A more secure version of HTTP is called HTTPS (Hypertext Transfer Protocol Secure). This 

contains "https://" at the beginning of the URL. It encrypts all the information that is sent and 

received. This can stop malicious users such as hackers from stealing the information and is 

often used on secure transmissions, such as- payment websites. HTTPS uses port 443 for 

communication instead of port 80. 

9.10 SIMPLE MAIL TRANSFER PROTOCOL (SMTP) 
Most internet systems use SMTP as a method to transferring e-mail from one user to another. 

SMTP is an application layer protocol. User-level e-mail clients typically use SMTP only for 

sending messages to a mail server for relaying, and typically submit outgoing e-mail to the 

mail server. SMTP is a protocol and is used to send the mail whereas POP (post office protocol) 

or IMAP (internet message access protocol) are used to retrieve those mails at the receiver’s 

end. The SMTP server is always on listening mode. As soon as it listens for a TCP connection 

from any client, the SMTP process initiates a connection through port 25. After successfully 

establishing a TCP connection the client process sends the mail instantly. Since SMTP's 

introduction in 1981, it has been updated, modified and extended multiple times. The protocol 

version in common use today has extensible structure with various extensions for 

authentication, encryption, binary data transfer, and internationalized email addresses. SMTP 



DVTEE- 201: ICT Resources and Applications- II UOU 

Unit 9: Layered Architecture of Internet and Protocols- II Page 113 of 151 

servers commonly use the Transmission Control Protocol on port number 25 (for plaintext) and 

587 (for encrypted communications). [10,11] 

9.11 
TRANSMISSION CONTROL PROTOCOL/INTERNET 
PROTOCOL (TCP/IP) 

The TCP/IP suite is a four layers model which is for both modelling current Internet 

architecture, as well as providing a set a rule that governs all forms of transmission over a 

computer network. The TCP/IP Model is sometimes called the Internet model. The TCP/IP 

model describes a set of general design guidelines and implementations of specific networking 

protocols to enable computers to communicate over a network. TCP/IP provides end-to-end 

connectivity specifying how data should be formatted, addressed, transmitted, routed and 

received at the destination. Protocols exist for a variety of different types of communication 

services between computers. 

TCP/IP protocol stack is a shorthand for the two most important protocols used to make the 

Internet work; the Internet Protocol (IP), and the Transmission Control Protocol (TCP). The IP 

is responsible for transferring data packets whereas the TCP makes sure all packets arrived 

safely, if not, retransmits them. The TCP/IP protocol stack is made up of four layers that work 

together. These four layers are (high to low)- 

Layer 4- Application Layer. 

Layer 3- Transport Layer. 

Layer 2- Network Layer. 

Layer 1- Physical Layer. 

The Application Layer-  

The application layer defines how certain services operate and how they can be used. Examples 

are the FTP service for transferring files, HTTP for serving Web pages and SMTP for e-mail. 

The two ends, called "the client" and "the server" are set up a connection over which they 

exchange messages in accordance with a specific protocol. The client starts the protocol by 

requesting the service. Often the next step is for the server to authenticate the client's request 

and respond accordingly. [12,13] 

The Transport Layer-  

On the Internet, the transport layer is realized by two protocols. The first is the Transmission 

Control Protocol (TCP) and the second is the User Datagram Protocol (UDP). Both break up a 

message that an application wants to send into packets and attempt to deliver those packets to 

the intended recipient. At the recipient’s side, both take the payload from the received packets 

and pass those to the application layer. [12,13] 

The main difference between TCP and UDP is that TCP is reliable or connectionful and UDP 

is connectionless protocol. TCP will collect incoming packets, put them in the right order and 
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thereby reassemble the original message. If necessary, TCP requests retransmission of lost or 

damaged packets. UDP merely takes each incoming packet and delivers the payload (the 

original message) to the application layer. Any errors or out-of-order data should be taken care 

of by the application. [12,13] 

UDP is much faster than TCP, and so is mainly used for applications like audio and video 

streaming, where the occasional error is less important than getting all the data there at the right 

time. More generally, UDP is designed for applications that do not require the packets to be in 

any specific order. Because of this, UDP is sometimes called a “connection-less” protocol. 

[12,13] 

For example, the e-mail client and server communicate over a reliable/ connection-oriented 

protocol (TCP). The server listens on a certain port (port 25) until a connection request arrives 

from the client. The server acknowledges the request, and a TCP connection is established. 

Using this connection, the client and server can exchange data. [12,13] 

The Network Layer-  

The network layer is responsible for transmitting and routing data packets over the network. 

The Internet uses the Internet Protocol or IP as its network layer. Each node on the network has 

an IP address, and data is sent as data packets (each data packet has specific format and size 

limit). [12,13] 

The data packets are passed from one node in the network to another until it gets to the 

destination address with a source IP address, destination IP address and a payload (message) 

imprinted on the data packet. The IP does not notice that a packet gets lost. It just never gets to 

the destination. If a particular node cannot pass the packet to the next node along the normal 

route, it will do its best to find an alternative path. That is why IP is sometimes called a “best 

effort delivery protocol". [12,13] 

The Physical Layer-  

The lowest layer is the physical layer, which defines how the cables, network cards, wireless 

transmitters and other hardware connects computers to the networks and networks to the rest 

of the Internet. Examples of physical layer networks are- Ethernet, Wi-Fi, Token Ring and 

Fiber Data Distributed Interface (FDDI). The physical layer provides the means to transfer the 

actual bits from one computer to another. [12,13] 

9.12 POINTS TO REMEMBER 
 The International Standard Organization (ISO) was one of the first organization to 

formally define a common way to connect computers. 
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 An IP address can be presented using binary number system or dotted decimal notation. 

IP addresses are usually written as a set of numbers (dotted decimal notation) in a given 

order. Devices using IP addresses use the internet protocol to communicate. 

 ISPs support various forms of Internet access, such as traditional modem dial-up up, 

DSL (Digital subscriber Line), cable modem broadband services, fiber and dedicated 

lines. 

 There are many different Internet Service Providers, some of the most popular include 

BSNL, MTNL, Reliance Jio, Bharti Airtel, Idea Cellular, etc.  

 In computer networking, a gateway is a component that is part of two networks, which 

use different protocols. 

 FTP works on the basis of same principle as that of Client/Server. FTP “Client” is a 

program running on your computer that enables you to talk to, and get stuff from, 

remote computers. 

 HTTP works by using a user agent to connect to a server. The user agent could be a 

web browser. The server must be located using a URL (Uniform Resource Locator) or 

URI (Uniform Resource Identifier). This always contains "http://" at the starting. It 

normally connects to port 80 on a computer. 

 SMTP is a protocol and is used to send the mail whereas POP (post office protocol) or 

IMAP (internet message access protocol) are used to retrieve those mails at the 

receiver’s end. 

9.13 GLOSSARY 

 Router- A device that transfers data between computer networks to provide access to 

the Internet. 

 ISP (Internet Service Provider)– A company that provides Internet service to customers. 

 HTTP (Hypertext Transfer Protocol)– A set of rules (a protocol) for transferring and 

accessing data using the web. 

 URL (Uniform Resource Locator)– A web address of a specific web page or file on the 

Internet. An example is https://www.uou.ac.in 

 IP (Internet Protocol)– A set of rules (a protocol) for sending data from one computer 

to another on the Internet. Each computer has a unique IP address that distinguishes it 

from all other computers on the Internet. 

 FTP (File Transfer Protocol)– A set of rules (a protocol) for transferring files between 

computers over the Internet. 

 Cookie- A small text file stored in a user’s computer by a website that the user has 

visited so that it can remember something about the user at a later time. For example, 

cookies are used for online shopping. Without cookies, login information would have 

to be entered before every product was added to the shopping cart. 
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 Link (hyperlink)– A word, phrase, image, etc., within a file or web page that a user can 

click on to jump to another document, section of the same document, or web page. 

 PC (Personal Computer)– a small computer designed for use by a single user at a time. 

 Mac (Macintosh)– a type of personal computer made by Apple Inc. It runs a version of 

the macOS (Apple’s operating system, pronounced “mack-oh-ess”). 

 OS (Operating System)– a powerful program that controls and coordinates a 

computer’s hardware devices and runs software and applications. Examples includes 

Windows, Android, OS X, and Linux. 

 Reboot– to shut down and restart a computer, allowing its operating system and 

programs to be reloaded. 

 CPU (Central Processing Unit)– the brain or engine of a computer, where most of the 

processing and operations take place. 

 Bit (Binary Digit)– the smallest, most basic unit of measurement for computer data 

storage, represented as either a 0 or a 1. One byte is equal to 8 bits. 

 Byte (Binary Term)– a unit of measurement for data storage. One byte is equal to 8 bits. 

9.14 CHECK YOUR PROGRESS 
1) Define OSI model. 

2) Define IP addresses and their role in computer networking. 

3) What do you understand by IPv4 and IPv6? 

4) Explain Internet governance. 

5) Briefly explain the types of internet connection. 

6) Explain the role of following protocols- HTTP, FTP, SMTP. 
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10.1 INTRODUCTION 
A number of factors affect design in web development, complicating what would otherwise 

appear to the end user to be a relatively simple process of displaying a picture or document. In 

truth, the development process involves not only the HTML and multimedia that make up the 

visual aspects of the page but also considerations of software engineering, human-computer 

interaction, quality assurance and testing, project management, information and requirement 

engineering, modelling, and system analysis and design. [1,2] 

Today’s websites are now becoming more application centred than traditional websites. This 

further complicates our projects as we integrate with legacy software and databases, strive to 

meet real-time data demands, address security vulnerabilities inherent to the environment we 

are working in, and ongoing support and maintenance typical of robust software applications. 
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In response to these advances in complexity and capability, web development has grown to 

embrace many of the same development processes of software development. Web development 

is best achieved as a linear process, but is usually completed asynchronously. The planning 

process described is intended to build upon itself to refine project requirements, look and feel, 

and development plans. However, limitations in timelines, mid-project revisions, and the 

extensive time that can be invested into the early stages of design lead many programmers to 

begin development while a project is still in design. Starting early with programming during 

design planning can accelerate work progress when the elements created early on are unlikely 

to be affected by later changes in the scope. [1,2] 

It is important to avoid aspects that are assumed to change, like visual layout or particular 

pieces of content, instead focusing on data structure, frameworks, and other components that 

are easily adapted to design changes. Some of the key things which should be avoided, 

monitored or resolved during web development are- (i) Vaguely defined use cases and 

inadequate project requirements, (ii) Overly broad or undefined scope of features, (iii) 

Unresolved disputes between stakeholders about project features, and (iv) Unrealistic time 

table, budget, or inadequate resources. By ensuring all of your objectives related to your web 

development projects should meet the SMART criteria, as- Specific, Measurable, Attainable, 

Realistic, and Timely. [1,2] 

To do web development, you need a few core concepts and technologies. You have to 

understand the basics of the web designing and development. You need to have a good 

understanding of HTML, CSS, and JavaScript for the “front-end” that is displayed on the 

browser, and from the “back-end” of the development work you need languages for the code 

running on the server, such as- PHP, ASP.Net, Python, etc. 

10.2 OBJECTIVES 
After the successful completion of this unit, you will be able to- 

 Explore web development tools. 

 Define open-source web development tools. 

 Know popular terminologies in the arena of web designing and development. 

 Explore latest trends in web designing and development. 

10.3 OVERVIEW OF WEB DEVELOPMENT TOOLS 
The task of web development in a full stack approach, means a web developer should have an 

understanding of all of the elements necessary to create and run a website. You should focus 

on familiarizing yourselves with several tools/frameworks those are used in the journey of 

developing a successful web application. You should have the brief overview of such basic 

tools/frameworks, such as- [4] 
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[1] Web Development- 

A brief history of the development of the Internet along with current trends and emerging 

technologies such as virtualization, botnets, internet of things, and more. 

Web Servers- 

Analysis of the components of servers from both a hardware and software perspective with 

introduction to LAMP (Linux, Apache, MySQL, PHP), WAMP (Windows, Apache, MySQL, 

and PHP), XAMPP (Cross-platform, Apache, MySQL, PHP and Perl) software and alternative 

solutions. Introduction to basic networking topics to provide an understanding of device 

addressing and URL translation. 

Design- Techniques useful in the design of web projects including site maps, wireframes, 

storyboarding and more. 

Development- Introduction to development models and best practices. Includes APIs, 

developing with or without others, and practices like pseudo-code, code formatting, and 

variable naming conventions. 

 

[2] Document Markup- 

HTML5- Introduction to HTML including features from the current specifications for HTML5. 

Covers tags and attributes, layout elements, forms, canvas, and more. 

CSS- Introduction to CSS3 including selectors and rules, classes, responsive styling, 

positioning, and more. 

 

[3] Scripting Languages- 

PHP- Introduction to PHP including debugging, arrays, email, file interaction, logic and control 

structure, and more. 

JavaScript- A brief contrast of JavaScript to PHP, use of jQuery, and the document object 

model. Demonstration of how to complete basic page manipulation using JavaScript. 

 

[4] Data Storage and more- 

MySQL- Primary and foreign keys, normalization and design, query design, and more. 

Security- An introduction to risk management and examples of basic methods of securing 

elements of a site. 

Advanced Examples- Examples of site features and methods, which combine the languages 

and topics in the text. 

Latest trends- Integration of common website elements that complete the user experience 

including search optimization, analytics, and important information. 

10.4 
OPEN-SOURCE WEB DESIGNING AND DEVELOPMENT 
TOOLS/ FRAMEWORKS 
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Open-source tools for web developers are the key to develop customized projects because 

generally they are free of cost, but they can be modified in any way as the developer wants. 

Some of the top demanding open-source tools for web development are- 

 

KOMPOZER- (www.kompozer.net) 

It is a WISYWIG (What You See Is What You Get) HTML editor. It is a light-weight 

application for performing development tasks. 

 

ECLIPSE- (www.eclipse.org) 

Eclipse is an IDE (Integrated Development Environment) specially for Java developers, but it 

may also be used to develop applications in other programming languages via plug-ins, 

including Ada, C, C++, C#, Erlang, JavaScript, Perl, PHP, etc. 

 

APACHE- (www.apache.org) 

Apache is the Web server which is demanded by almost all Web developers. It is on of the 

popular web server among Web developers because of its reliability and speed. 

 

XAMPP- (www.apachefriends.org) 

For writing a complete web application, a Web server is only the foundation. You need some 

other tools, i.e., Relational database (for example- MySQL) and the PHP language framework. 

Installing and configuring all of them one by one is a complicated task. The XAMPP provides 

all such tools (Apache, PHP, and MySQL) in a bundle which is very easy to install and access. 

 

POSTGRESQL- (www.postgresql.org) 

It is a relational database which is an alternative of MySQL, one can use it. 

 

PHPMYADMIN- (https://www.phpmyadmin.net) 

phpMyAdmin is an open-source GUI (Graphical User Interface) application for web 

developers which is used to administer MySQL databases and it makes the entire process much 

easier in a graphical manner. 

 

FIREFOX WEB DEVELOPER TOOLBAR- (https://addons.mozilla.org) 

Firefox web developer toolbar has more functions than the Firebug plug-in and is freely 

available. 

 

OPENSTA- (www.opensta.org) 

It supplies versatile test development software that enables you to create and run tests tailor-

made for the environment you are assessing. The contents and structure of a test will depend 

on the type of test you are conducting, the nature of the system you are targeting and the aims 



DVTEE- 201: ICT Resources and Applications- II UOU 

Unit 10: Introduction to Web Development Tools and Technologies Page 122 of 151 

of your performance test. It supports the creation of HTTP/HTTPS load tests that include 

scripts which supply the load element, and may also include collectors which are used to record 

additional performance data. 

 

BROWSERSHOTS.ORG- 

It allows to you to see how your website is viewed in any possible browser. The list of browsers 

includes almost any browser you can imagine and this saves you the hassle to manually test 

your site for browser compatibility. 

Bootstrap- (www.getbootstrap.com) 

Bootstrap is an open-source tool used to create responsive web designs. It comes with a 

complete JavaScript extension, containers, forms, buttons, classes, media queries, grids and 

navigation. 

 

Visual Studio Code- (https://code.visualstudio.com) 

Visual Studio code is a source-code editor made by Microsoft for Windows, Linux and macOS, 

and is a free, cross-platform code editor. It includes to support for debugging, syntax 

highlighting, intelligent code completion, etc. 

 

Node.js- (www.nodejs.org) 

Node.js is a popular platform for creating network applications that are both scalable and fast. 

It uses less CPU horsepower and has a smaller memory footprint than the other similar tools. 

It is revolutionary in that it helped usher in real-time web apps using web sockets to deploy 

push technology. It uses an event-driven, non-blocking I/O structure based on Google’s V8 

JavaScript engine. 

 

LESS- (www.lesscss.org) 

It is a CSS pre-processor, and has a similar syntax to CSS itself. It helps developers make CSS 

more extensible and maintainable with a full feature set including functions, and variables. 

 

AngularJS- (www.angularjs.org) 

AngularJS extends the power of HTML using markup for data binding and dynamic views. It 

is a Model-View-Whatever (MVW) JavaScript platform, and is well-suited for creating one-

page web applications and connecting HTML forms to JavaScript controllers and models. 

 

Brackets- (www.brackets.io) 

It is a lightweight web design editor and it is very useful for working on CSS, HTML and 

JavaScript. 

 

MongoDB- (www.mongodb.com) 
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MongoDB is a popular document-oriented database (also called no SQL). It can work across 

multiple platforms, and also uses documents with dynamic schemas for rapid data integration. 

ReactJS- (www.reactjs.org) 

It is a famous open source, efficient, and declarative JavaScript library used for the designing 

of user interfaces. 

 

Atom- (www.atom.io) 

It is an open-source and supports to cross-platform editing. It supports to AngularJS, smart 

auto-completion, Atom TypeScript, etc., which plays a crucial role in faster web development. 

 

Notepad ++ (www.notepad-plus-plus.org) 

It is a famous open-source text and source code editor for Microsoft Windows. It is known for 

offering tabbed editing, syntax highlighting and code folding for more than 50 programming, 

scripting and markup languages. 

 

Firebug- (www.getfirebug.com) 

This tool is an extension of Mozilla Firefox making simpler debugging, editing, and monitoring 

HTML, CSS, and JavaScript on a live web page. The key features of Firebug are- Inspects and 

edits HTML, Visualizes CSS metrics, Debugs and profiles JavaScript, Monitors network 

activity, quickly finds errors, Explores the DOM (Document Object Model), Handles cookies, 

etc. 

 

Ember.JS- (www.emberjs.com) 

It is an open-source JavaScript framework based on the model-view-controller (MVC) pattern, 

which is the preferred JavaScript frameworks for a single-page web application. 

 

WAMP- (www.wampserver.com) 

Its full form is Windows, Apache, MySQL, and PHP. It is mostly used for web development 

and local/internal testing server-side scripts. 

 

FileZilla- (www.filezilla-project.org) 

It is a cross-platform FTP (File Transfer Protocol) application which is freely available. 

 

GitLab- (www.gitlab.com) 

It is a web-based open-source repository manager. It offers features like- access controls, code 

reviews, activity feeds, and issue tracking. It has continuous integration and deployment built 

in, which is very helpful for you for building, testing, and deploying code. 

 

Axiis- (www.axiis.org) 
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It is an open-source data visualization frameworks, which is designed for both beginners and 

advance developers. It allows developers to define their data visualizations through intuitive 

and concise markup. It also offers pre-built visualization components with the abstract layout 

patterns that provide classes that help you to develop your own unique visualizations. 

10.5 
POPULAR TERMINOLOGIES USED IN WEB DESIGNING 
AND DEVELOPMENT 

 Active Server Pages (ASP)- Microsoft’s first server-side script language for 

dynamically-generated web pages. 

 Adaptive layout- A layout system that enables the visual elements in a web page or 

application to adapt to changes in the size of the application window or capabilities of 

the device on which the application is running. 

 Android- A mobile operating system that is based upon a modified version of the Linux 

kernel and currently owned and maintained by Google. 

 Browser- A software program that allows a user to view images and read hypertext 

documents (i. e. web pages). Chrome, Internet Explorer, Mozilla, Opera, and Safari are 

all browsers. 

 Cascading Style Sheets (CSS)- Declarations that describe how a document should be 

presented on the Web. CSS can be written for different media, can be part of an HTML 

document, or can be a separate file that is applied to multiple HTML documents. 

 Chrome- A web browser developed by Google that is based on the WebKit layout 

engine and application framework. 

 ColdFusion- A commercial rapid application development platform invented by Jeremy 

and JJ Allaire in 1995, originally designed to make it easier to connect simple HTML 

pages to a database. As of 2010, versions of ColdFusion (now owned by Adobe 

Systems) include advanced features for enterprise integration and development of rich 

Internet applications (RIA). 

 Content Distribution Network (CDN)- A system of computers containing copies of 

data, placed at various points in a network so as to maximize bandwidth for access to 

the data from clients throughout the network. A client accesses a copy of the data that 

resides on a server that is closer to them, as opposed to all clients accessing the data 

from the same central server. 

 Content Management System (CMS)- Software used to manage work flow in a 

collaborative environment. On the web, a content management system is designed to 

simplify the publication of web content to web sites and mobile devices—in particular, 
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allowing content creators to submit content without requiring technical knowledge of 

HTML or the uploading of files. 

 Cookies- Also known as a web cookie, browser cookie, or HTTP cookie, a piece of text 

stored by a user’s web browser. A cookie can be used for authentication, storing site 

preferences, shopping cart contents, the identifier for a server-based session, or 

anything else that can be stored as text data. Cookies can be encrypted or unencrypted. 

 CSS3- A modularized version of CSS that consists of several separate 

recommendations. Rather than attempting to shove dozens of updates into a single 

monolithic specification, CSS3 allows an easier and more efficient update to individual 

pieces of the specification. Modules enable CSS to be updated in a more timely and 

precise fashion, thus allowing for a more flexible and timely evolution of the 

specification as a whole. 

 Dreamweaver- A WYSIWYG (What You See Is What You Get) web development 

application originally developed by Macromedia and now owned and maintained by 

Adobe Systems. This desktop software program allows users to preview websites in 

locally installed web browsers, provides file transfer and synchronization features, the 

ability to find and replace lines of text or code by search terms and regular expressions 

across an entire site, and boasts a templating feature that allows single-source update of 

shared code and layout across entire sites without server-side includes or scripting. The 

behaviours panel also enables use of basic JavaScript without any coding knowledge. 

 Dynamic HTML (DHTML)- A late 1990s buzzword for a collection of technologies 

(HTML, CSS, JavaScript, and the Document Object Model) used together to create 

interactive and animated web sites. This buzzword has been replaced several times over 

with terms such as “DOM scripting,” “Ajax,” and, most recently “HTML5.” 

 Firefox- A free and open-source web browser created by Mozilla that uses the Gecko 

layout engine to display web pages. Mozilla Firefox implements the most current web 

standards in addition to several features which are intended to anticipate likely additions 

to the standards. 

 Flash- An Adobe multimedia platform used to add animation, video, and interactivity 

to web pages. It is frequently used for advertisements, games, and as a component of 

rich Internet applications (RIAs). Flash manipulates vector and raster graphics to 

animate text, drawings, and still images. It supports bidirectional streaming of audio 

and video, can capture input via mouse, keyboard, microphone, and camera, and, if 

properly coded, can be made accessible to some assistive technologies. 
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 HTML5- The next major revision of the HTML standard that is currently under 

development. Like its immediate predecessors, HTML 4.01 and XHTML 1.1, HTML5 

is a standard for structuring and presenting content on the World Wide Web. 

 Hyperlink- Hyperlinks are words or phrases within an HTML document that provide a 

connection to another HTML document. Hyperlinks create the “web” in World Wide 

Web. 

 Hyper Text Markup Language (HTML)- A simple mark-up language used to create 

hypertext documents that can be read on any computer. HTML is the structural basis of 

every web page. 

 Java Server Pages (JSP)- A Java technology that helps software developers serve 

dynamically generated web pages based on HTML, XML, or other document types. 

 JavaScript- A client-side scripting language originally developed by Netscape and later 

standardized by ECMA. Programs authored in JavaScript adds interactivity and 

conditional behavior to web pages. JavaScript, despite its name, has little in common 

with the programming language Java. 

 Keyword- A term that is more relevant or of higher importance in a given page of 

content on the web. A popular form of keywords on the web are tags which are directly 

visible and can be assigned by non-experts also. 

 Mobile Web- The Mobile Web refers to the use of Internet-connected applications, or 

browser-based access to the Internet from a mobile device—such as a smartphone or 

tablet PC—connected to a wireless network. 

 Multimedia- Media and content that uses a combination of different forms. Multimedia 

includes some combination of text, audio, still images, animation, video, and interactive 

content. 

 Native app- An application designed to run in the computer environment (machine 

language and OS) being referenced. 

 Open-source- Describes practices in production and development that promote access 

to the end product’s source materials and the licensed usage thereof. 

 Opera- A web browser and Internet suite developed by Opera Software. Opera is the 

most popular mobile browser, and the most popular desktop browser in some countries. 

 Operating System (OS)- Software consisting of programs and data that runs on 

computers, manages computer hardware resources, and provides common services for 

efficient execution of various application software. Microsoft Windows and Apple’s 

OS X are examples of common operating systems. 
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 Payment gateway- An e-commerce application service provider service that authorizes 

payments for e-businesses and online retailers. Payment gateways protect credit card 

details by encrypting sensitive information, such as credit card numbers, to ensure that 

information is passed securely between the customer and the merchant and also 

between merchant and the payment processor. 

 Photoshop- A graphics editing program developed and published by Adobe Systems 

Incorporated. It is commonly used by designers for print and the web. 

 PHP- A widely used, general-purpose scripting language that was originally designed 

for web development to produce dynamic web pages. 

 Prototype- On the web, typically a low-fidelity proof-of-concept application or 

interface to be used for testing the usability or viability of that interface or application. 

 Ruby- A dynamic, open-source programming language with a focus on simplicity and 

productivity. A primary aim of the language is to maintain an elegant syntax that is 

natural to read and easy to write. Ruby is the underlying language used in the Rails and 

Sinatra web frameworks. 

 Ruby on Rails- An open-source framework that brings the Ruby programming language 

to the web. 

 Safari- A graphical web browser developed by Apple and included as part of the Mac 

OS X operating system. A version of Safari is also available for Microsoft’s Windows 

operating system. 

 Screen size- On a computer monitor, the viewable image size is the actual amount of 

screen space that is available to display a picture, without obstruction from the case or 

other aspects of the unit’s design. Screen size is not necessarily an indication of a 

display device’s overall resolution as that calculation is made by multiplying the screen 

size by the pixel density of the device. 

 Search engine- A web application designed to search for information across publicly 

available pages on the World Wide Web. 

 Search Engine Optimization (SEO)- The process of improving the visibility of a 

website to search engines. 

 Site map- Provides a global, hierarchical view of a website’s pages or application’s 

“screens” for organizational purposes. Most site maps do not show every page-to-page 

or screen-to-screen connection; that function is usually served by detailed user flows. 

 Source code- Any collection of statements or declarations written in a computer 

programming language. 
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 Stylesheet- A set of rules defining the presentation of a structured document. 

 URL/URI- A Uniform Resource Locator (URL) is a Uniform Resource Identifier (URI) 

that specifies where an identified resource is available and the mechanism for retrieving 

it. The best-known example of the use of a URL is for the address of a web page. 

 User experience- The interaction a user has with an interface. From a planning 

perspective, the user experience is typically defined in wireframes, but every aspect of 

the web design and development process—from wireframing to copywriting to design 

to programming—affects the user experience. 

 Web standards- Technologies for creating and interpreting web-based content. Web 

standards are developed by the World Wide Web Consortium (W3C) and other groups 

and standards bodies and are carefully designed to deliver the greatest benefits to the 

greatest number of web users while ensuring the long-term viability of any document 

published on the web. 

 Website- A collection of related web pages, images, videos or digital assets that are 

addressed relative to a common URL. 

 Wireframe- A basic visual guide used in interface design to suggest the structure of a 

website and relationships between its pages. A webpage wireframe is a similar 

illustration of the layout of fundamental elements in the interface. Typically, 

wireframes are completed before any artwork is developed. 

 WYSIWYG- An acronym for “What you see is what you get.” The term is used in 

computing to describe a system in which content displayed during editing appears very 

similar to the final output. 

 .Net- A software framework for Microsoft Windows operating systems. It includes a 

large library and supports several programming languages, allowing language 

interoperability (each language can use code written in other languages). [3] 

10.6 RECENT TRENDS IN WEB DEVELOPMENT 
Technology is growing at a rapid pace day by day where digital advancement continues to re-

shape our surroundings and also influencing our day-to-day decisions. Earlier, websites were 

started with plain text, and now we are utilizing the applications of Artificial Intelligence (AI) 

in our websites. Such advancement in technologies have multi angle effects in re-shaping the 

business world. We have bots that can talk to you just like another human who can actually 

guess what exactly is in your mind. All these changes are highly indebted to the continuously 

evolving web development trends. Some of the trending routes of today's web development 

are- [5] 

 Voice Search Optimization. 
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 Chat Bot. 

 Mobile-Friendly Website. 

 JavaScript. 

 Progressive Web App. 

 Blockchain Technology. 

 Single Page Application. 

 Motion UI. 

 Augmented Reality (AR) and Virtual Reality VR. 

 Artificial Intelligence. 

10.7 POINTS TO REMEMBER 

 It is important to avoid the aspects that are assumed to change, like visual layout or 

particular pieces of content, instead focusing on data structure, frameworks, and other 

components that are easily adapted to design changes. 

 During the the journey of web development process, you should focus on familiarizing 

yourselves with various core tools/frameworks, as- HTML5, CSS3, JavaScript, etc. 

 Open-source tools for web developers are the key to develop customized projects 

because generally they are free of cost, but they can be modified in any way as the 

developer wants. 

 MongoDB is a popular document-oriented database (also called no SQL). It can work 

across multiple platforms. 

 ReactJS is a famous open-source, efficient, and declarative JavaScript library used for 

the designing of user interfaces. 

10.8 GLOSSARY 
 Adaptive layout- A layout system that enables the visual elements in a web page or 

application to adapt to changes in the size of the application window or capabilities of 

the device on which the application is running. 

 Content Distribution Network (CDN)- A system of computers containing copies of 

data, placed at various points in a network so as to maximize bandwidth for access to 

the data from clients throughout the network. A client accesses a copy of the data that 

resides on a server that is closer to them, as opposed to all clients accessing the data 

from the same central server. 

 Cookies- Also known as a web cookie, browser cookie, or HTTP cookie, a piece of text 

stored by a user’s web browser. A cookie can be used for authentication, storing site 

preferences, shopping cart contents, the identifier for a server-based session, or 

anything else that can be stored as text data. Cookies can be encrypted or unencrypted. 
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 HTML5- The next major revision of the HTML standard that is currently under 

development. Like its immediate predecessors, HTML 4.01 and XHTML 1.1, HTML5 

is a standard for structuring and presenting content on the World Wide Web. 

 Multimedia- Media and content that uses a combination of different forms. Multimedia 

includes some combination of text, audio, still images, animation, video, and interactive 

content. 

 Ruby- A dynamic, open-source programming language with a focus on simplicity and 

productivity. A primary aim of the language is to maintain an elegant syntax that is 

natural to read and easy to write. Ruby is the underlying language used in the Rails and 

Sinatra web frameworks. 

 Site map- Provides a global, hierarchical view of a website’s pages or application’s 

“screens” for organizational purposes. Most site maps do not show every page-to-page 

or screen-to-screen connection; that function is usually served by detailed user flows. 

10.9 CHECK YOUR PROGRESS 
1) Define the web development process. What are the core tools required to design a basic 

web application? 

2) List the tools used for designing user interface with brief description. 

3) Define open-source web development tools. 

4) Explain the following terminologies used in web development- HTML5, Mobile Web, 

Payment gateway, Safari, Search engine, Site map, Wireframe, User experience. 

5) Briefly explain the latest trends in web development. 
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11.1 INTRODUCTION 
From letter writing to report writing, the written communication always requires skill and 

expertise. The written documents provide a record of a correspondence, which is a key in 

situations where legal concerns may arise. The written communication you produce, represents 

you and your organization, so your goal is always to make it clear, concise, and professional, 

regardless of the type of message you are sending. 

Some of the popularly used business documents that you will find in your professional journey, 

as- e-mail, memos, letters, fax cover sheets, and reports. When you are writing workplace 

documents, you will usually be focusing on the two intentions, inform and persuade. Most 

commonly, memos, fax cover sheets, and short reports are intended to inform. Such documents 

deal with facts only, and their messages are usually neutral, they are not likely to create an 

emotional response, either positive or negative. But in some situations, like e-mail and letters 

you have to persuade to someone in any way.  
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Different types of workplace documents can align with different purposes. You will have to 

choose the right document type and accordingly you will have to plan writing the document, 

grammar, and punctuation skills to draft a clear message to the recipient. 

Here, we are basically dealing with report writing and formation. There are several types of 

reports you might need to create, such as- Annual Report, Weekly Report, Project Report, 

Sales/Marketing Report, Research Report, Academic Report, etc. 

11.2 OBJECTIVES 
After the successful completion of this unit, you will be able to- 

 Define various report types and their purposes. 

 Define need of report writing. 

 Explain report organization. 

 Define important workplace document and formatting style. 

11.3 TYPES OF REPORTS 
Reports come in all sizes but are typically longer than a page and somehow extended upto 400 

pages similar to a book. The type of report depends on its function, and audience to whom it 

has to present. Reports vary by their function, style, and purpose. There are many types of 

reports, here we are focusing on the following types of reports used at the workplace. 

Annual Report- 

This will typically cover the organization's yearly progress and performance to share the 

achievements with the audience.  

Weekly Reports- 

This type of reports is helpful to share the weekly progress various projects and goals. This can 

be simple as 1 to 2 pages longer. 

Project Reports- 

Keep your clients and team members up-to-date on the status of various projects progress. 

Research Report- 

the research reports are the way to present in-depth research findings. Such as, scientific 

findings, data and statistics from a study, etc., a research report is a way to share one's research 

findings. 

Academic Report- 

Such type of reports can be created for a class, often in graduate or undergraduate universities/ 

colleges. It may be periodical or random. 

Progress Report- 

A progress report is used to give management an update on the status of any assigned 

task/project. It is generated at timed intervals (for example, monthly, quaterly, etc.) or on 
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completion of any key stage in the project. It records accomplishments and identifies any 

challenges or concerns. 

Recommendation Report- 

A recommendation report is used to help management make decisions. The goal of this type of 

report is to identify a solution to a problem or suggest a course of action. The intention of a 

recommendation report is not to assign blame or be overly critical, but to suggest improvements 

in a positive manner. 

Summary Report- 

A summary report is used to give management information. For example, if you work in the 

marketing department, your boss might ask you to find out about your competitors’ online 

activities so that your organization can effectively compete with them. To do this, you would 

research your competitors’ websites, social media profiles, digital advertising campaigns, and 

so on. Then, you would prepare key points so that your management can get the essential 

information and can act accordingly. Summary reports always focuses on the facts, leaving it 

to management to decide on a course of action. 

11.4 IMPORTANCE OF WRITING AN ATTRACTIVE REPORT 

 The project manager is accountable for the timely completion of the project. For 

achieving such goal progress report is very important. 

 It can fulfill the audience expectation about the concern topic. 

 The figures and tabular data must be well presented. 

 Headings and sub headings are the key to make a report worthy. 

 The design and structure of a report is of key importance. 

 The font type, style and font size must be chosen carefully. 

 The organization of the report must be reviewed. 

11.5 ESSENTIAL STAGES IN REPORT WRITING 
The reports have various designs depending on the profession, or organization's need. 

Organizations very often have their own “stylesheets” on which all organizational document 

designs are based, so make sure we are sharing a general format of reports. The reports have 

specifications, such as- layout, organization of content, format of headings and lists, the design 

of the graphics, and so on. The advantage of a required structure and format for reports is that 

you or anyone else can expect them to be designed in a familiar way. Reports are usually read 

in a hurry manner in which people get the information they need, so that the key facts, the 

conclusions, and other essentials should be mentioned in a eye catching manner. 

 

When someone analyses the design of a report, he/she will notice that how some information 

is presented repetitively, because, this has to do with how people read reports. People do not 
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read reports straight through: they may start with the executive summary, table of content, key 

facts, and most probably conclusion. So, designing a good report is a big challenge. The 

standard components of the typical report are discussed with the following sub-sections which 

are only the guidelines to prepare a report because different organizations can have different 

report formats, as- 

Cover letter- 

The cover letter is either attached to the outside of the report with a paper clip or is bounded n 

the front of the report. It is a communication from you (the report writer) to the recipient of the 

report. The cover letter explains the context of the events that brought the report about. It 

contains information about the report that does not belong in the report. 

Example of the cover letter-  

First paragraph- It cites the name of the report, putting it in italics. It also mentions the date of 

the agreement to write the report. 

Middle paragraph- It focuses on the purpose of the report and gives a brief overview of the 

report’s contents. 

Final paragraph- It encourages the reader to get in touch if there are questions, comments, or 

concerns. It closes with a gesture of good will, expressing hope that the reader finds the report 

satisfactory. 

As with any other element in a report, you may have to modify the contents of this cover letter 

for specific situations. Sample cover letter is shown in the figure 11.1  
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Figure 11.1 Sample Cover Letter 

Cover Page- 

Cover page of the report must be decent and informative in terms of report title, submitted by 

(creator of the report), submitted to (recipient of the report), duration (date). For example- The 

word-processing software to be used to design a cover page of the report. Refer to figure 11.2 
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Figure 11.2 Cover Page Sample  

Abstract/ Executive Summary- 

Most reports contain at least one abstract/ executive summary, in which the summary of the 

contents of a report are presented. In some report formats, the abstract and the executive 

summary are treated differently. The executive summary is presented with the key facts and 

conclusions contained in the report. Typically, executive summary can be 2 to 3 pages long if 

the length of the report is 30 to 50 pages. For longer reports, it can be proportionately increased.  

Table of contents- 

In every document which is of longer size (more than 10 pages) the table of contents is a place 

which cannot be skipped by the reader. It shows readers what topics are covered in the report, 

and how those topics are discussed (with sub-topics) in a serial manner. To create a table of 

contents, you should remember the following-  

 Font size and style. 

 Levels of headings. 

 Page number (Infront of each heading or sub heading). 

 Indentation, spacing, and capitalization. 
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 List of figures and tables- If your document has more than two figures or tables create 

a separate list of figures, so that the readers can use the list of figures to quickly find 

the illustrations, diagrams, tables, and charts in your report. 

Introduction- 

An essential element of any report is it's introduction. The well-structured/defined introduction 

makes it sure that the presented information is clear and concise with its real purpose. The 

introduction part of any report prepares the reader to read the main body of the report. 

Body of the report- 

The body of the report is of course the main text of the report, the sections between the 

introduction and conclusion are called the body of the report.  

Headings and sub headings- 

Headings, sub-headings and their titles of the report makes the key impression among the 

reader’s mind. 

During report preparation, the headings and sub-headings about any title are the subject of 

gaining attention. Headings are like the parts of an outline that have been pasted into the actual 

pages of the document. Heading size and title are an important feature of any professional 

writing, because they alert readers about upcoming topics and subtopics. Headings are also 

useful for report writers to keep you organized and focused on the flow of the topic. 

Conclusions- 

A conclusion does not necessarily just summarize a report. Instead, use the conclusion to 

explain the most significant findings you made in relation to your report topic. 

Appendixes- 

Appendixes are those extra sections following the conclusion. We can put anything in 

appendixes that does not comfortably fit in the main part of the report but you feel that must 

be included in the report. The appendix is commonly used for large tables of data, big chunks 

of sample code, fold-out maps, background details that is too basic or too advanced for the 

body of the report, or large illustrations that just do not fit in the body of the report.  

 

Information Sources/ References- 

Documenting your information sources is all about establishing, maintaining, and protecting 

your credibility among the readers. Anything you have taken for completing your report, it 

must be cited in the reference section. 
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11.6 IMPORTANCE OF DOCUMENT FORMATION 
Document formatting refers to the way in which a document is visually organized and it 

addresses things like font selection, font size, font style (bold, italic, underline), spacing, 

margins, alignment, columns, indentation, and bullets and numbering. 

A well formatted document is consistent, correct, visually eye catching, and easy to read. The 

visual appeal of a document has an effect on the reader and how they perceive the information, 

so it is very important in any type of writing or documentation to be well concerned with its 

formatting. Formatting also makes information more accessible to the reader by creating and 

labelling sections and sub-sections, highlighting key words, and making a good impression on 

the audience mind. Few things should keep in mind while creating/formatting a report, as- 

 Font size (11-12 pt.), and a consistent style throughout, including headers, footers, and 

visual labels. 

 Section headings (somehow 14pt-16pt). 

 A standard professional font should be used (e.g., Times New Roman, Arial, Cambria, 

Calibri). 

 Single or 0.15 to 0.3 line spacing, with no indentation on the first line of the paragraph. 

 No additional line break between paragraphs, instead paragraph spacing should be used 

(before 6pt, after 6pt) 

 Text alignment must be justified. 

 Page numbers should be at the bottom right corner (starting the first page of the main 

text, i.e. not the cover page or Table of Contents) 

 Tables should be well formatted and organized. 

 Spell and Grammar Checker should be used. 

11.7 PREPARING TYPICAL WORKPLACE DOCUMENTS 
Whenever you will start to write a document at your workplace, you always need to consider 

who is the audience and what is the purpose of your message (to inform, persuade, or entertain). 

The optimal approach to create an office document is to sketch the outline of the document 

first. This will help you to create the structure of your document and make the writing process 

much easier. The following are the document frequently used in offices- 

 

E-Mail: 
It may be used similarly to text messaging or synchronous chat, or as a quicker way to receive 

and send information that would traditionally be written in a letter. It can be delivered to a 

mobile device. Many businesses use automated emails to acknowledge communications to the 

people. Emails are often informal when used for personal communication, but business 

communication requires attention to detail, awareness that your email reflects you and your 

organization. Email often serves to exchange information within organizations. Although email 
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may feel informal, remember that when used for business, it needs to convey professionalism 

and respect.  

 

Tips for effective business e-mails: 

 Proper salutations should demonstrate respect. 

 Subject line should be clear, brief, and specific. This helps the recipient to understand 

the essence of the message. 

 Close your e-mail with a signature which contains your name and business contact 

information. 

 Avoid abbreviations because an e-mail is not a text message. 

 Format it cleanly, include line breaks between paragraphs for ease of reading. 

 Do a minimum of three-stage review (including structural edit, copy edit, and 

proofread) before you send it. 

 Reply your e-mails promptly. Make a habit of replying e-mails within 24 hours. 

 Do not send your reply to everyone who received the initial email unless your message 

absolutely needs to be read by the entire group. 

 Avoid using all capital letters. Capital letters are considered as rude words. 

 Give feedback or follow up. If you do not get a response in 24 hours, email or call 

because spam filters may have intercepted your message, so your recipient may never 

have received it. 

Memos (memorandum or Reminder)- 
A memo is normally used for communicating policies, procedures, or related official business 

within an organization. It is often written from a one-to-all perspective, broadcasting a message 

to an audience, rather than a one-on-one, interpersonal communication. It may be used to 

update a team on activities for a given project or to inform a specific group within an 

organization of an event, action, or observance. The purpose of a memo is to inform, but it may 

occasionally include an element of persuasion or a call-to-action. One effective way to address 

un-official speculation is to spell out clearly for all employees what is going on with a particular 

issue. If a company wants employees to take action, they may issue a memo.  

 

A memo has a header that indicates who sent it and who the intended recipients are. Pay 

particular attention to the title of the individual(s) in this section. Date and subject lines are also 

present, followed by a message that contains a declaration, a discussion, and a summary. In a 

standard writing format, we might expect to see an introduction, a body, and a conclusion. All 

these are present in a memo, and each part has a purpose. The introduction in the opening uses 

a declarative sentence to announce the main topic. The body elaborates or lists major points 

associated with the topic, and the conclusion serves as a summary. 
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Business Letters- 
Letters are brief messages sent to recipients that are usually outside the organization. They are 

often printed on letter head and usually take up one or two pages. While email may be used 

more frequently today, the business letter remains a common form of written communication. 

Your organization may have its own letter format, but the common elements across business 

letters are- Return Address, Date, Recipient Address, Inside Address, Salutation, Subject Line, 

Introduction, Body, Conclusion, Closing, Signature, Reference Initials, Enclosures (if any), 

Contact information, etc. 

Letters may serve to introduce your skills and qualifications to prospective employers, deliver 

important or specific information, or serve as documentation of an event or decision. They may 

deliver information with a positive, negative, or neutral tone. Regardless of the type of letter 

you need to write. A letter contains five areas (but not necessarily all the elements are used in 

every case)- 

The heading, which establishes the sender, including address and date. 

The introduction, which establishes the purpose. 

The body, which articulates the message. 

The conclusion, which restates the main point and may include a call-to-action. 

The signature line, which sometimes includes the contact information. 

Short Report- 
Reports are designed to record and convey information to the reader and can be used both 

internally (within organization) and externally (outside organization). Reports serve to 

document new information for specific audiences, goals, or functions. The reports are often 

analytical or involve the rational analysis of information. Sometimes the report contains the 

facts with no analysis at all, but in some other situations, the reports summarize past events, 

present current data, and forecast future trends. 

11.8 POINTS TO REMEMBER 

 Reports are designed to record and convey information to the reader and can be used 

both internally (within organization) and externally (outside organization). 

 The written communication you produce, represents you and your organization, so your 

goal is always to make it clear, concise, and professional, regardless of the type of 

message you are sending. 

 A memo is normally used for communicating policies, procedures, or related official 

business within an organization. It is often written from a one-to-all perspective, 

broadcasting a message to an audience, rather than a one-on-one, interpersonal 

communication. 

 Letters are brief messages sent to recipients that are usually outside the organization. 

They are often printed on letter head and usually take up one or two pages. 
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 Letters may serve to introduce your skills and qualifications to prospective employers, 

deliver important or specific information. 

11.9 GLOSSARY 

 Annual Report- This will typically cover the organization's yearly progress and 

performance to share the achievements with the audience.  

 Project Reports- Keep your clients and team members up-to-date on the status of 

various projects progress. 

 Research Report- the research reports are the way to present in-depth research findings. 

Such as, scientific findings, data and statistics from a study, etc., a research report is a 

way to share one's research findings. 

 Academic Report- Such type of reports can be created for a class, often in graduate or 

undergraduate universities/ colleges. It may be periodical or random. 

 Progress Report- A progress report is used to give management an update on the status 

of any assigned task/project. It is generated at timed intervals (for example, monthly, 

quarterly, etc.) or on completion of any key stage in the project. It records 

accomplishments and identifies any challenges or concerns. 

11.10 CHECK YOUR PROGRESS 
1) Define the role of various reports. 

2) How many types of reports are used in an organization? Explain briefly. 

3) Explain the importance of document formatting. 

4) Briefly explain the organization of a report. 

5) Define the various workplace documents with their key features and purposes. 
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 https://coccoer.pressbooks.com/chapter/document-design-technical-writing. 

 https://kpu.pressbooks.pub/businesswriting/chapter/writing-formal-reports/#fig11.1. 

 https://www.citewrite.qut.edu.au/write/writing-well/report.html. 

 https://learn.solent.ac.uk/mod/book/view.php?id=232731&chapterid=36551. 

 https://courses.lumenlearning.com/sac-businesscommunication/chapter/13-4-report. 

 https://ohiostate.pressbooks.pub/feptechcomm/chapter/8-formatting. 

 https://courses.lumenlearning.com/wmopen-

businesscommunicationmgrs/chapter/word-processing-software 

11.12 SUGGESTED READINGS 
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 https://ecampusontario.pressbooks.pub/profcommsontario/chapter/writing-workplace-

documents. 

 https://kpu.pressbooks.pub/businesswriting/chapter/writing-formal-reports. 

 https://coccoer.pressbooks.com/chapter/document-design-technical-writing. 

 https://kpu.pressbooks.pub/businesswriting/chapter/writing-formal-reports/#fig11.1. 

 https://courses.lumenlearning.com/sac-businesscommunication/chapter/13-4-report. 

 https://ohiostate.pressbooks.pub/feptechcomm/chapter/8-formatting.  

 https://courses.lumenlearning.com/wmopen-

businesscommunicationmgrs/chapter/word-processing-softwar. 
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12.1 INTRODUCTION 
Feedback and reviews are the vital part of learner’s skillset or organizational improvement. 

Constructive feedback is a robust tool for creating healthy environment, utilizing one's 

potential, and engagement to achieve better results. Feedback helps to optimize work processes 

and give future directions, so that one can develop strategies accordingly. Feedback plays the 

crucial role in education and learning by identifying the actual scenario and avoid repetitive 

mistakes. Feedback and reviews give people an opportunity to look themselves through 

different angels. Giving regular feedback is one way we can show employees that they are 

valued and useful. Constructive feedback opens up the communication channels between 

employee and employer, which is a key to achieve common organizational goal. 

A survey is a research method used for collecting data from a predefined group of participants 

to gain information and insights into various topics of interest. The surveys can be conducted 

for multiple purposes where researchers can conduct surveys in depending on the methodology 

chosen to achieve the goal. For conducting surveys, you can design a questionnaire or any other 
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standard procedures to collect unbiased data. The data can be collected either online or offline 

mode. In online, the survey data can be collected using digital media, such as- social media 

networks, email, forms, etc. 

12.2 OBJECTIVES 
After the successful completion of this unit, you will be able to- 

 Explore types of feedback collection. 

 Explore designing tactics of surveys. 

 Define data analysis methods. 

12.3 TYPES OF FEEDBACK COLLECTION 
The communication process depends on a series of components that are always present. If you 

remove one or more, the process disintegrates. Such components are- a source, a receiver, a 

message, and a channel or multiples of each in divergent ratios of signal strength and clarity. 

The final step in the communication process is feedback. It contributes to the transactional 

relationship in communication, and serves as part of the cycling and recycling of information, 

content, negotiations, relationships, and meaning between the source and receiver. Because the 

feedback is so valuable for developing strategies and improvements. Feedback is defined as a 

receiver’s response to a source, and can come in many forms. Feedback is always present, even 

if we fail to capture or attend to the information as it is displayed. Here we are describing 

several forms of feedback. [3] 

 

[1] Indirect Feedback- 
Indirect feedback is a response that does not directly come from the receiver or source. The 

receiver may receive the message, and may become the source of the response, but they may 

not communicate that response directly to you. For example- In the case of accessing your 

website, this is your ability to track who accesses your Web page, what they read, and how 

long their visit lasts can be a source of feedback that serves to guide for improving/ developing 

your website much better. You may also receive comments, e-mails, or information from 

individuals within your organization about what the visitors/customers have told to them; this 

is another source of indirect feedback. [3] 

Note- The fact that the information is not communicated directly may limit its use or reliability, 

but it does have value. All forms of feedback have some measure of value. 

 

[2] Direct Feedback- 
Direct feedback is a response that comes from the receiver. Direct feedback can be both verbal 

and nonverbal, and it may involve signs, symbols, words, or sounds that are unclear or difficult 

to understand.  
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For example- You may send an e-mail to a customer who inquired about your water pump, 

offering to send a printed brochure and have a local sales representative call to evaluate how 

suitable your pump would be for the customer’s particular application. In order to do so, you 

will need the customer’s mailing address, physical location, and phone number. If the customer 

replies with a sense of satisfaction with your services, one can store it as feedback, but it is 

hard to interpret if you got few more and complex information/replies. Communication is 

dynamic and complex, and it is no easy task to understand or predict. One aspect of the process, 

however, is predictable: feedback is always part of the communication process. The ability to 

identify clear and direct feedback can be a significant challenge. [3] 

 

[3] Internal Feedback- 
Internal feedback is generated by the source in response to the message created by that same 

source. You, as the author, will be key to the internal feedback process. This may involve 

reviewing your document before you send it or post it, but it also may involve evaluation from 

within your organization. We usually think of feedback as something that can only come from 

others, but in the case of internal feedback, we can get it from ourselves. Internal feedback 

starts with you. Your review of what you write is critical. You are the first and last line of 

responsibility for your writing. As the author, it is your responsibility to ensure your content, 

that is- correct; clear; concise; and ethical. [3] 

 

[4] External Feedback- 
Writing, reading, and action based on the exchange of symbolic information is a reflection of 

the communication process. Feedback comes in many forms and in this part of our discussion 

we focus on answering that essential question, assessing interaction, and gathering information 

from it. External feedback involves a response from the receiver. Increasingly Web-based 

documents allow for interaction and enhancement of external feedback. Page views are a count 

of how many times a Web page is viewed, irrespective of the number of files it contains. Each 

time a user or reader views the page counts as one page view. [3] 

 

[5] User-Generated Feedback- 
With the introduction of online media, the speed of feedback has been greatly increased. Public 

relations announcements, product reviews, and performance data of your organization are often 

made available internally or externally via electronic communication. If you see a factual error 

in an article released internally, within minutes you may be able to respond with an e-mail and 

a file attachment with a document that corrects the data. In the same way, if the document is 

released externally, you can expect that feedback from outside your organization will be quick. 

Audience may even post positive or negative comments. [3]  
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Customer reviews and similar forms of user-generated content are increasingly common across 

the Internet. Written communication is often chosen as the preferred format; from tweets to 

blogs and commentary pages, to threaded, theme-based forums, person-to-person exchange is 

increasingly common as user generated feedback. The online feedback can influence several 

future customers, but negative customer reviews in the online information age can make a 

disproportionate impact in a relatively short time. The online environment can be both fast and 

effective in terms of distribution and immediate feedback. [3] 

12.4 ROLE OF FEEDBACK 
Feedback is something which tells you that you are on the right track or not. Feedback is 

information provided on the performance or understanding of a task which can then be used to 

improve this performance or understanding. Feedback helps to close the gap between actual 

performance and intended performance. The use of feedback is regarded as one of the most 

powerful strategy to improve one's achievement. Sometimes, feedback is typically related with 

greater academic achievement, improvements in learner's work, and enhanced learners’ 

motivation. Feedback can serve many different purposes, such as- praise, encouragement, 

identification of errors, suggestions of how to fix errors and guidance on how to improve the 

work standard. [1] 

12.5 HOW TO DESIGN A SURVEY? 
Questionnaires and surveys are essential tools for gathering this necessary information. Such 

questionnaires and surveys can also help you to discover new information, open new doors for 

study, and develop new solutions. Some essential characteristics of a good survey that 

researchers need to know, including: [2] 

 A clear understanding of the focus of the research and the type of data that needs to be 

collected. 

 A clear and consistent format. 

 Clear and concise instructions. 

 Clear language for the questions. 

 Definition of terms. 

 

Advantages of designing a questionnaire- [2] 

 Cost-effective- Designing a well-crafted questionnaire will save you both time and 

money. 

 Easy to use- As with any type of research, analysis and forecasting are easier if you 

collect large amounts of information.  

 Questionnaires offer you the flexibility to manage data as per your need. 
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 Effective for all audience sizes of sample- Questionnaires allow you to gather 

information from an audience of any size. You can target a small group to gather 

information in a local event or a large group for the study that requires a wider range of 

participants. 

Disadvantages of designing a questionnaire- [2] 

 Issues of dishonesty- Respondents might not be completely truthful in their answers. 

This can happen as a result of trying to fit some social role or to protect their own 

privacy. 

 Emotional responses- Emotions can alter a respondent’s interpretation of a question and 

their possible answer. 

 Biasness- If an individual does not like a question or the larger ideas behind the survey, 

they could purposefully alter their responses to fit their own bias. 

 Difficulties of interpretation: One issue could be the difference between how you 

develop a question and how a respondent might interpret it. 

 Lack of personalization- Surveys can sometimes come across as impersonal. This lack 

of customization might lead potential respondents to ignore the survey or not put much 

effort into providing answers. 

12.6 STEPS TO DESIGN A SURVEY 
Survey research is a type of research design that has two important characteristics. First, the 

variables of interest that are measured using self-reports. These self-reports are gathered by 

questionnaires, either completed independently by a participant or administered by a member 

of a research team. Second, often survey research is conducted to understand something about 

a larger population; remember, this is known as generalizing results. Consequently, 

considerable attention is paid to the type of sampling (data collection) and the number of cases 

used. In general, researchers using a survey design have a preference for large randomly 

selected number of samples. Survey research is common to gather a variety of information. [4] 

Survey research is best suited for studies that have individual people as the unit of analysis. 

However, other units of analysis, such as families, groups, organizations, or communities may 

also be used in survey research. Most survey research is used to describe single variables (e.g., 

voter preferences, motivation, or social support) and to assess statistical relationships between 

variables (e.g., the relationship between income and health). [4] 

12.7 DATA HANDLING AND INFORMATION GENERATION 
Types of survey data- 

Different types of questions in a survey come with different considerations that you should take 

into account. Most survey questions can be grouped into four types, as- Categorical Scale Data; 

Ordinal Scale Data; Interval Scale Data; and Ratio Scale Data. 
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[1] Categorical Scale Data- 

Categorical data allows you to answer using a list of specific names or labels or categories, i.e. 

Gender, Age group, Educational level, etc. Categorical data is easiest to analyze where you can 

present such data using frequency count, percentage, etc. 

 

[2] Ordinal Scale Data- 

Ordinal data is any type of question where the responses only make sense as an order. 

For example: 

“How much do you use our product?" 

Answer: 

Never 

Rarely 

Sometimes 

Often 

Always 

One important consideration when analyzing ordinal data is being cognizant that order matters. 

If it is possible, randomly flip the order of answers for each survey taker. 

 

[3] Interval Scale Data- 

Interval data needs to be ordered and the distance between the values needs to be meaningful. 

For example: 

An interval data question would be, “What is your budget?” where the answers would be a 

predetermined set of prices like “<5k, 10k, 15k”. 

It is best to use equally-sized intervals if possible because it makes it possible to use averages 

on the data and more clearly visualize the summary of the data. If intervals are not equal sizes, 

then it should be treated as categorical data. 

 

[4] Ratio Scale Data- 

Ratio data is the richest form of survey data. A ratio scale ranks the highest in the four “levels 

of measurement”. The ratio scale has all the qualities of nominal, ordinal, and interval scale. 

On a ratio scale, the data obtained can not only be categorized and ranked but also have equal 

intervals. A ratio scale has a true zero, that is, the zero possesses a meaningful value. The true 

zero value in a ratio scale makes it possible to describe the amount of magnitude. 

The common example of a ratio scale is length, duration, mass, money age, etc. For the purpose 

of marketing research, a ratio scale can be useful to evaluate sales, price, share, and a number 

of customers. 

12.8 POINTS TO REMEMBER 
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 Feedback and reviews are the vital part of learner’s skillset or organizational 

improvement. 

 Feedback helps to optimize work processes and give future directions, so that one can 

develop strategies accordingly.  

 A survey is a research method used for collecting data from a predefined group of 

participants to gain information and insights into various topics of interest.  

 The communication process depends on a series of components that are always present. 

If you remove one or more, the process disintegrates. Such components are- a source, 

a receiver, a message, and a channel or multiples of each in divergent ratios of signal 

strength and clarity. 

12.9 GLOSSARY 
 Categorical Scale Data- Categorical data allows you to answer using a list of specific 

names or labels or categories, i.e. Gender, Age group, Educational level, etc. 

 Ordinal scale data- It is a categorical, statistical data type where the variables have 

natural, ordered categories and the distances between the categories are not known. 

 Interval Scale Data- Interval data needs to be ordered and the distance between the 

values needs to be meaningful. 

 Ratio data- It is the richest form of survey data. A ratio scale ranks the highest in the 

four “levels of measurement”. 

12.10 CHECK YOUR PROGRESS 
a) Define the different types of feedback collection methods. 

b) How to design a good survey? 

c) Explain the role of feedback in improving organizational growth? 

d) Define the types of survey data. 

12.11 BIBLIOGRAPHY/ REFERENCES 
 [1] https://granite.pressbooks.pub/teachingdiverselearners/chapter/feedback-2. 

 [2] https://www.enago.com/academy/14-tips-for-designing-an-effective-research-

questionnaire-survey. 

 [3] https://courses.lumenlearning.com/cerritos-commskillsformgrs-1/chapter/8-1-

diverse-forms-of-feedback. 

 [4] https://viva.pressbooks.pub/mswresearch/chapter/12-survey-design. 

12.12 SUGGESTED READINGS 
 https://granite.pressbooks.pub/teachingdiverselearners/chapter/feedback-2. 

 https://courses.lumenlearning.com/cerritos-commskillsformgrs-1/chapter/8-1-diverse-

forms-of-feedback. 
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